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Complete teacher’s manual for Open office writer 2 Class 1

Class 1 Summaries

How to open writer file?
ANGRA A Pl q 69413 6699 QU ?
What is the use of tool bar

M QA QULLIQN @6l 7
What is difference between page layout and web layout?

69% 62T I9° 68S 6MAIAG 69R IR AIRY /8l ?
Why use we status bar?

21661 RIT 919 § LG LR *R2R ?

What is text boundaries ?

6990 Qe @6l ?

How to show and hide formatting bar ?
PAITe QIa § 60816 6QHIRAN 98° RIIRQN ?
What is ruler?

UM @€l ?
What is non-printing characters?

Non-printing characters @él ?

How to zoom in and zoom out on the page
6d@ Q 69916 G 99° @l ARG KA ?
How to shut down computer.

ARG § 69716 QL QAU ?
Now let’s start video.

969 063 q IR ! .

. To stop video time at 1 minute 07 seconds in VLC Media Player.
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COMPUTER SHIKSHA

Do you all remember -
- 2661 FlI6S 168 QY8 § g
what wa;l'::’:hlt;° youin QURTR 1 68 9l FSIAIRARI ?

Stop video here and ask them if they remember what they learnt in writer 1?
JE0I6Q 63 q 9L A% Y9° JoIQ 64IREA Fll6R 2R 697168 AURTR €
69 @6l Sglelem ?

Just listen to the answers and play the video again for the correct answer.

Qa9 § g4 99° 908 2@ AR @@6 § A eR |

. To stop video time at 1 minute 42 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell why the Formatting Q2aIae & 6erIdiTe gR S1a QIEE
Tool Bar is used ? UL QUG ?

# Formatting Toolbar

Stop video here and ask if they know why ‘Formatting toolbar’ is used?
JE0I6Q 086 q 98 A I9° JFIR 6471I6R RSB PFIT° fRIA § FIEq
QULLIQN @I ?

Just listen to the answers and play the video again for the correct answer.
QAR § §8 1G° 90 AR AR BE6 § YRS SR |
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3. To stop video time at 2 minute 17 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell what happens with Q@aIge qasmg‘ 9@ Guer Il
Export as PDF and what is the full Q61 621021 99° AGIP O R
form of PDF ? ed qa?

2 (e lﬁ:

Stop video here and ask what is ‘export as PDF’? And what is the full form of
‘PDF’*?

YZ0I6Q 866 § % A IS° IFIR ‘export as PDF’ @61 YS9° PDF Q R el
@6l ?

Just listen to the answers and play the video again for the correct answer.

QRQ § 4 99° 90Q 29 IR 886 § AR eI |

4. To stop video time at 3 minute 02 seconds in VLC Media Player.

Can you tell QEAING 26A FING 94 F69Q
why we use Find & Replace ? QLR UL FAIR |

Stop video here and ask why we use ‘Find and Replace’?

JE0I6Q GGG § 96 9 99° IS 2AI6¢ “Find 99° Replace’ RIaG QUSLIR
R ?

Just listen to the answers and play the video again for the correct answer.
QAQ § g4 99° 0] 29 IR 8&6 § AR eI |
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5. To stop video time at 3 minute 29 seconds in VLC Media Player.

COMPUTER SHIKSHA

Now open your writer file. Sl amgg IG’IQQ 2 6eag

Stop video here and ask students to open writer file as shown in the video and
then play the video again.

JE@0I69 ©E6 q 9% AR 99° I8 AIRg 99 Q@6 63 695N QR

ARTA QA FIRM § B6UF FA6E IS° FILIN6R V66 § YRS SR .
6. To stop video time at 4 minute 05 seconds in VLC Media Player.

Stop video here and ask students to press Window + R button as explained in
video.

920160 806 § 9% 99 I9° BIE Aleg 8F6 gLIAIRASI @R window + R
Q9% § GRS AR §F .

Just check if they have pressed window + R button or not and then play the
video again. _
Y63 697 @0G2 96 6971168 window + R § 968 § @FIRRE & §1@ 99°
PE6 g JASIa oI,

7. To stop video time at 4 minute 15 seconds in VLC Media Player.

Stop video here and ask students to type ‘swriter’ in the run command box as
shown in video.

JE0I69 @63 @ 9L @9 99° ]IE AIRg video 6Q 6QHIAINYS| @& run

command box 68 “swriter’ 6RYSIVIN L .
Just check if they have typed or not and then play the video again.

969 697 A0R2 AT 697168 6AY AIARE § QI I9° AE6 § JeI
SR .

8. To stop video time at 4 minute 30 seconds in VLC Media Player.
Stop video here and ask students to Click on ‘OK’ button as shown in video .

Supported By “Human Development Foundation” 6



COMPUTER SHIKSHA

ceeee---. bridging the digital divide

E0I6Q W60 g 96 @ I9° RIS Al gL video 62 694l AINYSI W ok
QOR Q Q9IRS dR QF .

Now Just check if they have opened writer file or not and then play the video
again.

Y69 56@ 607 @92 697164 writer Q file § B69% A3 6QNRE @ QI
Q€ video @ g}?@la omid .

9. To stop video time at 4 minute 45 seconds in VLC Media Player.

COMPUTER SHIKSHA

What we learn today ? 21X 21661 K41 &gl ?

Stop video here and ask what will we learn today?

JE20I69 63 q 9% 29 99° oI 2R 260 K4l S5 ?
Just listen to the answers and play the video again for the correct answer.

QA9 § g4 99° 90Q 209 IR 886 § A eI |

10.To stop video time at 5 minute 24 seconds in VLC Media Player.

COMPUTER SHIKSHA

Now you type out the paragraph N6E £11g 6Q61ILINYSI AIouglIer
being shown to you. og FIRa e |

A Rich man had only one son. The sin fell

into the bad company. He developed many
bad habits the man was much worried
about the habits of his son. He tried his
best to mend his habits but he could
successes. One day his thought of a plan to
teach his son a lesson.

Stop video here and ask students to type the given paragraph as shown in the
video and then play the video again.
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JE@0I69 ©E06 @ 9% AR 99° I8 IR video 6Q 6QHAIRYS] A
paragraph g 6RYSICIN §L N9° QLG § YRS SR |

11.To stop video time at 5 minute 40 seconds in VLC Media Player.

w7’

COMPUTER SHIKSHA
D he diff
ey bios e e 24 6RRIRE 8" 666 6RRIGE
la ou‘,’, AIER aldey 96 g6 RIFRT ?

Print Layout

V/s
Web Layout

Stop video here and ask if they know the differences between ‘Print layout’ and
‘Web layout’

JE@0I69 @63 Q 9L @9 99° JGIQ 649I6%R Print layout’ \IQ° “Web layout”’
ARIER AFRY K8 RITRS ?

Just listen to the answers and play the video again for the correct answer.
QAR q g8l 99° A0SR AR 9 [[mgatale! qQ QG?Q‘IQ omig |

12.To stop video time at 06 minute 09 seconds in VLC Media Player.
Stop video and ask students to do for Print layout and Web layout as shown in
the video and then play the video again.
JE20I69 63 q 9% 29 99° Ig AIRg video 6Q 6QHIAINS| @ Print

layout 99° Web layout @991 AR §& .M8° 8836 § 9a<IQ oMl |

13.To stop video time at 6 minute 47 seconds in VLC Media Player,
Stop video and ask students to do writer page in ‘Web layout’ format as shown
in the video and then play the video again.

JE0I69 63 Q 9L @9 99° I8 ARG writer page 69 web layout format
091 AR 2. 99° GE6 § gReia oI |

14.To stop video time at 7 minute 01 seconds in VLC Media Player.
Stop video and ask students to do in ‘Print layout’ format as shown in the video.
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JE@0I69 ©E06 @ 9% AR 99° I8 AIeg 8@G 63 696! AN @ print
layout R2QIAIN L .

Now just check whether they’ve changed the layout of the page or not and then
play the video again.

969 569 699 9G 699169 page 69! layout change @969R88 @ QI
NG° Q66 § YRS ORI |

15.To stop video time at 7 minute 12 seconds in VLC Media Player.

w7’

COMPUTER SHIKSHA

Canyou tell 266 §R SIN SITE 4SLIR /R
why we use the Toolbar ? £661 @LAINE @ ?

Stop video and ask if they can tell why the ‘Toolbar’ is used?
E0I69 866 § 8% A 99° oI 6971168 KEAIRES “toolbar” § KIS

QUL @UULIN] ?
Just listen to the answers and play the video again for the correct answer.

QA9 § g4 98° 908 999 dIR 668 § IR oM |

16.To stop video time at 7 minute 45 seconds in VLC Media Player.
Stop video here and ask students to click on the View menu as shown in video
and then play the video again.

YE@0I69 066 @ 9% AR 99° 8I8 AIFg §2 ©@G 69 696NN QR view
menu AU6R YRIRG! AN NG° GILIV6R BGE § YRR TMI2 .

17.To stop video time at 8 minute 00 seconds in VLC Media Player.
Stop video and ask students to hide ‘Drawing Toolbar’ as shown in the video
and then play the video again.

Supported By “Human Development Foundation” 9



COMPUTER SHIKSHA

......... bridging the digital divide

JE@0I69 ©E6 g 9% AR 99° I8 FIeg GG 6Q 6QHAIRNYS! @f drawing

toolbar § hide @94 REIRSI TN L . IS° SILIYER BEG § YA SR

18.To stop video time at 8 minute 25 seconds in VLC Media Player.
Stop video and ask students to Hide ‘Formatting bar’ as shown in the video and
then play the video again.

JE@0I69 ©E6 @ 9% AR 99° I8 AIeg 8E6 69 6QIKIRYS| @ Hide
‘Formatting bar’ @2QIdIR §€ IG° GILIU6R 863 § YAl SRI2

19.To stop video time at 8 minute 39 seconds in VLC Media Player.
Stop video and ask students to hide ‘Standard toolbar’ as shown in the video
and then play the video again.
JE@0I69 ©E6 q 9% AR 99° I8 AIeg 886 6Q 6QIKIRYS| @ Hide

standard toolbar ‘@AQIIR 92 I8° ILIU6R &G § YRTIa oMl

20.To stop video time at 9 minute 02 seconds in VLC Media Player.
Stop video and ask students to bring back the ‘Drawing toolbar’ as shown in the
video and then play the video again.

JE0I69 @63 q 9% 29 99° ]Ig AIng @63 62 6Q6IKIRR @F drawing
toolbar § 6PAUR G AR GL . IS° GITITER BBG § YA SR

21.To stop video time at 9 minute 20 seconds in VLC Media Player.
Stop video and ask students to bring back the ‘Formatting toolbar’ as shown in
the video and then play the video again.

IZ0I69 GBG § 98 89 I9° I8 FIeg GB3 69 646ILIR2S! OF
formatting toolbar § 6EPQIR 218G IR GE . I9° GILITER &6 § YR
SRl
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22.To stop video time at 9 minute 40 seconds in VLC Media Player.
Stop video and ask students to show ‘Standard toolbar’ as shown in the video
and then play the video again.

Y@0I6Q Q@G q 9% A IQ° RIg FIfg 98 @636 646 AR AR
‘Standard toolbar’ @@ 6GHIRS! IR L . YG° GITIVER VBB § YRS
SmIe)

23.To stop video time at 10 minute 03 seconds in VLC Media Player.

w7

COMPUTER SHIKSHA

Canyou tell 2lee 6899 QIR G‘lfﬁ f1egia eg
why we use the Status Bar ? £661 @LUINE @ ?

Status Bar

Stop video here and ask why we use ‘Status bar’?

20169 8B6 § 98 99 I9° JFIQ 26 status RN FUSLIR KRR .
Just listen to the answers and play the video again for the correct answer.

QA9 § g4 99° 0] 29 IR 8&E6 § 9aIa eI |

24.To stop video time at 10 minute 53 seconds in VLC Media Player.
Stop video here and ask students to click on the View menu as shown in the
video and then play the video again.
JE0I69 @63 Q 9L 29 99° ]IE AIng @63 61 696! AN A View
menu QU6 YIRS AR g% NQ° QILIIERN video G QG‘Q‘IQ omi2l.

25.To stop video time at 11 minute 17 seconds in VLC Media Player.
Stop video here and ask students to hide ‘Status bar’ as shown in video and then
play the video again.

JE0I69 63 Q 9L A9 99° I AIng ©@3 69 66! AN @ status
bar § hide @l QREIRSI IR L . IG° GIFITER video § YRS SR,
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26.To stop video time at 11 minute 43 seconds in VLC Media Player.
Stop video here and ask students to show the Status bar as shown in video.
Now just check whether the ‘Status bar’ is showing again or not and then play
the video again.

JE@0I6Q @63 q 9L 29 99° I AIeg Q83 69 66! AN @ status
bar § 69¢IQS! AIN 9L .

969 569 699 9&a2 status bar § 2R 6AHRRE & Q1L . 99° BIT6R
PE6 § YRS SRI2.

27.To stop video time at 12 minute 08 seconds in VLC Media Player.

COMPUTER SHIKSHA

] i =
ey osaer e [l 050 ca genos e 1o gas
6Q6C dRIN AR ?
there?

Stop video here and ask if they know what is ‘Ruler’ and how many types of
‘Rulers are there?

YE0I69 ©E6 @ 9% 97 99° JFIR 6476 QMR K6l GRS 99° YOI6R
QMR 6R6L RA QAR ?

Just listen to the answers and play the video again for the correct answer.
QAR § §4 1G° 90 AR AR BE6 § YRS SR |

28.To stop video time at 13 minute 14 seconds in VLC Media Player.
Stop video here and ask the students to hide the ‘Ruler’ option as shown in the
video and then play the video again.

JE0I69 ©E6 @ 9% AR 99° I8 FIeg 92 9@6 63 696! AN @ ruler

option § hide @891 AN 99° GILITER BBEB § YAFIR TRI .
29.To stop video time at 13 minute 30 seconds in VLC Media Player.
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Stop video here and ask the students to show the ‘Ruler’ option as shown in the
video.

JZ0I69 @66 § 88 9 I9° ]IS FIeg Q86 61 69 KRNI ©F ruler
option § 69IRSI AR GL .

Now just check whether the ‘Ruler’ is shown or not and then play the video
again.

966 56@ 667 @9G2 ruler § 699IR ANRE @ FIF . 96° GILIUER DG §
JesIa SRl .

30.To stop video time at 13 minute 45 seconds in VLC Media Player.

COMPUTER SHIKSHA

1€ @6 SIL!
dia !

Stop video here and ask if they can tell what is‘Text Boundaries’?
JE0I69 8E6 q 9% a1 99° AFIR 64CI6R ‘Text Boundaries’ K6l
REUAER ?

Just listen to the answers and play the video again for the correct answer.
QAR § §8 1G° 90 AR AR 8E6 § YIS |

31.To stop video time at 14 minute 48 seconds in VLC Media Player.
Stop video here and ask the students to hide the ‘Text Boundaries’ option as
shown in the video and then play the video again.

YQ0I6Q 08B § 8% @ 98° RIG FIRg ©@G 61 6QHIAINAS| R “Text
Boundaries’ option hide @€ QREIRSI AR §L YG° GIFITER 863 § YFIR
omie.

32.To stop video time at 15 minute 04 seconds in VLC Media Player.
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Stop video here and ask the students to bring back ‘Text Boundaries’ option as
shown in the video and then play the video again.

JE0I6Q 863 § 88 A I9° ]IS FIeF 9L ©&6 62 6G%! AR AR
“Text Boundaries’ option § 62PUR 2GS AR G€ IG° GILIV6R ©&G
JeSIR SRI2 .

33.To stop video time at 16 minute 25 seconds in VLC Media Player.
Stop video here and ask the students to show the ‘Non-printing Characters’
option as shown in the video and then play the video again.

JE0I69 @63 q 9L @9 99° RIg AIng Q83 69 626! ARSI U “Non-
printing Characters’ § 6Q9IRG! AR G . I9° FILIV6R B&6 § YRR
SIS .

34.To stop video time at 16 minute 41 seconds in VLC Media Player.
Stop video here and ask the students to hide the ‘Non-printing Characters’ as
shown in the video.

JE0I6Q ©86 q 9% 9 9Q° RIE FlIeg Q66 6Q 696l ARSI @F “Non-
printing Characters’ option § hide @€l QIRG! AR QL .

Now just check whether the ‘Non —printing characters is hidden or not and then
play the video again.

96S 564 699 @G ‘Non —printing characters § ROIR A0RE @ Q& 98°
QITINER BEB § YIS ORI .
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35.To stop video time at 16 minute 46 seconds in VLC Media Player.
w7

COMPUTER SHIKSHA

Next, you will all learn about Full 21969,86¢1 97169 P /1S
Screen. SaA6R §gS |

Stop video here and next you will learn about full screen.
JE0I69 63 Q 9L A9 99° GIRIFER 2Y 9661 AF169 full-screen SYAER
dge .

Just listen to the answers and play the video again for the correct answer.
QAR § 98 9G° 0% AR AR 8&6 § RS SR |

36.To stop video time at 17 minute 33 seconds in VLC Media Player.
Stop video here and ask students to do the Full screen of the page as shown in
the video.

JE0I69 63 @ 9L 29 99° I ARG 98 @63 62 66! AN @ full
screen @981 AR .

Just check and play the video again.
J6Q T6a 60Q QG2 99° 0B q qm‘la omid |
37.To stop video time at 17 minute 52 seconds in VLC Media Player.

Stop video here and ask students to do the Normal page as shown in the video
and then play the video again.

JE@0I69 @63 q 9% @9 99° RIg AIeg 883 69 6.6l ARSI @R normal
page R9QI AR 92 NG° 886 § IR SR |

38.To stop video time at 19 minute 20 seconds in VLC Media Player.
Stop video here and ask students to practice the ‘Zoom’ option as shown in
video and then play the video again.
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JE@0I69 ©E6 q 9% AR 99° I8 AIeg 8@G 6 696l AN @ zoom
option Q ZIRIY ARG G IS° FILIV6R 866 § YRR SR |

39.To stop video time at 18 minute 27 seconds in VLC Media Player.

COMPUTER SHIKSHA

Closing Writer. AN G 9L @ |

=

Close Button

Stop video here and ask students to close the writer page and then play the
video again?
20169 836 § 98 99 99° RIS FIeg AR 698 § 99 99Q! IR g
G° 866 g A9l ORI .

40.To stop video time at 20 minute 36 seconds in VLC Media Player.

COMPUTER SHIKSHA

Shut down your computer.

2fa *fiaca g 9L /9 |

Stop video here and ask how to shutdown a computer.
Y@0I6Q @86 q 9% A I9° FfRTR § 62718 shutdown @€l 98 QUL

Just listen to the answers and play the video again for the correct answer.
QARQ g g8l 99° 90 QAR IR VL6 § YRS SR |
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Complete teacher’s manual for Open office writer 2 Class 2

Class 2 Summaries

How to open writer file?
AURTA PIRM G 6276 3698 QUL ?
What is the use of tool bar?

M QA QULLIN @67
What is difference between page layout and web layout?

69% 6M2IAG YG° 639 6RAIRG F11I6Q AIRY K61 ?
Why use we status bar?

al6e] /Y QUQ G?I@u@ LI AR ?
What is text boundaries ?

6990 Qe @6l 269 ?
How to show and hide formatting bar?

IT° QIR g 6206 694 AIRAN 99° B! RN ?
What is ruler?

QRS K6l 26 ?

What is Non-printing characters?

Non-printing characters @6l 2/6%'?

How to zoom in and zoom out the page
69@ q 6906 g1 99° gFl ARG YR .
How to shut down computer.

AAREA § 69716 9L AU .

Now let’s start video.

2 968 QGG g 2D 27! .

Supported By “Human Development Foundation”
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41.To stop video time at 22 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell why we use View? egaide aleﬂ%‘imgﬁ SIRSIa

Stop video here and ask if they can tell why we use ‘View’” menu?
JE0I6Q 86 § 99 AR IG° JFIR 6DFNI6E FEURES 2I6S QR 6619 FILR
URLIQ d2Q ?

Just listen to the answers and play the video again for the correct answer.
QA q §4 99° A0 AR JIR 8&G q QG‘Q‘IQ omiel |

42.To stop video time at 48 seconds in VLC Media Player.

COMPUTER SHIKSHA

Do you know the difference
between Print layout and Web

layout ?

94 6RAUINS I8° 6ES 6RAIAT
AIER AIdSY 96 g6 RIFRT ?

\

Print Layout

4
‘ v ' e V/s
S Web Layout

Stop video here and ask if they know the difference between ‘Page layout and
Web layout’?

YZ0I6Q QB8 § 99 A9 IG° JFIR 6DI6E 69% 6RAIAT IS° 681
6M2IRQS ° F1IER AIPRY K4 QGRS ?

Supported By “Human Development Foundation” 18
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Just listen to the answers and play the video agaln for the correct answer.
QAR q F4 99° A0 LR JIR 8&E qQ QQQIQ omlie |

43.To stop video time at 1 minute 22 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell how will you remove QEAIRE gR° g QIQ g §661 FAR
the Drawing Toolbar ? LI I ?

il

7
“ E‘i i e Drawing Toolbar

Stop video here and ask if they know how to remove ‘Drawing tool bar’?
YE@0I69 @606 @ 9% AR 99° JFIR 649167 RIEIRE ‘BR° RN’ § 684G
LRI ?

Just listen to the answers and play the video again for the correct answer.
Qa9 § g4 99° 908 29 AR @@6 § aIa eRI |

44.To stop video time at 1 minute 53 seconds in VLC Media Player.

COMPUTER SHIKSHA
Can you tell why we use SLAIRE 2160 FING 94 6qQ
Find & Replace ? QLT Yegin etRIR |

% Find & Replace

Stop video here and ask why we use ‘Find and Replace’?
YZ0I6Q 866 § 99 A IG° JFIR 2I6E! ‘PIRE I9° 6L °  FIER
LI IR ?

Just listen to the answers and play the video again for the correct answer.
QA q §4 99° A0 AR JR Q&0 q QG?Q‘IQ omlie |
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45.To stop video time at 2 minute 19 seconds in VLC Media Player.

COMPUTER SHIKSHA

Now open your writer file. N ngg Imam ¢ Geag

Stop video here and ask students to open the writer file and then play the video
again.
JE0I69 ©G3 @ 9L 99 Y9° ]IE ARG AURTR FIRM § 3698 KA ([}
gL IG° QITITER @66 § YRS SR .

46.To stop video time at 2 minute 57 seconds in VLC Media Player.

Stop video here and ask students to press Window + R button as shown in
video.

JE0I69 @63 Q 9L AR 99° RIg 7oy 99 ©@3 69 66! AN QU
Window + R button QQIm6%.

Just check if the run command box is opened or not and then play the video
again. .
Y63 569 669 @R&2 “run command box” 3696 6LRUIRE & Q1T I9°
QlTITER @66 § PRSI SR,

47.To stop video time at 3 minute 08 seconds in VLC Media Player.
Stop video here and ask students to type ‘Swriter’ as shown in video .
ME0I6Q W60 g 96 AR I9° RIS FIeg BE6 6Q 6QHARNYS| @
‘Swriter’ 6RYLIVR FE.

Just check if they have typed or not and then play the video again.
Y69 569 607 ARG 640167 6MERE @ QL. 99° GILIJ6R ©L6 q

IR SRI .

48.To stop video time at 3 minute 26 seconds in VLC Media Player.
Stop video here and ask students to Click on ‘OK’ button as shown in video .
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JE@0I69 ©E06 @ 9% AR 99° I8 AIeg 6@G 6Q 695l AN Af ok @GR

g QRIRSI AN §L .
Just check whether their file is opened or not then play the video again.

96G 667 R0 FIAM G 6699 A% 69RAR @ FIT FITITER 8B §
JeSIR SRI2 .

49.To stop video time at 3 minute 37 seconds in VLC Media Player.
5.

What will we learn today?
2IF 2169 K6l feiQl ?
You will practice using the 2661 21 9€ 6RAING I8° 698
Print layout and web layout today. 6RAING § ISR S6 AN KAE |

COMPUTER SHIKSHA

Stop video here and ask what will we learn today?

JE@0I69 ©E06 @ 9% AR 99° A9IR 2R 26 @48l §gS ?

Just listen to the answers and play the video again for the correct answer.
QA q §4 99° A0 AR 9 [~ gatale! q QG?Q‘IQ omid |

50.To stop video time at 4 minute 09 seconds in VLC Media Player.
5. 4

COMPUTER SHIKSHA

Now you type out the line J6€ g1Ig 69¢1IAINYSI NS G
being shown to you. fIRa el |

The more you give away , the
more happy you become.
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Stop video here and ask students to type the given line which is shown in video
JE0I69 ©E06 @ 9% AR 99° I8 AIeg 8@G 6 696 AN aF I€
ARG g 71N S AR GEL .

and also ask to do copy and paste of this line 10 times and then play the video
again.

99° Y@ AIRE § €0 A 9T 96° 698 A9l AR 2 IS° SITIF6a BE6 §
JesIa SRl .

51.To stop video time at 5 minute 50 seconds in VLC Media Player.
Stop video here and ask students to do copy and paste of the given line as
shown in the video.

JE@0I69 ©E6 @ 9% AR 99° I8 AIeg 8@G 63 6QsIKIRYS| QF Gl

ARSI ARG § 9T I9° 69 RN 9L .

Now just check if everyone has done so and play the video again.

J6Q 56Q 659 9002 G 4062 2RKIARE 99° @63 q A6 TmI2.
52.To stop video time at 7 minute 09 seconds in VLC Media Player.

Stop video here and ask students to do copy and paste 10 times as shown in the
video.

JE0I6Q 986 q 9% 9 98° RIE Fleg QGG 6Q 696l AN QR o 2R
Q0 99° 69% A9 UIR L .

Now just check whether they’ve copied 10 times or not and then play the video
again.

Y69 569 607 @R 64716% €0 2R /T 29R8 & QI 99° GILIT6R
PE6 § YL SR .
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53.To stop video time at 7 minute 23 seconds in VLC Media Player.

COMPUTER SHIKSHA

So first, go ahead and show how 6069 gA6E Q12 98° §6¢1 FAR
you can hide the Formatting cIFITer 9 QIR § RTINS SILl
Toolbar. 696l |

« -

Stop video here and ask students to hide ‘Formatting bar’ and then play the
video again.

Z0I6Q 866 § 8% A IS° RIS FIeg dIF° QIR § hide 94 ROIRS
IR G2 I9° GIZI6R &G § 9 oI .

To stop video time at 8 minute 15 seconds in VLC Media Player.
Stop video here and ask them to hide the ‘Formatting Toolbar’ as shown in the
video.

E0I6Q ©G6 § 98 A I9° 697IT BL3 6Q 69¢! LIRS QR relge

SRSIA § hide @94 ROINSI VRN L .

Now just check whether they have hidden the ‘Formatting toolbar’ or not and
then play the video again.

964 699 Faa2 647169 SIF° FRSIA § NOIN 6ARE @ FI1F . 98°
QITIU6R BEG § YRS oI .

54.To stop video time at 8 minute 22 seconds in VLC Media Player.

COMPUTER SHIKSHA

And next, go ahead and remove 9Q° 21969, LI 9e° 69'ge
the Text Boundaries. QIRdal g €Al
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Stop video here and ask students to hide the ‘Text Boundaries’ and then play the
video again.

JE@0I69 @63 Q 9L 29 99° I AIeg 6679 1R8N q hide RAU RIFINS
IR 8 99° GITITER V&6 § YRR SmI .

55.To stop video time at 9 minute 02 seconds in VLC Media Player.
Stop video here and ask them to hide the ‘Text Boundaries’ as shown in the
video.

JE0I69 63 Q 9L A9 99° 6AIRT 9L 6996 QIQEAT q hide @eU
ACIRQ! IR §L 692UR BGG 62 6QHARAR .

Now just check and whether they have hidden the ‘Text boundaries’ or not and
then play the video again.

Y69 56Q 607 @H2 69916% 6996 QIQEA! § hidden @€l RETR
6588 @ Q1T I&° CITIU6R BH3 § YFAIR T |

56.To stop video time at 9 minute 06 seconds in VLC Media Player.
w7

COMPUTER SHIKSHA

Now remove the Drawing Toolbar. 96Q ER° gm QIR g €612 |

Stop video here and ask students to hide the ‘Drawing Toolbar’ and then play
the video again

JE20I60 @63 Q 9% 29 99° ]Ig ARG 9L CR° gRIIRQ § hide @€l
RAFIRS| AR 99° GITITER ©EE6 § YRR SR .

57.To stop video time at 09 minute 52 seconds in VLC Media Player.
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......... bridging the digital divide

Stop video here and ask them to hide the ‘Drawing Toolbar’ as shown in the
video.

JE0I69 @63 q 9% @9 99° 699197 ©@3 69 66! AN QU

CR° MR § hide FCU QRTINK ([} Q% .

Now just check whether they have removed the Drawing toolbar’ or not and
then play the video again.

966 56 667 2952 62616 2R° PR SIQ § 291N 69RRE & QlE 9e°
QITIU6R BHG § YRS oI .

58.To stop video time at 10 minute 00 seconds in VLC Media Player.
.. i

COMPUTER SHIKSHA

Next, bring the non printing £1969, £FI6 60 691 £ AP
characters on your page. 6QENLN JEq 2Alél |

Stop video here and ask students to show the ‘Non-printing Characters’ and
then play the video again.

JE20I69 63 q 9% 29 99° g AIeg 92 "Non-printing Characters’ @
6RHRR! QIR L . YG° QITITER 866 § YRR SR .

59.To stop video time at 10 minute 36 seconds in VLC Media Player.
Stop video here and ask them to show the Non-printing Characters as shown in
the video.

YE@0I69 ©E6 @ 9% @R 99° 647IRg Q@3 6Q 6Q4 IR @ “Non-

printing Characters’6 9IRSl IR L .
Now just check if everyone has done so and play the video again.
Y69 56Q 607 G2 IQ 97164 /3 AIRE
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60.To stop video time at 10 minute 41 seconds in VLC Media Player.

COMPUTER SHIKSHA

Now, hide the Standard Toolbar. 968, LIS R SING REI2A |

Stop video here and ask students to hide the ‘Standard Toolbar’ and then play
the video again.

JE0I6Q 866 g 88 A Ie° ]IS FIFg |18 FIeg YEIE g 1A g hide
a9 ROING! JIR 9L . 99° FILIT6R QPG § AR SR

61.To stop video time at 11 minute 19 seconds in VLC Media Player.
Stop video here and ask them to hide ‘Standard toolbar’ as shown in the video.

E0I6Q 086 § 98 AR I9° 6FINT 9€ BHG 63 699 NS AR VGG
gm SR G hide 9 REINSI AR L .

Now just check if everyone has done so and play the video again.

J6Q 56@ 659 9002 G 699167 8 AIART Ie° PIRINER 066 q
Jesia SR

62.To stop video time at 11 minute 23 seconds in VLC Media Player.

COMPUTER SHIKSHA

Next, show how you can reduce L1966, $6¢1 FER 692 QA NG §
the size of the page. AN 69612 |

Stop video here and ask the students to zoom out the page and then play the
video again.
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JE@0I69 ©E6 @ 9% AR 99° I8 AIRg 99 69K g zoom out @Q6R I9°
QIEIU6R BEG § YRS oM.

63.To stop video time at 12 minute 04 seconds in VLC Media Player.
Stop video here and ask the students to zoom out the page as shown in the
video.

JE@0I69 ©E6 g 9% a2 99° I8 AIeg GEG 6Q 694 AN Of 696 §

zoom out @RS AIR §L .
Now just check if everyone has done so and play the video again.
Y69 060 667 A0 96 97169 KR AIRRE 99° W86 § 9aSla oI

64.To stop video time at 12 minute 08 seconds in VLC Media Player.
.. i

COMPUTER SHIKSHA

Now bring back the Formatting 6% 62INITE gR QIR § geSIa
Toolbar. 2l |

Stop video here and ask students to bring back ‘Formatting Bar’ and then play
the video again.

Z0I6Q GGG § 98 9 99° RIg fleg PdIT° QIa § 6P 2GS AR
QL IG° QITITER &6 § YRR SR

65.To stop video time at 12 minute 52 seconds in VLC Media Player.
Stop video here and ask them to show the ‘Formatting Toolbar’ as shown in the
video.

JZ0I6Q BG6 § B8 A IS° 67T BL3 69 69%! ARSI AF PelIT®
SRR 6QHIRG AN L .

Now just check if everyone has done so and play the video again.
Y69 56Q 607 @0G2 9T 97169 /1 AR 99° @63 q QG@I‘& omlid
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veree--.. bridging the digital divide

66.To stop video time at 12 minute 56 seconds in VLC Media Player.

COMPUTER SHIKSHA

Bring back the Drawing Toolbar. SR°EMEING Q_G‘G‘IQ 2161 |

Stop video here and ask students to bring back the ‘Drawing Bar’ and then play
the video again.

20169 836 § 98 99 99° |IE FIeg 92 2R° Ia § 6P AG AR
IG° QILIU6R ©R6 § YRR emial.

67.To stop video time at 13 minute 29 seconds in VLC Media Player.
Stop video here and ask them to show the ‘Drawing Toolbar’ as shown in the
video.

JE0I69 @63 q 9L @9 99° 699197 ©E3 69 626! AN A 2R°

MR @ 6LTNNRNG 9% .
Now just check if everyone has done so and play the video again.

Y69 T6@ 604 20172 99 97169 @4 RS 99° ©L6 Q gﬁ‘él@ omie

68.To stop video time at 13 minute 34 seconds in VLC Media Player.

COMPUTER SHIKSHA

Now, remove the 969, 29 Q4P 69600 989
Non-printing characters. el |

Supported By “Human Development Foundation” 28



COMPUTER SHIKSHA
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Stop video here and ask students to remove the ‘Non-printing Characters ‘and
then play the video again.

Y@0I6Q Q@6 q 9% A Ie° Ig FIRg §€ “Non-printing Characters q
PRSI AR 99° QITITER BVE6 § YRR SmI

69.To stop video time at 14 minute 04 seconds in VLC Media Player.
Stop video here and ask them to hide the ‘Non-printing Characters’ as shown in
the video.

JE0I69 @63 q 9L Q9 99° 699Ieg ©@3 69 66! AN QU ‘Non-

printing Characters’ § hide @€ REIRG! QIR 9L .
Now just check if everyone has done so and play the video again.

Y69 564 657 F0GY 98 97169 4R IR 99° 9836 § 9a9la oIl

70.To stop video time at 14 minute 08 seconds in VLC Media Player.

w7

COMPUTER SHIKSHA

Next, bring back the Text 21969, 69'gS FIQEN § YRR
Boundaries. alé |

Stop video here and ask them to show the ‘Text Boundaries’ and then play the
video again.

20I69 836 § 98 99 99° 626197 9L 6959 AL § 6% AR
98° 66 g A9l oI

71.To stop video time at 14 minute 36 seconds in VLC Media Player.
Stop video here and ask them to show the ‘Text Boundaries’ as shown in the
video.
JE@0I69 63 Q 9L A9 99° 699197 ©@6 61 695 JIRYL QF 657%

QG § 6QHIRG IR G2 .
Now just check if everyone has done so and play the video again.
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Y69 6% 657 F0G2 96 97169 KR QIR 99° 086 § 9a9la eIl

72.To stop video time at 14 minute 42 seconds in VLC Media Player.

COMPUTER SHIKSHA

Now bring back the Standard .

Stop video here and ask students to bring back the ‘Standard Toolbar’ and then
play the video again.

Z0I6Q O%06 § 99 A IG° &I FIeg VEIE TR FI § 6AR 21
IR G 99° BBG § YRSl SR,

73.To stop video time at 15 minute 27 seconds in VLC Media Player.
Stop video here and ask them to show ‘Standard Toolbar’ as shown in the video

JE0I6Q BG3 § 88 AR IS° 699I0T V86 69 6@% ARSI QF EIE

MmN @ 6L ([} QY.
Now just check if everyone has done so and play the video again.

Y69 60 667 R0 96 97169 KR QIR 99° 086 § 9aSla oI

74.To stop video time at 15 minute 35 seconds in VLC Media Player.

COMPUTER SHIKSHA

And now in the end, 9Q° QG 661969, SR 697 A
make your page size 100%. IR G €0o% @R |

Stop video here and ask them to zoom in the page to 100% and then play the
video again.
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20169 836 § 98 99 I9° 62€I8T §E 69K G €00 % zoom SAS! AR
G° GILIU6R BB3 § YRR SMIZ.

75.To stop video time at 16 minute 07 seconds in VLC Media Player.
Stop video here and ask them to increase the page size as shown in the video
and.

JE@0I69 ©E6 @ 9% AR 99° 647G QGG 6Q 694 IR A 699

ARG § SRS IR QL .
Now just check if everyone has done so and play the video again.

Y69 T6a 667 A0 96 97169 KR IR 99° 086 § 9asla oI

76.To stop video time at 16 minute 15 seconds in VLC Media Player.

COMPUTER SHIKSHA

Closing Writer. AN g L /R |

o=

Close Button

Stop video here and ask students to close their file and then play the video
again.

JE0I6Q 66 @ 9% A9 99° ]Ig FIeg 9% J0I6R TFIRM § 98 A6
G° QILIU6R BR6 § YRS omidl
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77.To stop video time at 17 minute 37 seconds in VLC Media Player.

COMPUTER SHIKSHA

Shut down your computer.

290 eflaca g 98 |9 |

Stop video here and ask students to shut down the computer properly and then
play the video again.

20169 836 § 98 99 99° |IE AIeg 92 *fAcA § 98 994! IR 98°
QlTITER @66 § YRS S,
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Complete teacher’s manual for Open office writer 2 Class 3

Class 3 Summaries

How to open writer file?

ARTA A PR G 6996 B6UF FQULN ?
Use of insert menu.

RAEIS 6617 QA FULLIR

About the manual break.

Manual break Y6

What is header and footer?

GO 9Q° PO R4l ?

What is the use of hyperlink?

Hyperlink @ @UYL«I @6l ?

How to insert hyperlink?

Hyperlink § 6886 K099 @QULN ?

How to insert pictures on the writer page?
AURTA QA 694 6Q 52 q 676 QRIS KU
How to draw shapes on the writer page?
AURNGR 69K 6 draw shape 6986 @I .
How to shut down computer.

AR q 69716 /L AU

Now let’s start video.

29 969 Q&6 2198 K< .

Supported By “Human Development Foundation”

bridging the digital divide

33



COMPUTER SHIKSHA

..... bridging the digital divide

78.To stop video time at 28 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell 9] 086 696090 ¢EQ 96 g6d
what are non-printing characters? QLAINe & ?

1]

,(l Non-Printing
% Characters

Stop video here and ask students, if they can tell what are None-printing
characters?

JE0I69 @63 q 9L A9 99° I AIeg JFIR 697168 @EUIRAES “None-

printing character" @61?

Just listen to the answers and play the video again for the correct answer.
QAR § G4 9G° 90 AR AR BE6 § YRS SR |

79.To stop video time at 01 minute and 07 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell what is difference £692I9¢ I9° 6681 AUERN
between undo and redo? a1dey 06 QRAING ?

- o M |
.

Stop video here and ask the students, do they know the differences between
‘Undo and Redo’?

JE0I69 @63 Q 9L A9 99° RIE AIeg J9IR 697168 Qe I9° 6962

CrIER AIRY K4l RISRT ?
Just listen to the answers and play the video again for the correct answer.

Q9 § g4 99° 0] QA9 dIf 8E6 § JasIa ol |
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80.To stop video time at 1 minute 37 seconds in VLC Media Player.

COMPUTER SHIKSHA

Canyou tell QLIRS 6869 QIR ¢ £67 Faf
how will you remove status bar? LR AINE ?

, 1
Az

Stop video here and ask if they can tell how will they remove ‘Status bar’?
Y@0I6Q G@G § 9% A I9° JoIQ 640160 @LUIR6R /IFD QA § 694G

2o I ?
Just listen to the answers and play the video again for the correct answer.

QRQ § g4 99° 90Q 29 IR 8&E6 § AR eI |

81.To stop video time at 2 minute 05 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell why use find and eEAINS 2i6A FING 94 694
replace? QIES SYSLIR SRAIR |

Find & Replace

Stop video here and ask if they know why we use ‘Find and Replace’ option?
JE@0I69 ©E06 @ 9% AR 99° dFIR 649167 RISIRT 2I6E FIRE 99° Q69

29E § FIRE USTIR KRR ?
Just listen to the answers and play the video again for the correct answer.

QAQ § 4 99° 0] 29 IR 8&6 § A eI |

82.To stop video time at 2 minute 33 seconds in VLC Media Player.
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COMPUTER SHIKSHA

Now open your writer file. seg.gaa Qlﬂgg Iﬂ’lﬂﬁ) f 6eae

Stop video here and ask students to open the writer file using any method and
then play the video again.

JE0I6Q ©E6 g 9L AR 99° I8 FIeg 69164 Ia QI QUL 91
ARG A PR G B6IF RIS IR FL YG° CITIV6R BEB § YRS

omie .

83.To stop video time at 3 minute 35 seconds in VLC Media Player.
Stop video here and ask students to open writer file as shown in the video.

JE0I6Q @63 q 9L 29 99° RIg AIng @63 62 696! NS AF AN
QAT G 6698 AR AR 9L .

Now just check whether they have opened the writer file or not and then play
the video again.

Y69 56Q 607 @RF2 699168 AURTA A PIRM § 364U A 6QNRT @

Q1@ 98° GITIT6R QBB § YRTIa omI2l

84.To stop video time at 3 minute 51 seconds in VLC Media Player.
. 4

What will we learn today?
2IF 2169 96 §giel ?
In today’s class you will all learn about 2R F19 691 £641 Al6R de169 aedd
the Insert menu. 661Q SHA6R FIEIS |
e Edit Yie Format Table ook Windoy P

COMPUTER SHIKSHA

UUUUU led 1 - OpenOffice Writer

gE-v H2mETQ 0,
Exam freE€ A-Y-2-y

Stop video here and ask, what will we learn today?
JE0I69 @63 Q 9% @9 99° JoIA 2R 26e K&l SFQl .
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Just listen to the answers and play the video again for the correct answer.
QA q §4 99° 0K AR JIR 8&G q QG‘G{IQ omiel |

85.To stop video time at 4 minute 35 seconds in VLC Media Player.
. 4

COMPUTER SHIKSHA

Now all of you type out the 980169 6961DINAYS] AINGIL T
paragraph as shown here £6£1 97169 IR Q@ |

As he opened the door of almirah he was surprised to
note that all the apples had become rotten. He felt

ired effect. The boy
gave up bad company and became good again.

Stop video here and ask students to type the paragraph as shown in video?
JE@0I69 ©E06 q 9% AR 99° I8 AIeg 8@6 63 696l AN @F AN
q olnd 9 ?

Now just check and play the video again.
Y69 569 607 @052 99° 063 qQ qqe‘la omiel

86.To stop video time at 4 minute 47 seconds in VLC Media Player.
=

COMPUTER SHIKSHA

3 Q046 661G ¢ FIET QUeLIR
?
Why is the Insert menu used ? QQUQIa 2

Insert Menu

Stop video here and ask if they can tell why the Insert menu is used?
E0I6Q @63 § B9 A9 I9° JFIR 6961168 A& U6 AFDS 6417 G
RILR LTI FAG ?
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Just listen to the answers and play the video again for the correct answer.
QAQ g g4l 99° 90 QA IR QLB § JRSIR SR |

87.To stop video time at 5 minute 19 seconds in VLC Media Player.

g

COMPUTER SHIKSHA

What is Manual Break and 661g2IM 69Q @61 IG° 21671 ILIG
why do we use it ? FIET QUeLIR *AIQ ?

)

Az

Stop video here and ask if they know what is ‘Manual Break’ option and why
we use it?

YQ0I6Q 08B § 8% A 98° I9IQ 6971167 RISIRE “manual break” 29e

Qe 2lesl 9elq QLG QUeTIQ *TRIR ?
Just listen to the answers and play the video again for the correct answer.

QA9 § g4 98° 908 Q99 AR 668 § IR oM |

88.To stop video time at 6 minute 23 seconds in VLC Media Player.
Stop video here and ask students to click on ‘Manual Break’ option as shown in
the video and then play the video again.

20169 G838 § 98 99 99° I8 FIeg G2 “manual break” YR 69 {9
Q99! dIR 609 AF GG 65 694l ARAR I9° FITIT6ER BTG § YRR
SRl

89.To stop video time at 6 minute 55 seconds in VLC Media Player.
Stop video here and ask students to click on ‘Page Break’ option as shown in
the video and then play the video again.

IZ0I60 DE6 § 9% A9 I9° |IG FISG 92 page break 2Ye 69 &S /84S
IR 699 OF G@6 68 694l AIRAR I9° ITIT6ER BFE § YIQ SR
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90.To stop video time at 7 minute 40 seconds in VLC Media Player.
Stop video here and ask students to do ‘Line Break’ as shown in the video and
then play the video again.

20169 883 § 98 99 99° RIS AIeg < line break @3S AR & K49
692 QO 866 61 696 UIRAR I9° FILIV6R K86 § YA SR

91.To stop video time at 8 minute 04 seconds in VLC Media Player.
Stop video here and ask students to do as shown in the video and then play the
video again.

JE@0I69 63 q 9L 29 99° RIg 7Ieg 883 69 6.6l AN A AR
dIR 9L IG° QITIU6R @BG6 § ARSI oM .

Now just check, whether they’ve used ‘Manual Break’ option or not, and play
the video again.

Y69 56Q 607 @72 649168 manual break 2Ya Q QUSRIR FRAIARE @
QE 98° WBB § eI I .

92.To stop video time at 8 minute 19 seconds in VLC Media Player.

4 34

COMPUTER SHIKSHA

How are Fields used and for DR YR 6908 9e° Q6 aIgl
what ? UL FUAIN ?

Stop video here and ask why we use ‘Fields’ option?

20169 8136 § 9 99 99° JFIQ 26E “Fields’ AYR Q UL FIEG
R0E .

Just listen to the answers and play the video again for the correct answer.
QA q §4 99° A0 AR AR 86 q QG“FSI‘& omid |
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93.To stop video time at 9 minute 45 seconds in VLC Media Player.
Stop video and ask the students to insert the date as shown in the video and play
the video again.

JE0I69 63 Q 9L 29 99° I AIeg 883 69 6.6l AN AF SIS q
RAEIS 229! IR 9L IS° 866 § YRR SR |

94.To stop video time at 10 minute 56 seconds in VLC Media Player.
Stop video and ask the students to insert the ‘Time’, ‘Page number’, ‘Page
count’ as shown in the video and play the video again.

JE0I69 @63 q 9L 29 99° I 7Ieg 92 ©@3 69 66! AN QU
‘FIRE1°, ‘60% RAR 607 RIRE REIT F2S! IR IG° 866 § YRR
oI |

Now just check, whether they’ve inserted the ‘Fields name’ or not, and play the
video again.

966 567 66] @9G2 69416Q ‘Fields name’ 9 ARG 22IRRE & Q1L
G° BB6 § YRS oRIZ .

95.To stop video time at 11 minute 03 seconds in VLC Media Player.

=

COMPUTER SHIKSHA

Can you tell why we use 266 ANART QITS QUeLIN
hyperlink? QAR STARL | ?

Hyperlink

Stop video and ask if they know why we use ‘Hyperlink’ option?
JE0I69 63 Q 9L A9 99° JoIQ 699116R QGRS 2I6¢1 ‘Hyperlink’ 219Q

QA LR FIEG FAB ?
Just listen to the answers and play the video again for the correct answer.

Q9 § g4 99° 0] QA9 dIf 8E6 § JasIa ol |
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96.To stop video time at 12 minute 15 seconds in VLC Media Player.
Stop video and ask students to click on the Insert menu and then play the video
again.
JE@0I69 @63 Q 9L @9 99° I AIeg 99 RIS 6019 QU6 §a 234l
dR Qe I9° GITIT6R 8B3 § LGS SR .

97.To stop video time at 12 minute 28 seconds in VLC Media Player.
Stop video and ask the students to click on the ‘Hyperlink’ option as shown in
the video.
JE0I69 @63 Q 9L 29 99° I Ieg 92 ©@3 69 66! AN QU
‘Hyperlink’ 2YE 69 8 99 AR .
Just check whether the box has appeared or not as shown in the video and then
play the video again.
969 569 699 90GY 699 O GB6 69 694l UIRAR 69297 9F 2GR &
Q@ 99° QILIg6a GE6 § eI oI

98.To stop video time at 13 minute 34 seconds in VLC Media Player.
Stop video here and ask students to choose any file and then click the ‘open’
button as shown in the video.
JE0I69 @63 Q 9L A9 99° I 7Ieg 99 ©@3 69 66! AN QU
662144 M § 6T AR6S YQ° QILITER B6UR 9F QU FA
A6
Just check and play the video again.
P62 697 ARG 99° BE6 § YRR SR

99.To stop video time at 13 minute 58 seconds in VLC Media Player.

Stop video here and ask students to click on the ‘apply’ button and then
followed by ‘close’ button as shown in the video.

JE0I69 ©E6 g 9% AR 99° I8 FIfg 98 986 63 695l AN F
apply 999 Q69 Ga KA6Q IQ° 6N 9 q 69H6S .

Just check and play the video again.

P62 697 ARG 99° 966 § PRSI SN
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100. To stop video time at 14 minute 25 seconds in VLC Media Player.
Stop video here and ask students to open the Hyperlink as shown in the video.

JE@0I6Q @63 @ 9L @9 99° RIg AIeg ©&6 6 694 JIRYS QR

Hyperlink 3699 @919 IR QT .

Just check whether they have opened the link or not and then play the video
again.

T6@ 698 AR 697168 69 link § 3698 SRR @ 1T IS° BE6 §
JesIa SR,

101. To stop video time at 14 minute 40 seconds in VLC Media Player.
Stop video here and ask the students to close the current page and then play the
video again.

20169 836 § 98 99 99° |IE FIeg SAIF A 698 § 9L 99! IR gL
G° 866 g ATl oM.
102. To stop video time at 13 minute 49 seconds in VLC Media Player.

w7

COMPUTER SHIKSHA

What is a Header and 6200 Q61 99° IQIg 2l6F 6908
how do we use it ? LUELIN *NE1 ?

Stop video here and ask them do they know what is ‘Header’ and how to use it?
JE20I69 @63 q 9% A 99° I AFIR 697160 RISIRES header @4l IQ°

J21q QULLIR 6906 QUL ?
Just listen to the answers and play the video again for the correct answer.

QAQ § g4 99° 0] 29 IR 886 § 9AIQ eI |
103. To stop video time at 16 minute 05 seconds in VLC Media Player.
Stop video here and ask the students to insert the ‘Header’ as shown in the

video.
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YE@0I69 ©E6 @ 9% A 99° I8 AIeg 8@6 63 696! AN QfF header

g 2099 AR §L .
Just check whether they’ve inserted the header or not and play the video again.
QA q §4 99° A0 AR dIR @63 q gﬁ‘élfﬂ omid |

104. To stop video time at 16 minute 57 seconds in VLC Media Player.
Stop video here and ask the students to type story name in the ‘Header box’ as
shown in the video and then play the video again.

JE@0I69 66 Q 9L 29 99° ]Ig AIng 98 &6 6Q 694 ARSI QF
header € 69! story Q QIFl 6RYS! IR .MG° FITITER ARG § YRR
oI,

105. To stop video time at 17 minute 07 seconds in VLC Media Player.

COMPUTER SHIKSHA

R Q61 99° LI 69AF QUeLIR
QAU ?

Stop video here and ask them do they know what is ‘Footer’ and why is it used?
JE0I6Q 086 q 9% 9 I98° 697197 dFIR 647160 RIERS footer @8l 9_°

92Ig 2I6E RIEG QUETIR /IR ?
Just listen to the answers and play the video again for the correct answer.

Q99 § g4 99° 0] QA9 dIf 8E6 § JasIa el |

106. To stop video time at 17 minute 51 seconds in VLC Media Player.
Stop video here and ask the students to insert the ‘Footer’ as shown in the video.
Just check and play the video again.

JE0I69 @63 @ 9L A9 99° I Ieg 883 69 66! AN @ footer @
insert @291 AN §2 NG° BE6 § YRR SRI.
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107. To stop video time at 19 minute 00 seconds in VLC Media Player.
Stop video here and ask the students to insert the date and page number on the
‘Footer box’ as shown in the video and then play the video again.

G060 QBB § 98 a9 I9° RIS AIeG 98 &6 69 694 AINIYS| AR
footer @ 69 date YG° 69@ PAA RAIS KR! AR IG° GILIV6R QL6 q
gesia SmI2.

Now just check whether students have inserted ‘Header and Footer’ or not and
then play the video again.

969 699 @9G2 99 RIS header 99° footer § insert @ARE & Q12 9S°
QIEIU6R BEG § PRSI oM.

108. To stop video time at 19 mlnute 10 seconds in VLC Media Player.

COMPUTER SHIKSHA

2ies AINGR 69 ¢ g8g 60A8
Can you tell how we use Pictures 98" QITE QUL 9 661
in Writer and why ? QeaIae & 2

Stop video here and ask them if they know how to bring pictures on the writer
page.
JE0I6Q @63 q 9L a9 Y9° 6991Rg JFI 69768 KISIRT AURTA page

69 5¢ 6a41E MG .
Just listen to the answers and play the video again for the correct answer.

Q99 § g4 99° 908 QA9 AR §E6 § JasIa el |

109. To stop video time at 20 minute 26 seconds in VLC Media Player.
Stop video here and ask students to click on the ‘Insert’ menu and then click on
the ‘Picture’ option as shown in the video and then play the video again.
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JE@0I69 ©E06 @ 9% AR 99° I8 FIeg 92 9@6 6 695l AN aF
RAFS 6619 QU6 {7 ARG AR YG° QITIT6R TR AYR 62 {R KR!
QIR 99° FILIER YRR QBB § oI,

110. To stop video time at 21 minute 01 seconds in VLC Media Player.

Stop video here and ask students to choose any picture and then click on the
‘Open’ button as shown in the video and then play the video again.

JE0I69 ©E06 g 9% AR 99° I8 FIeg 9L 9@6 6 695 AN R
69100 §¢ g J6MY KA6S YQ° B69R TR QU6 FR AR 9Q°
QlTITER PRSI 8G3 § SR,

111. To stop video time at 21minute 11 seconds in VLC Media Player.

Stop video here and check whether they have inserted a picture or not and then
play the video again.

YZ0I6Q Q%G8 § 99 A9 IG° 99 667 2202 697168 52 § Redd KR8
@ Q1T 96° BB6 § YRR SR,

112. To stop video time at 22 minute 11 seconds in VLC Media Player.

Stop video here and ask the students to draw the Oval from the Drawing bar as
shown in the video.

JE0I69 63 Q 9L 29 99° ]I ARG 56 6Q 696 AR af SR° QI

69 oval draw Q99! AR QE.
Now just check if everyone has done so and play the video again.

Y63 069 657 2002 d0169 KR AIRRE I9° @66 g JASIa omId .

113. To stop video time at 22 minute 47 seconds in VLC Media Player.

Stop video here and ask the students to change the shape outline and line width
from the drawing bar as shown in the video.

JE@0I69 @63 Q 9L A9 99° Rl FIeg 99 GE@3 69 66! AN QU
RFRRE A shape ERINS IR IS° ER° QA A line width SRS
AR .

Now just check if everyone has done so and play the video again..

Y69 60 656 F9GY 99 90169 KR AIRRE I9° V66 § JASIa oM .

114. To stop video time at 23 minute 36 seconds in VLC Media Player.
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Stop video here and ask the students to change the shape outline color and area
color from the drawing bar as shown in the video.

IZ0160 AEG § 96 A9 I9° YZ0I6Q ABE § 99 99 I9° |1 FIeg 8
GG 69 669l ARSI AR ARTRANS A AN IG° R° A A area AN
g QGRI2l.

Now just check if everyone has done so and play the video again.
Y69 T6a 667 2202 96 97169 KR AI0RE N9° @66 § YRS SR,

115. To stop video time at 23 minute 45 seconds in VLC Media Player.
v

COMPUTER SHIKSHA

Save your file anywhere in £691 £610 FIAA § *HAQACA A
computer. 691619 RI916% 69 | |

)

Stop video here and ask the students to save the writer file and then shut down
the computer.

JE0I6Q 63 @ 9% 29 99° ]Ig ARG 9L AURNTA X PIRM § 69R AR

AR 9e° fRTR § 99 9 .
Just check whether they have shut down the computer or not.

468 569 66 901Re AT 697169 aFAT § 96 FRETRRE & FIE.
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Class 4 Summaries

How to open writer file?

AURTA A PIRM § 6996 B6UT FQULN ?
Use of insert menu.

RARS 6619 A FUILIR

About the manual break.

Manual break Y6 .

What is header and footer?

GO R PO R4l ?

What is the use OF hyperlink?

Hyperlink @ @ULI @6l ?

How to insert hyperlink?

Hyperlink § 68616 2096 aaUai ?

How to insert pictures on the writer page?
ARGA Q 6IRER 5 69716 RADS FAULIN ?
How to draw shapes on the writer page?

AURNGA R 6dR 62 608G draw shape SQULIG ?
How to shut down computer.

AFAQEQ @ 6276 9L AU

Now let’s start video.

29 Q&6 21 K< .
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116. To stop video time at 42 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell what happens efaIqe 216¢1 6468696 69%
when we use page break ? 69Q QUSLIR FAAIR Q6] 6LINAIN?

, 1
Az

Stop video here and ask them if they know why we use ‘Page Break’?
YE@0I69 ©E6 @ 9% AR 99° JFIR 699167 RISIRE 2I6E page break @

FIEE QUSTIR FRAIR ?
Just listen to the answers and play the video again for the correct answer.

QRQ § g4 99° 90Q 29 IR 8&E6 § AR eI |

117. To stop video time at 1 minute 05 seconds in VLC Media Player.

COMPUTER SHIKSHA

Canyou tell ‘;":7; ;‘a"pe"s with QTUINS BR TN 96 62IRAN ?

Stop video here and ask them if they know what is ‘Fields’ option ?
YE@0I69 ©E6 @ 9% AR 99° JFIR 64CI6R QSRS “Fields’ option K6l ?
Just listen to the answers and play the video again for the correct answer.
QAQ § 4 99° 0] 29 IR 886 § A eI |

118. To stop video time at 1 minute 25 seconds in VLC Media Player.

Supported By “Human Development Foundation” 48



COMPUTER SHIKSHA

veree--.. bridging the digital divide

COMPUTER SHIKSHA

Can you tell QLIRS LINANRS FIN Q61
what happens with Hyperlink ? 6LIRNAN ?

, 1
2l

\
Stop video here and ask if they can tell what is ‘Hyperlink’ option?

JE0I69 063 q 9L A9 Y9° JoIQ 6491168 @8 AIRAES ‘Hyperlink® option
@4 ?

Just listen to the answers and play the video again for the correct answer.
QAQ § g4 99° 90Q 29 IR 886 § AR eI |

119. To stop video time at 1 minute 57 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell what happens with QEZAINL 620 99° FTA FINU Q61
Header and Footer ? 6LIRNAN ?

‘ . ’74“‘ 3

Stop video here and ask what is ‘Header and Footer’ option ?

JE@0I69 @63 q 9% @9 99° JGIQ ‘Header and Footer’ option @4l ?
Just listen to the answers and play the video again for the correct answer.

QAQ § 4 99° 0] 29 IR 886 § A eI |
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120. To stop video time at 2 minute 42 seconds in VLC Media Player.
=

COMPUTER SHIKSHA

Now open your writer file. pIEE 40 ngg lmem g Geae

Stop video here and ask students to open writer file as shown in the video and
then play the video again.

JE@0I69 @63 Q 9L 99 99° Rl 7Ieg 92 ©@3 69 66! AN QU

ARA QA FIRM § B6UR FR6E IS° FILIN6R VLB § YRR S,

121. To stop video time at 3 minute 07 seconds in VLC Media Player.
. 4

COMPUTER SHIKSHA

Have you all been able to open the £661 47169 QAUNT'A O PIAM §
Writer file ? 3698 QAAIRS @ ?

Stop video here and ask students to type the paragraph as shown in video.
JE20I69 63 @ 9% 99 99° RIg ARG 9L ©G3 61 6@l NS AR 98

dIQUPIr § PR FRER
Now just check and play the video again.

Y69 T6@ 657 R0 IG° BEG § YRFIR oI,
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122. To stop video time at 3 minute 11 seconds in VLC Media Player.

=

COMPUTER SHIKSHA

Have you all typed out the £6€1 96169 aIQugIer ¢ g oied
paragraph ? Focem e ?

He went to market and purchased some fresh
apples and a rotten one. He came back to his
home and called his son. He asked his son to put
all the apples along with the rotten one in the
almirah. The son did the same. After some days
father asked his son to bring the apples.

Stop video here and check whether they have typed out the paragraph or not and
then play the video again.

YE@0I69 ©E6 g 9% AR 99° 667 990 690168 AIQUIIP q FIRd FARE
QL .

123. To stop video time at 3 minute 19 seconds in VLC Media Player.
=

COMPUTER SH\K§HA
Sl1a69, 651 97169 AIUGIP §
. Mext, all of you shois how ta FO5 20T QISIER QS SN
divide the paragraph in two parts. cacI2l |

To divide the

% parts

Stop video here and ask students to divide the paragraph in two parts and then
play the video again.

JE20I6Q @63 q 9% 29 99° ]Ig AIeg 9L dIQIFICP § 2 QIFIER FeD

A6 Y9° QIRINER ©BB § qa‘eﬁa omiel.

124. To stop video time at 3 minute 58 seconds in VLC Media Player.
Stop video here and ask students to bring the cursor on the first line of the
paragraph and play the video again.

20169 GB3 § 98 99 I9° |Ig FIeg g2 899 § AIGIF QAR §
21891 IR 99° GFG § gRSIa oI,
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125. To stop video time at 4 minute 27 seconds in VLC Media Player.
Stop video here and ask students to click on ‘Line Break’ option as shown in the
video and then play the video again.

YE@0I69 ©E6 @ 9% a2 99° I8 FIeg 92 9@6 6 695l AN F
line break ZYE QAUER {7 AR AR IG° QITIVER BLG § YL S,

126. To stop video time at 5 minute 16 seconds in VLC Media Player.
Stop video here and ask students to click on ‘Page Break’ option as shown in
the video and then play the video again.

JE0I69 @63 Q 9L 29 99° I Ieg 92 ©@3 69 66! AN QU
page break IYE QU6 G2 209! AR I9° FILIV6R BEB § YRR
Smi.

Now just check whether they’ve done ‘Manual Break’ or not, and play the video
again.

96Q 569 699 f0G2 699169 manual break @8 AFKE & FIE 99°
Jesia emil.

127. To stop video time at 45minute 49 seconds in VLC Media Player.
L :

COMPUTER SHIKSHA

Now write your name in the Y6 6LCR 60 §F1 RIF 6ME 9Q°
Header and also show how you £661 686 FaR A9 Ad eQe €lLl
can insert the date also. a1 6l |

Using Header

Stop video here and ask students to do practice of ‘Header’ and then play the
video again.

J@0I6Q BE6 § 98 99 99° KIg AIeg “header’ Q ARUIY SRS IR §L
G° BE6 § YRR oI,
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128. To stop video time at 6 minute 23 seconds in VLC Media Player.
Stop video here and ask students to insert Header as shown in the video and
then play the video again.

20169 G838 § 68 99 Ie° RI8 FIeg 52 86 69 626! ARSI OF
header § insert 85169 I9° GILIUER 8G6 § YRR oRI2.

129. To stop video time at 7 minute 06 seconds in VLC Media Player.
Stop video here and ask students to type the name and date in the ‘Header box’
and then play the video again.

YE@0I69 ©E06 @ 9% /R 99° I8 AIRg header box 62 @Il 9Q° QI
6MGYS JIR 98 I9° SIQITER ©66 § YRR SRI.

130. To stop video time at 07minute 20 seconds in VLC Media Player.

=’

COMPUTER SHIKSHA

] . SIg6R, ARTARR ¢ FUSLIR SR
N 'y
s, open any ok file by yising 6965163 66159 PIAR § B68S
the Hyperlink. ea |l

Using Hyperlink

Stop video here and ask students to open any file using ‘Hyperlink’ option and
then play the video again.

YE0I6Q GEB q 9% A I9° RIg FIRg 9L ‘Hyperlink’ Q 2YR § QULLIQ
A3 66R16T PR § B69E AR AR GL .

131. To stop video time at 07 minute 46 seconds in VLC Media Player.
Stop video and ask students to click on the Insert menu and then play the video
again.

20169 883 § 9 9 99° KIS AIFG insert menu QU6 7 QS| AIN
3L IG° BL6 § YRR SRI2.

Supported By “Human Development Foundation” 53



COMPUTER SHIKSHA

......... bridging the digital divide

132. To stop video time at 07 minute 51 seconds in VLC Media Player.
Stop video and ask the students to click on the ‘Hyperlink’ option as shown in
the video.

JE@0I69 @63 q 9% @9 99° I8 AIeeg ‘Hyperlink’ 29a QU6 {8 K<
IR 9T 60203 QPG 69 695! AIRIAR .

Just check whether the box has appeared or not as shown in the video and then
play the video again.

T6Q 699 A0 VGG 69 696l ARSI AR 690162 66159 Qg ALK @
Q1@ 98° FITIT6ER BEG § YRSl SR,

133. To stop video time at 08minute 48 seconds in VLC Media Player.
Stop video here and ask students to choose any file and then click the ‘open’
button as shown in the video.
JE0I69 @63 q 9L 29 99° ]Ig AIng 98 @63 62 696! AR o
6269168 FIRA § T6nT FAS! AIR IS° SITIIER 3697 TR AU {4
@RS IR QL .
Just check and play the video again.
Y69 560 657 R0 IG° BE6 § YRR oI,

134. To stop video time at 09 minute 04 seconds in VLC Media Player.

Stop video here and ask students to click on the ‘Apply’ button and then
followed by ‘Close’ button as shown in the video.

JE0I6Q 986 q 9L 9 I8° RIQ FlIeg ©&3 62 694 IR U apply

QFe RU6A FR F0G! AN L IS° GITIT6R close TF § 699!,
Just check and play the video again.
Y69 T6a 667 R0 IG° BEE § YRFIR oI,

135. To stop video time at 09 minute 30 seconds in VLC Media Player.
Stop video here and ask students to open the Hyperlink as shown in the video .

E0I69 ©66 § 88 AR 9Ie° |IE fleg §66 63 694l ARSI OF
Hyperlink § 3698 229 dIR 9E .
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Now just check if everyone has done so and play the video again.
69 T67 697 2202 99 97162 FRIRRE 98° BBG § YRS S .
136. To stop video time at 9 minute 40 seconds in VLC Media Player.

=7
COMPUTER SHIKSHA
Now use the Footer option to 96€ SN 69K 60 PERN AYE §

insert a page number on your QUELIN K5 66159 69F fER
page. 2896 /9 |

Stop video here and ask students to insert the page number in the ‘Footer’ box
and then play the video again.

JE0I69 G3 q 9% @9 99° g AIReg "footer box” 6 698 QAR G
insert @291 AR §2 . 99° QITITER 866 § YRR SR
137. To stop video time at 10 minute 15 seconds in VLC Media Player.

Stop video here and ask students to insert ‘Footer’” as shown in the video and
then play the video again.

JE0I69 W63 q 9L 29 99° Ig AIng Q83 69 696! AN @ footer @
insert 80191 QIQ 92 .M8° SILIU6 BFE6 § YRR SR

138. To stop video time at 10 minute 48 seconds in VLC Media Player.
Stop video here and ask students to insert page number on the footer box as
shown in the video and then play the video again.

JE0I69 63 Q 9L 29 99° ]Ig AIng Q83 69 626! AN QU footer
69 69% FARA NG GRS AR G N9° GIFIUER BLE § YRR S,

139. To stop video time at 11 minute 53 seconds in VLC Media Player.
Stop video here and ask the students to draw the Star from the drawing bar as
shown in the video.

JE0I69 @63 Q 9L A9 99° I ARG G183 69 646! AN Q& drawing

bar 69 star RFLS RS AN L .
Just check and play the video again.

69 56 667 2052 98° 96 § gasia oIl .
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140. To stop video time at 13 minute 11 seconds in VLC Media Player.
Stop video here and ask the students to change the Shape formatting from the
drawing bar as shown in the video.

JE0I69 @63 q 9% 29 99° Ig AIng @G3 62 6@46! AN @ drawing

bar 69 shape Q formatting § SeRIAG! QIR §L .

Just check whether they have changed formatting of drawing or not and play the
video again.

96Q 569 699 fGY 6971169 2@R° Q formatting § SGRIR 69RRE & FIL
8° GE6 § YRR SRI2.

141. To stop video time at 13 minute 29 seconds in VLC Media Player.
Stop video here and ask the students to save the file and then play the video
again.

@0I6Q GGG § 96 9 99° |1 FI9g FIAM g 699 999! AR 92 I9°
PE6 § YeSIR SR .

142. To stop video time at 13 minute 56 seconds in VLC Media Player.
Stop video here and ask students to click on the file menu as shown in the video
and then play the video again.

JE0I69 @63 q 9L 29 99° I AIeg 883 69 6.6l AN A I
6917 QU6R G FAS! IR G2 .

143. To stop video time at 14 minute 12 seconds in VLC Media Player.
Stop video here and check whether they’ve clicked on save submenu and the
box has appeared or not as shown in the video.

JE@0I6Q @63 q 9% 29 Y9° 654 2R 69716 69@ 6717 QUER {R /R

AR 969 620160 9 ATR & QT .
Just check and play the video again.
T6Q 699 2052 99° W63 qQ qa‘@‘m omi2l.
144, To stop video time at 14 minute 40 seconds in VLC Media Player.
Stop video here and ask students to type their name in the file name box as

shown in the video and then play the video again.
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JE@0I69 ©E06 @ 9% @R 99° I8 oG &G 63 696l AN QF
690169 file name @ 6 Kl IR AR AN L .

145, To stop video time at 14 minute 57 seconds in VLC Media Player.
Stop video here and ask students to click on save option as shown in video and
then play the video again.

YE@0I69 ©E06 @ 9% A 99° I8 AIeg 8@6 63 6Q5IKIRYS| A 69
28 QU6 GR 209 dIR 98 I9° SIFITER V66 § JRFIR SR,

Stop video here and check whether they have saved writer file or not and then
play the video again.

JE0I69 ©G3 @ 9L A9 YQ° T6a 659 2968 697168 ARG Q FIom q
69@ RS @ Q1T Y&° QITIU6R ©6G § YRR SR,

146. To stop video time at 15 minute 15 seconds in VLC Media Player.

COMPUTER SHIKSHA

Shut down your computer.

£a efiaca g 9L a9 |

Stop video here and ask students to shutdown the computer and then play the
video again.

JE0I6Q BE6 § 96 9 99° 8I¢ fIeg afasa § 96 294! IR §2. 98°
PE6 § YeFIR SR .
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Complete teacher’s manual for Writer 2 Class 5
Class 5 Summaries

v" Open your laptop/notebook and switch on.

S MUIISY /62199R 369 @ IQ° §6 2Q a9 .
v How to open Writer file and operate it.

ARG QA PR § 697G B69Q FAULN IS° YLIQ QUSRIR 694G @ULII
v" What is manual break?

Manual break @6l ?
v How to do page break?

Page break @ 698G QUL ?
v How to use characters option?

characters option § 6901% QUL KL ?
v How to use effects, font effects etc.?

effects, font effects 9Q° QGUIT @ 607G QUSRIQ AQULI ?
v" Why do we use default formatting?

2I6¢1 default formatting § 6986 QULLIR aIQ ?
v How to Close Writer file.

AURNGA A P G 6906 9L AU ?
v How to shut down computer.

AARTA § 9L 6975 AU .
Now let’s start class.

969 219 ©L6 Q 2 !9 .
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147. To stop video time at 33 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell which sub menu you 661 @RAIRE 68¢ 98° FINA §
will need to use to insert date and 69@ 69 89¢ eael Glﬁgsﬂ
time on your page ? 6Q% gR6rg § SISRIA /e |

=9l

bl

Stop video here and ask which sub menu is used for inserting ‘date and time
option?
E0I6Q 866 § 99 AR I9° JFIA “date IS° time’ § RELS KRR AR

699 submenu R FUGLIR FAICAI ?
Just listen to the answers and play the video again for the correct answer.

QAQ § g4 99° 90Q 29 IR 886 § 9a<Ia eI |

148. To stop video time at 48 seconds in VLC Media Player.

COMPUTER SHIKSHA

26 622 I9° FEA A RIS
Why do we use Header & Footer ?

Stop video here and ask if they know why we use ‘header and footer’?
JE0I69 @63 @ 9% 29 Y9° JoIQ 6476 @RAIRES 26T “header IQ°

footer’ § RI2@ QUSLIR KRR ?
Just listen to the answers and play the video again for the correct answer.
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Qa9 § g4 99° 908 2@ R @@6 § AR eRI |

149. To stop video time at 1 minute 12 seconds in VLC Media Player.

COMPUTER SHIKSHA

. " . LINIONS A SYSLIN FIAU §6€1
Using Hy;?erllnk how many files 6Q6oI0 Tlan g £919 608 68
can you insert on your page ? aedd 0610188 ?

- :IIJ!

.

Stop video here and ask them how many files can be inserted using hyperlink?
JE0I69 @63 q 9L @9 99° 699I9g AFIA hyperlink Q! QULLIA A1
626015 PIRN § RIS FAAIRS ?

Just listen to the answers and play the video again for the correct answer.
QAR § 98 9G° 90 AR AR BE6 § RIS |

150. To stop video time at 1 minute 30 seconds in VLC Media Player.

COMPUTER SHIKSHA

Canyou tell geel QQOI@Q LNLONT PR §
how is a Hyperlink file opened ? 608 3698 QAUAII ?
) (.z.e

- o

N =

Stop video here and ask them if they know how to open ‘hyperlink file’?
JE20I69 @63 q 9% 29 99° JoIQ 6996% QGRS “hyperlink file” @ 6986

369e @ULN] ?
Just listen to the answers and play the video again for the correct answer.

Q99 § g4 99° 908 QA9 AR §E6 § JasIa el |
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151. To stop video time at 2 minute 00 seconds in VLC Media Player.
=7

COMPUTER SHIKSHA

Canyou tell 2691 @2 QIS YQIE FRLIN Q4
what is a Standard Toolbar ? 268 ?

4
: 1
‘ I'J £ Ut 1 - pen0fice Bt
/ \ \\ Be [ ot o T ok e
DN E P T L R R T 1) TLL Ty
™ vinelten o0 v B/ Ez3n ZNEEL9D

Stop video here and ask if they can tell what is standard tool bar?

JE@0I69 ©E6 @ 9% AR 99° J9IR 649168 REAIRAES “standard toolbar”
@6l ?

Just listen to the answers and play the video again for the correct answer.
QRQ § g4 99° 90Q 29 IR 8&E6 § AR eI |

152. To stop video time at 2 minute 20 seconds in VLC Media Player.
=7

COMPUTER SHIKSHA

Now open your writer file. pEgE TGl Qlﬂgg me g Geae

Stop video here and ask students to open writer file and then play the video
again?
JE20I6Q @66 q 9% 29 99° RIg AIRg AURTA A FIRM § 364 AR

([} 9L I9° QIRINER ©EG § qa@ﬂa omi2l.

153. To stop video time at 3 minute 24 seconds in VLC Media Player.
Stop video here and check whether they’ve opened writer file or not and then
play the video again.

JE0I69 63 Q 9L A9 Y9° T6a 659 2942 697168 ARG Q FIom q
3695 SR8 @ QIE IG° FILIU6R BGG § YRR SMIZ.
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154, To stop video time at 3 minute 54 seconds in VLC Media Player.
"=

COMPUTER SHIKSHA

What will we learn today?
2IR 2169 !4 §iel ?
In this class you will learn about the 2IFQ FI9 68 §691 6PIFIS 667 A &8
options of the Format menu like; 9% g6 faa6a figle 6a906a;

i Untitied 1 - OpenOffice Writer

Ble £t Yow fnet Fomat Tibe Tooh Wedow bop
2-8-0s BE&8 9= & @E-v A2mE T4 @,
xam it-ae€ A-v-2-,

Stop video here and ask, what will we learn today?

JE@0I69 ©E6 @ 9% AR 99° A9IR 2R 26F @48l Fg! ?
Just listen to the answers and play the video again for the correct answer.

QAQ § 4 99° 90Q 29 IR 8&E6 § A eI |

155. To stop video time at 4 minute 21 seconds in VLC Media Player.
. 4

COMPUTER SHIKSHA

Now, all of you type out 968, §6¢1 97169 £ AINATA 661G
paragraph as shown in your 69 6961AINAS] AINGIEP T G
Writer page. giod et |

He went to market and purchased some fresh

apples and a rotten one. He came back to his

home and called his son. He asked his son to
put all the apples along with the rotten one in
the Almirah. The son did the same. After some
days father asked his son to bring the apples.

Stop video here and ask students to type the paragraph as shown in video?
JE@0I69 @63 q 9% 29 99° g AIeg Q83 69 646! AN A AIAUGIP

g 9199 9591 AN 9L .
Now just check and play the video again.
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156. To stop video time at 4 minute 27 seconds in VLC Media Player.
=7

COMPUTER SHIKSHA

Have you all typed out the £6€1 96169 alauglie g g oiad
paragraph ? FEEM A ?

He went to market and purchased some fresh
apples and a rotten one. He came back to his
home and called his son. He asked his son to

put all the apples along with the rotten one in

the Almirah. The son did the same. After some
days father asked his son to bring the apples.

Stop video here and check whether they’ve typed out the paragraph and then
play the video again.
YE0I69 8E6 g 9% 21 99° 564 60 27T T 6971161 FIRd

FRINRE 99° GITITER VBB § YRR SmI2l.

157. To stop video time at 4 minute 43 seconds in VLC Media Player.
=

COMPUTER SHIKSHA

Can you tell why we use the £661 FRAIRNS 2Al6H 696N
Character sub menu ? dQ6fg @ @6 dIR QUSRI QR ?

Character

Stop video here and ask why we use ‘character sub menu’?

JE0I6Q GGG § 98 @ I9° USIR 2lI6F! “character sub menu’ § RIZG@
LI *RRIIT ?

Just listen to the answers and play the video again for the correct answer.
QA q §4 99° A0 AR dIR @63 q QQQ‘IQ omid |

158. To stop video time at 06 minute 21 seconds in VLC Media Player.
Stop video here and ask students to select the paragraph as shown in the video.

E0I6Q 866 g 98 A I9° ]IS FIeg V86 61 604 RIS QF ARG
g d6me K9S AR 9L .
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Just check whether they’ve selected the paragraph or not and then play the
video again.
96Q 569 691 201G 620162 AIQIFIP § T6RT FOIRE @ A1 .

159. To stop video time at 6 minute 40 seconds in VLC Media Player.
Stop video here and ask students to click ‘Format’ menu and then click on the
‘Characters’ sub menu as shown in the video and then play the video again.

20169 836 § 98 99 99° |IE AIeg “format” 6919 § @ AAQIAIR g
98° GIQIY6R “Characters’ sub menu QUER 7 908! AR L€ 699 O
QGG 63 6QHININAR . 99° FILIT6R K66 § JAFIR SR,

160. To stop video time at 7 minute 34 seconds in VLC Media Player.
Stop video here and ask students to change the font name as shown in the video
and then play the video again.

JE0I6Q 63 q 9L 29 99° ]Ig AIng ©G3 69 696! AN @ font
name § SORIRS! IR §L. IS° GILIU6R VLGB § JASI SmI2l.

Now just check and play the video again.
J6Q T6a 607 AR 99° 0B q q{?élﬁ omlil.

161. To stop video time at 7 minute 48 seconds in VLC Media Player.
Stop video here and ask students to select the paragraph as shown in the video.

JE0I69 63 q 9L 29 99° Ig AIng Q83 69 696! AN A AIAUGIP
q J6ne KARIUIR 9S.

Just check whether they’ve selected the paragraph or not and then play the
video again.

96Q 569 699 290G 697162 QUG § T6AS FARE @ QI I9°
QITIU6R BHG § YR M2,

162. To stop video time at 8 minute 13 seconds in VLC Media Player.
Stop video here and ask students to click ‘Format’ menu and then click on the

‘Characters’ sub menu as shown in the video and then play the video again.
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20169 836 § 98 99 99° |IE AIeg “format” 6919 § @ AAQIAIR gL
\G° QITITER ‘Characters’ sub menu RUER {7 A2 IR 98 .6JQQM
QGG 63 6QHININAR . I9° FILITER V86 § YRR SR,

163. To stop video time at 08 minute 33 seconds in VLC Media Player.
Stop video here and ask students to do ‘Bold’ and ‘Italic’ as shown in the video
and then play the video again.

20169 836 § 98 99 99° RIS AIeg ‘Bold’ 98° ‘Italic’ @G QIR g€
6J20R V86 69 6RHNUARNAR . 98° FITITER BLG § YRR S,

Now just check and play the video again.
Y63 564 697 2002 18° VB3 g YRR Sl

164. To stop video time at 08 minute 47 seconds in VLC Media Player.
Stop video here and ask students to select the paragraph as shown in the video.

JE0I6Q @63 q 9L 29 99° ]Ig AIng Q83 69 696! AN A AIAUGIP
g J6ne ARSI AR 9L .

Just check whether they’ve selected the paragraph or not and then play the
video again.
96Q T6a 691 F0GY 6971165 T6ne FALIRRE & 917 99° Q86 § 9aTl
omliel.

165. To stop video time at 09 minute 04 seconds in VLC Media Player.
Stop video here and ask students to click ‘Format’ menu and then click on the
‘Characters’ sub menu as shown in the video and then play the video again.

JE0I6Q GGG § 96 99 99° I8 FIeg “format” 6617 § &% FASIUIR §E
8° GIQIY6R “Characters’ sub menu QU6 7 A0S R QL .6JQQ%R
PE6 69 6NV . I9° FILIN6R VLGB § YAl S,

166. To stop video time at 09 minute 31 seconds in VLC Media Player.
Stop video here and ask students to change the ‘font size’ as shown in the video
and then play the video again.
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JE@0I69 ©E06 @ 9% AR 99° I8 AIeg 8@G 61 696 AN @ “font
size’ § FORIRSI IR GL YG° GITIU6R BEG § YRS T2,

Now just check and play the video again.
Y69 56Q 607 K02 IQ° 986G q gﬁ‘él‘a omi2 .
167. To stop video time at 10 minute 10 seconds in VLC Media Player.

4.~

COMPUTER SHIKSHA

Can you tell 2661 @€ AIRS P SAQ FIQU K61
what happens with Font Color ? 6QIRAN ?

Font Color

Stop video here and ask if they can tell what happens with ‘Font color’?
YQ0I6Q 08B § 8% A 98° JoIQ 6471168 @LAIRER “Font color’ I K6l

6Ll ?
Just listen to the answers and play the video again for the correct answer.

QA9 § g4 98° 908 999 AR 668 § IR oM |

168. To stop video time at 10 minute 52 seconds in VLC Media Player.
Stop video here and ask students to select the paragraph as shown in the video.

JE0I69 063 @ 9L A9 99° ]I8 AIng ©E3 69 696! AN A AIAUGIP
g J6AQ 99 JIR QE.

Just check whether they’ve selected the paragraph or not and then play the

video again.

969 569 699 20GY 9T 624162 QIR § T6AT FRIRRE & Q12 9e°
QITITER V66 § PRSI SR,

169. To stop video time at 11 minute 58 seconds in VLC Media Player.
Stop video here and ask students to do as shown in the video and then play the
video again.
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JE0I69 ©E06 @ 9% AR 99° I8 AIeg 8@6 63 696! AN QF KR!
IR 8 99° ITITER Q66 § IR SR,

Now just whether they have changed the font color or not and play the video
again.

966 56 66Q @0G AT 696168 font color § SRR ANRE & Q1T 99°
QIEIU6R BEG § PRSI eI,

170. To stop video time at 12 minute 05 seconds in VLC Media Player.

PRz

COMPUTER SHIKSHA

Can you tell £661 QT GINE QCEPR FTIRU Q61
what happens with effects ? 6QIQAN ?

i

2l
EY

Stop video here and ask if they can tell what happens with ‘Effects’?
JE0I6Q ©E6 q 9L 9 I8° dFIQ 69¢1I6Q @EIRAES Effects’ IR Kl

6L I ?
Just listen to the answers and play the video again for the correct answer.

QAQ § g4 99° 90Q 29 IR 886 § A< eI |

171. To stop video time at 12 minute 51 seconds in VLC Media Player.
Stop video here and ask students to select the paragraph as shown in the video.

JE0I69 63 Q 9L 29 99° Ig AIng @83 69 66! AN A AIAUGIP
g J6mS 99Q1 AIR §E.

Just check whether they’ve selected the paragraph or not and then play the

video again.

96Q T6a 691 fGY 6901165 QI § T6AS FAANRE & AT 98°
QITITER W66 g YRS SmIY |
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172. To stop video time at 13 minute 08 seconds in VLC Media Player.
Stop video here and ask students to do as shown in the video and then play the
video again.

JE@0I69 @63 Q 9% 29 99° RIG 7Ieg 983 69 6.6l AN A AR
IR 98 96° GITIU6R AEG § YRSIa SR,

173. To stop video time at 14 minute 17 seconds in VLC Media Player.
Stop video here and ask students to do all the lines in Capital letter as shown in
the video and then play the video again.

JE0I69 @G6 q 9% @9 99° ]Ig AIeg 99 MRS q capital letter /9@
28R 62 KRG R G€ 699 A @86 6Q 69¢l ARAR I9° FILIV6R B&G
g eI oM.

174. To stop video time at 14 minute 35 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell 2661 9T AIRS 2AEH AATA 69
why we use outline in Writer ? AITRNAEG K6l IR SISLIQ KR ?

Stop video here and ask them if they can tell why we use ‘outline’ in the
‘Writer’?

JE@0I69 @63 @ 9% 29 99° JGIQ 649I6R fRUINES AURTR 6 2GS
‘outline’ § FI2G USLIA KR ?

Just listen to the answers and play the video again for the correct answer.
QAQ § 4 99° 0] 29 IR 886 § A eI |

175. To stop video time at 15 minute 13 seconds in VLC Media Player.
Stop video here and ask students to select the paragraph as shown in the video.

JE@0I69 ©E6 @ 9% AR 99° I8 AIfg €66 62 66Nl @f AP
q J6MQ 229! IR 9L
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Just check whether they’ve selected the paragraph or not and then play the
video again.

96Q 569 691 fGY 620162 QI § T6AT FAARRE & Q12 9e°
CIRIYER ©EG @ qgéla omid .

176. To stop video time at 15 minute 31 seconds in VLC Media Player.
Stop video here and ask students to do as shown in the video and then play the
video again.

JE@0I69 ©E6 @ 9% AR 99° I8 AIeg 8@6 63 696 AN QF KR!
IR §E 99° GIZI6R AEE § 9edIa eI,

177. To stop video time at 16 minute 47 seconds in VLC Media Player.
Stop video here and ask students to apply the ‘outline’ as shown in the video
and then play the video again.

20169 836 § 98 99 99° KIS AIeG ‘outline’ § F0SI N L 69N AF
QGG 69 694 AIRAR IS° FILIV6R 8GG § YAIR SRI.

178. To stop video time at 16 minute 51 seconds in VLC Media Player.

4.

COMPUTER SHIKSHA

Can you tell what is Shadow ? £651 GF QIRS 66161 961 ?

Stop video here and ask what is ‘Shadow’ and why we use it?

20169 8838 § 99 9 99° JFIR ‘Shadow’ @6 I8° 2I6S1 981G AR

LRI AR .
Just listen to the answers and play the video again for the correct answer.

QAQ § 4 99° 0] 29 IR 886 § A eI |

179. To stop video time at 17 minute 24 seconds in VLC Media Player.
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Stop video here and ask students to select the paragraph as shown in the video.
JZ0I6Q 0BG § 99 A I&° 818 AIeg AU § T6R K9S dIR 9
6JEN ©B6 69 6SHURAR .

Just check whether they’ve selected the paragraph or not and then play the
video again.

968 56 657 @952 626168 AT § 6T FORE & AIE 9e°
QITIU6R BHG § YRS oI .

180. To stop video time at 17 minute 53 seconds in VLC Media Player.
Stop video here and ask students to do as shown in the video and then play the
video again.

JE@0I69 ©E6 @ 9% AR 99° I8 AIeg 8@6 63 696 AN QF KR!
IR 98 I6° GITIU6R Q&3 § LSIR SR .

181. To stop video time at 18 minute 19 seconds in VLC Media Player.
Stop video here and ask students to apply the ‘Shadow as shown in the video
and then play the video again.

20166 GGG § 98 9 I9° RI FI9g ‘Shadow 99! UIR §L 6UAGG
QGG 63 696 AIRAR N9° SITITER VL6 § YJRFIA SR .

182. To stop video time at 19 minute 12 seconds in VLC Media Player.
Stop video here and ask students to remove the shadow from the lines as shown
in the video.

J@0I6Q BE6 § 96 89 99° &I IS line Q shadow 2FIRG! IR §L
60R9R QPG 6Q 69 IRAR .

Now just check whether they’ve removed the ‘Shadow’ or not then play the
video again.

96Q T69 698 FGe 699169 ‘Shadow’q 29IR AIRRE @ QI8 99°
CIRIYER 0GB Q Q@?éla omid .
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183. inute 22 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell what is Blinking and £671 @TAIRNS SEP @61 2A6E 98°
why is it used ? 9geIg QILE QUELIQ SN ?

Stop video here and ask if they can tell what is ‘blinking’ and why we use it?
JE@0I69 ©E6 @ 9% AR 99° J9IR 6491168 REUIQAES ‘blinking” KE I_°
261 991G FITG QUSTIR *DRIIG ?

Just listen to the answers and play the video again for the correct answer.
QRQ § g4 99° 90Q 29 IR 8&E6 § AR eI |

184. To stop video time at 20 minute 02 seconds in VLC Media Player.
Stop video here and ask students to select the paragraph as shown in the video.

JE0I69 @63 q 9L 29 99° ]Ig AIng Q83 69 696! AN A AIAUGIP
g J6mSQ 99Q1 AN §< .
Just check whether they’ve selected the paragraph or not and then play the
video again.
96Q 569 699 9G 697162 QUG § T6AS FAAGRE & QI 9e°
QITITER VBB § YRSIR omI |

185. To stop video time at 20 minute 21 seconds in VLC Media Player.
Stop video here and ask students to do as shown in the video and then play the
video again.
JE20I69 @63 q 9% @9 99° RIE AIeg 883 69 6.6l AN AR AR
([} 9L .9° PIRITER K63 qQ QQQ‘IQ omiel.

186. To stop video time at 20 minute 48 seconds in VLC Media Player.
Stop video here and ask students to apply the ‘blinking” as shown in the video.

JE20I69 @63 Q 9% @9 99° RIg AIeg 983 69 6.6l AN A
‘blinking’ @RS AR GL .
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Just check whether they’ve applied ‘blinking’ or not and then play the video
again.

J6Q 569 607 @R 647168 ‘blinking” @ ARES @ Q@ . 99° QIRIg6Q
PE6 § YRS SRI.

187. To stop video time at 21 minute 30 seconds in VLC Media Player.
Stop video here and ask students to remove the ‘Blinking’ option as shown in
the video and then play the video again.

20169 886 § 9 99 99° KIS FIeg ‘Blinking’ option § 26109 AR §8
699 O Q&6 62 693l ARIAR .

188. To stop video time at 21 minute 50 seconds in VLC Media Player.

PRz

COMPUTER SHIKSHA

Why do we use the Hidden 2I6E1 627 A USTIN K€ AIRY
option ? o ?

Stop video here and ask if they know why we use ‘hidden’ option?
JE20I6Q @63 q 9% A9 99° IoIQ 6471I6R @LAIRES 2I6¢] hidden’ option

QA LLIR FIEE FRAR .
Just listen to the answers and play the video again for the correct answer.

QAQ § 4 99° 0] 29 IR 886 § 9AIQ eI |

189. To stop video time at 22 minute 37 seconds in VLC Media Player.
Stop video here and ask students to select the paragraph as shown in the video.

JE0I69 @63 Q 9L 29 99° I AIeg 883 69 6L6IKINIYS QF AINUIIP
g J6mS 9991 AN §F .

Just check whether they’ve selected the paragraph or not and then play the
video again.
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969 569 699 29GY 697162 AU § T6AS FAARE & QI

QIEIU6R BEG § YRS oM.

190. To stop video time at 23 minute 05 seconds in VLC Media Player.
Stop video here and ask students to do as shown in the video and then play the
video again.

YE0I69 ©E06 @ 9% AR 99° I8 AIeg 8@6 63 696 AN QF KR!
dR QE .

191. To stop video time at 23 minute 33 seconds in VLC Media Player.

Stop video here and ask students to apply the ‘hidden’ as shown in the video.

JE0I69 @63 Q 9L 29 99° RIg FlIex Q@G 6Q 6946 ARSI @fF ‘hidden’
RS IR QE .

Just check whether they’ve applied ‘hidden’ or not and then play the video
again.
966 567 667 @0GY AT 696168 ‘hidden’ RRLIRGE & Q1T 99° 826 §
Jesia SR,

192. To stop video time at 23 minute 53 seconds in VLC Media Player.
Stop video here and ask students to bring back paragraph which they had hidden
as shown in the video and then play the video again.

JE0I69 @63 Q 9L A9 99° RIg 7Ieg 92 ©@3 69 66! AN QU
‘hidden’ RS AN § A6 2GS VR GL .MG° B&B § YRR

omlil.
193. To stop video time at 24 minute 06 seconds in VLC Media Player.

COMPUTER SHIKSHA

Canyou tell £661 8 IS BRa-MGP T Q6
what happens with Over-lining ? 6LINAN ?

Stop video here and ask if they know what is ‘Over lining’ option?
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JZ0I6Q GGG § 98 9 99° ASIQ 62€N6R ‘Over lining” option FIL&G

QUQQIQ 99T ?
Just listen to the answers and play the video again for the correct answer.
QA q §4 99° A0 AR R 886 q qgaﬂa omid |

194. To stop video time at 24 minute 56 seconds in VLC Media Player.
Stop video here and ask students to select the paragraph as shown in the video.

JE0I69 &6 @ 9% AR 99° I8 AIeg 8@G 63 696 AN @F AL
g 96AQ A9 AR L .

Just check whether they’ve selected the paragraph or not and then play the

video again.

969 569 699 90GY 9T 624162 ARG § T6AT FRGRE & Q12 9e°
PE6 g JaSIa oI,

195. To stop video time at 25 minute 16 seconds in VLC Media Player.
Stop video here and ask students to click on the ‘Format’ option and then click
on the ‘Characters’ sub menu and then play the video again.

JZ0I6Q Q@6 § 96 99 99° 818 AIeg format AYe AIER {Q AS! AR
Q< 9Q° GILIY6R “Characters’ sub menu QIER @ AR IR §€ IQ° QGG
g eI M2l

196. To stop video time at 26 minute 04 seconds in VLC Media Player.
Stop video here and ask students to apply the ‘over lining” as shown in the
video.

JE0I6Q 986 q 9L 9 98° RIE AlIeg Q63 6] 696l AN QR ‘over
lining’ @91Q AR QL .

Just check whether they’ve applied ‘over lining’ or not and then play the video
again.

96Q T69 691 fGY 69416% ‘over lining’ FAINRE @ QT 98° QBB g
JeSIR SRI .

Supported By “Human Development Foundation” 74



COMPUTER SHIKSHA

......... bridging the digital divide

197. To stop video time at 27 minute 02 seconds in VLC Media Player.

"

by

COMPUTER SHIKSHA

Can you tell why we use the strike 266162 aIfie alegl LI9e-67
through option ? QUELIQ QILE /1 ?
Strike through

Stop video here and ask if they know why we use ‘strikethrough’ option?
YE@0I69 ©E6 @ 9% AR 99° JFIR 69916 RIEIRE 26 strikethrough’
29 Q UL Qe a52R ?

Just listen to the answers and play the video again for the correct answer.
QAQ § 4 99° 90Q 29 IR 8&6 § AR eI |

198. To stop video time at 28 minute 37 seconds in VLC Media Player.
Stop video here and ask students to apply the ‘Strikethrough’ as shown in the
video.

JE0I69 @63 q 9L A9 99° RIg Ieg 883 69 6.6l AN
‘Strikethrough’ apply @961 QIR 9L .

Just check whether they’ve applied Strikethrough” or not and then play the
video again.

969 569 699 9a? 699169 “Strikethrough’ apply SRQIRRE & QI 9e°
QITINER BEB § YRS ORI,

199. To stop video time at 29 minute 16 seconds in VLC Media Player.
Stop video here and ask students to remove the ‘Strikethrough’ from the
paragraph as shown in the video and then play the video again.

JE20I6Q @63 q 9% 29 99° RIg AIeg AP Q “Strikethrough’ LGRS
IR 8 699 O ©&6 69 6% IRAR MG° GILIU6R B&E § YRR

omid .
200. To stop video time at 29 minute 27 seconds in VLC Media Player.
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COMPUTER SHIKSHA

Let us now learn about 219 QEAIR ALARINE FAAER
Underlining. figiel |

Stop video here and ask if they can tell why we use ‘Underline’?

YE0I69 ©E6 g 9% AR 99° JFIR 647168 REUIAES 26¢] ‘Underline’ §

QLG ISR *R2UQ ?
Just listen to the answers and play the video again for the correct answer.

QRQ § g4 99° 90] 29 IR 8&E6 § 9aIa eI |

201. To stop video time at 31 minute 38 seconds in VLC Media Player.
Stop video here and ask students to apply the ‘underline’ as shown in the video.

V20169 966 qQ 9@ @A I9° I8 7leg ©EG 69 694l IR OF

“underline” 66<I TN 9L .

Just check whether they’ve applied ‘underline’ or not and then play the video
again.

966 567 66Q @9GY 624168 ‘underline’ RARE & FIE I9° GITITER [BE
g A9l omI |

202. To stop video time at 32 minute 33 seconds in VLC Media Player.
Stop video here and ask students to change the underline color as shown in the
video and then play the video again.

@0I6Q GGG § 98 99 99° |1 FIeg underline A SR § FIRINS! AR
3L 69Q A ©G6 69 696l AR .

203. To stop video time at 32 minute 48 seconds in VLC Media Player.

Supported By “Human Development Foundation” 76



COMPUTER SHIKSHA

......... bridging the digital divide

COMPUTER SHIKSHA

2661 RTINS 6D6L6T6R 2i6e
i you te:; w:a' hapd"enls w;'e" QUIRFING SRR A FISLIN SRAIN
we use Background color Q6 62192119 ?

Background Color

Stop video here and ask if they know what happens with ‘background ‘option?
JE0I69 63 @ 9% A9 Y9° JoIQ 64¢1I6R QISIRT background ‘option

KU K6l 6L ?
Just listen to the answers and play the video again for the correct answer.

QRQ § g4 99° 90] 29 IR 8&E6 § 9aIa eI |

204, To stop video time at 33 minute 16 seconds in VLC Media Player.
Stop video here and ask students to select the paragraph as shown in the video
and then play the video again.

YQ0I69 866 q 8% AR I9° 8I8 Fleg G@G 69 696! IR @F AU
q J6MSQ A0S AR 98 N9° VBB § YRR SmI .

205. To stop video time at 33 minute 38 seconds in VLC Media Player.
Stop video here and ask students to change the ‘background color’ of the
paragraph as show in the video.

JE0I6Q 886 q 9L 9 98° I8 7eq AP Q background Q AN G

ERIAG! IR §F 699 AF QPG 69 695! AIRIR .
Now just check and play the video again.
Y69 T6@ 657 R0 IG° BEG § YRFIR oI,
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206. To stop video time at 34 minute 06 seconds in VLC Media Player.
. 4

COMPUTER SHIKSHA

Can you tell what happens with £69 @RaIfe G 6IdIde TIQI
default formatting ? @61 6LIN2AIN ?

i

% Default Formatting

Stop video here and ask if they can tell what happens with ‘default formatting’
option?
JE@0I69 ©E6 g 9% AR 99° JFIR 6471168 REUIAES “default formatting’

option Y19 @él 6€1N2IIN ?
Just listen to the answers and play the video again for the correct answer.

QRQ § 4 99° 90Q 29 IR 886 § AR eI |

207. To stop video time at 35 minute 40 seconds in VLC Media Player.
Stop video here and ask students to use the ‘default formatting’ as shown in the
video and then play the video again.

JE0I69 @63 @ 9L A9 99° I AIeg 883 69 66! AN @ ‘default

formatting’ @ UG LIR K0S AN L .
208. To stop video time at 35 minute 50 seconds in VLC Media Player.

COMPUTER SHIKSHA

Closing Writer. AN G €L @R |

==

Close Button

Stop video here and ask the students to close the writer file and then shut down
the computer.

IZ0I60 DEG § 96 29 I9° KIE FIFg 92 AATA A FIAR § 9L S5
IR G2 98° GILIU6a AfRsa § 98 999l AR 92 .
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Just check whether they have shut down the computer or not.
Y69 T6R 604 201F2 69768 AT § 9L A1 69083 & Qg .
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Complete teacher’s manual for Writer 2 Class 6
Class 6 Summaries

Open your laptop/notebook and switch on.

S MUIISY /62199R 369 @ IQ° §6 2Q a9 .

How to open Writer file and operate it.

ARG QA FIRM § 697G B69e @AM IS° YLIQ FULLIR 690G S,
What is manual break?

Manual break @él ?

How to do page break?

Page q break @ 687G @I ?

How to use characters option ?

characters option § 6901% QUL KL ?
How to use effects, font effects etc.?

effects, font effects 9Q° QGUIQ @ 607G QUSRIQ AQULI ?
Why we use default formatting?

2l16¢1 default formatting @ ALE QUSLIR AR ?
How to use line and spacing?

2I6E! line 99° spacing § 69¢16 QUSRIA 99G ?
How to insert drop caps?

drop caps § Re99 6086 QUL 2
How to insert border?

Border § 69616 RG99 @QUAIN ?
How to Close Writer file.

AURTA A FIRM G 6906 L YUK .
How to shut down computer.

AAQEQ @ 6276 9L AU .

Now let’s start class.

969 219 |I9 I /AR .

209. To stop video time at 49 seconds in VLC Media Player.
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COMPUTER SHIKSHA

Can you tell what happens with £69 @RaIe SR 6T IR
default formatting ? @6 6QINAIN ?

, 1
‘ ' ‘/I,Al 1
o

Stop video here and ask if they can tell, what is ‘Default Formatting’?
JE@0I69 ©E6 @ 9% AR 99° JFIR 699168 REUIRAES ‘Default Formatting’
@6l ?

Just listen to the answers and play the video again for the correct answer.
QRQ § 4 99° 90Q 29 IR 8&6 § AR eI |

210. To stop video time at 1 minute 14 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you say why we use £6¢1 @EAIRS 2I6F 6R6ALR
characters sub menu ? de6eg q @6 dIR SUSLIA QR ?

Character submenu

Stop video here and ask if they know why we use ‘Character’ option?

YE@0I69 ©E6 g 9% 9 99° A%IR 647167 QSRS 2I6E! “Character’

optionQ USRI ARG K9G ?
Just listen to the answers and play the video again for the correct answer.

QAQ § 4 99° 0] 29 IR 886 § 9AIQ eI |
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211. To stop video time at 2 minute in VLC Media Player.
. 4

COMPUTER SHIKSHA

Now open your writer file. HIES Sdbt nggg IO’IQS?( 7 Geae

Stop video here and ask students to open writer file and then play the video
again.

JE@0I69 ©E6 g 9% AR 99° 88 FIfg AURTA A FIRR § B6Ia KIS
IR 98 I6° A&6 § gReIq oI,

212. To stop video time at 3 minute 27 seconds in VLC Media Player.
v

COMPUTER SHIKSHA
Now, type out the paragraph Qaalg, £69 69611AINYS!
being shown to you. diugier ¢ ¢ ¢INd et |

There he saw bunches of fine, ripe grapes hanging

from a vine. His mouth began to water. He wanted to
eat them. So he jumped again and again, to reach
them, but in vain. The grapes were hanging too high
for him to get at them.
At last he gave up the attempt and went away
saying, "the grapes are sour. If | eat them, they can
harm me."

Stop video here and ask students to type the paragraph as shown in video?
JE0I6Q 63 @ 9L A9 99° RI8 FIeg &6 61 694 JIRYS! QR

AP § PR KRS ([} Q% .
Now just check and play the video again.

969 56 660 902 98° 886 § e oI,
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213. To stop video time at 3 minute 32 seconds in VLC Media Player.

"=

N

Have you all typed out the £6¢1 9€168 dIUGIEP ¢ g oindg
paragraph ? FoEeme ?

There he saw bunches of fine, ripe grapes hanging
from a vine. His mouth began to water. He wanted to
eat them. So he jumped again and again, to reach
them, but in vain. The grapes were hanging too high
for him to get at them.

COMPUTER SHIKSHA

At last he gave up the attempt and went away
saying, "the grapes are sour. If | eat them, they can
harm me."

Stop video here and ask if they have typed out the paragraph?

YE@0I69 ©E6 @ 9% AR 99° JFIQ 649168 QUYL 59 SInd fQARE ?
Just listen to the answers and play the video again for the correct answer.

QRQ § g4 99° 90] 29 IR 8&6 § 9aIa e |

214, To stop video time at 4 minute 14 seconds in VLC Media Player.
Stop video here and ask students to select the paragraph as shown in the video
and then play the video again.

YQ0I69 866 § R AR I9° 8I8 Fleg G@G 69 696! IR OF I
q J6MS ARSI AR §F N9° SITITER VB8 § JRFIR SR,

215. To stop video time at 4 minute 33 seconds in VLC Media Player.
Stop video here and ask students to click on the ‘Format’ menu and select the
‘Characters’ submenu and then play video again.

JE20I69 @63 q 9% 29 99° I AIeg ‘Format’ menu QU6 §8 29Q!
QIR §€ \IK° ‘Characters’ submenu § J6MG KR! IR G . 99° GILIY6R
PE6 § eI SR,

216. To stop video time at 5 minute 25 seconds in VLC Media Player.
Stop video here and ask students to change the font style as shown in the video
and then play the video again.
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JE@0I69 ©E6 @ 9% AR 99° I8 AIeg 6EG 6Q 695 AN @fF font Q
style § FORING! R GL .

217. To stop video time at 5 minute 59 seconds in VLC Media Player.

Stop video here and ask students to select the line as shown in the video.
JE0I6Q @63 q 9% 2 99° Ig AIng @63 62 6Q46! AINYS| OF ARG §
Jd6AQ SRS AIR L .
Just check whether they’ve selected the paragraph or not and then play the
video again.
969 569 699 9a 627162 ARG § T6NT FARE & Q@ 98°
QlTITER @66 § YRS SR,

218. To stop video time at 6 minute 19 seconds in VLC Media Player.
Stop video here and ask students to click on the ‘Format’ menu and select the
‘Characters’ submenu and then play video again.

JE0I6Q 986 q 9L 9 I8° I8 FIeg 9L format menu QU6 §F K6
JQ° QIRIOERQ “Characters’ submenu QUER F@ FRE6S I:° GIRIVER 866 §

JesIa SR,

2109. To stop video time at 6 minute 49 seconds in VLC Media Player.
Stop video here and ask students to change the ‘Font size’ of the line as shown
in the video and then play the video again.

JE0I6Q 026 q 9L A I8° RIE FIeg € 963 69 6Q% AN AR

RS A font size § FIRIAS! VIR IS° FITIYER BEG § YA SR,
Now just check whether they have changed the font size or not and then play
the video again.

96Q T6a 691 fGY 69416% font size § FGRIR 6RRE & FIX. I9°
QITITER @66 § PRSI SR,
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220. To stop video time at 6 minute 58 seconds in VLC Media Player.

=

COMPUTER SHIKSHA

. 21969, §6¢ §019 AN § NG
Next, select the second line and 99 98° 921N 65FF O FAN G
change the color of the text. 608 9ql |

Change the colour of
the text.

Stop video here and ask students to change font color and then play the video
again.

JE0I69 @63 @ 9L A9 99° 8I8 AIeg 98 font color FERIRS IR 9Q°
QIEIU6R BEG § PRSI oM.

221. To stop video time at 7 minute 17 seconds in VLC Media Player.
Stop video here and ask students to select the line or paragraph as shown in the
video.

JE0I69 @63 Q 9L @9 99° I AIng ©83 69 66! AN A MRS
9e° glqugier § S6ne 998! dIR QF .

Just check whether they’ve selected the line/paragraph or not and then play the
video again.

J6Q 56q 659 9002 697160 ARG 9Q° AIQUFIT § AT FACARRE &
Q1@ 98° FITITER ARG § YRSl SR,

222. To stop video time at 7 minute 30 seconds in VLC Media Player.
Stop video here and ask students to click on the ‘Format” menu and select the
‘Characters’ submenu and then play video again.

@0I6Q GGG § 98 9 99° RIG FI9g ‘Format’ 6619 QU6 ] 859! IR
@2 \9Q° ‘Characters’ submenu QU6R GK G| IR L . I9° FILIV6R QG
g eI M2l

223. To stop video time at 8 minute 13 seconds in VLC Media Player.
Stop video here and ask students to change the ‘Font Color’ as shown in the
video and then play the video again.
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JE0I69 ©E06 @ 9% AR 99° I8 AIeg 8@G 6 696 AN @ ‘Font
Color’ § fARIRSI QIR Q€ . 99° SITIT6R @86 § JRTIa oI,

Now just check whether they have changed the font color or not and then play
the video again.

966 56 667 @0G 694168 “font color’ § SERIA 6GRRE @ Q@ IS°
QIEIU6R BEG § YRS eI,

224, To stop video time at 8 minute 21 seconds in VLC Media Player.

COMPUTER SHIKSHA

Move ahead and select the third N6 Q12 98° O ANING a6mQ
line and make it blink . QR 9Q° IRIg & /L |

Stop video here and ask students to make third line blinking and then play the
video again.

@0I6Q GGG § 98 9 I9° |Ig F19g 9518 ARG § blinking 88<! AR
QL IG° QITITER @66 § PRSI SR,

225. To stop video time at 8 minute 42 seconds in VLC Media Player.
Stop video here and ask students to select the line or paragraph as shown in the
video.

JE0I69 @63 Q 9L 29 99° I ARG ©83 69 66! AN n MRS

a9 Qlougier § S6RS K99 AR QF .

226. To stop video time at 8 minute 59 seconds in VLC Media Player.
Stop video here and ask students to do as shown in the video and then play the
video again.

Supported By “Human Development Foundation” 86



COMPUTER SHIKSHA

......... bridging the digital divide

JE0I69 ©E06 @ 9% AR 99° I8 AIeg 8@6 63 696! AN QF KR!
IR 9. 98° GITIT6R BE6 § YRR SmI2l.

2217. To stop video time at 9 minute 26 seconds in VLC Media Player.
Stop video here and ask students to make the line ‘Blinking’ as shown in the
video.

YE@0I69 ©E06 @ 9% AR 99° I8 AIeg 886 6Q 695l ARSI Of ARG §
blinking @RS JIR §€ IS° FILIV6R 8GG § YRR SRIZ.

Just check whether students have made the line blinking or not and then play the
video again.

966 564 657 @95 RIS 7168 ARG G blinking 98 69RRE & a12 98°
QlTITER @66 § YRS SR,

228. To stop video time at 9 minute 37 seconds in VLC Media Player.
w7

COMPUTER SHIKSHA

Next, change all the remaining 21969, AEAINYSI NAR YEg
lines to small letters and then 6219 2/R 601 TR I8° SIAER
change it back to capital letters. 921G gRLIN €F AJR 69 KA |

small letters and
capital letters

Stop video here and ask students to practice the ‘Effects’ then play the video
again.

@0I6Q GGG § 98 99 I9° |1 FIeg ‘Effects’ 9 2RUIY 956! IR G2 .
G° GILIU6R BBG § YRR SMI.
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229. To stop video time at 9 minute 48 seconds in VLC Media Player.
Stop video here and ask students to select the remaining line as shown in the
video and then play the video again.

YE@0I69 ©E6 @ 9% 9 99° I8 AI9g ARAINYR NING § J6MF FRS
([} 9L 99° QIRINER 8EG q g@éla omil.

230. To stop video time at 10 minute 26 seconds in VLC Media Player.
Stop video here and check whether students have used the ‘Effects’ or not and
then play the video again.

JE@0I69 QL6 @ 9% 9 99° 564 60Q 94 ]IG Q6T ‘Effects’ Q
QRLIN FRRE @ FIE .99° FILIV6R BEE § YRR SRI.

231. To stop video time at 10 minute 34 seconds in VLC Media Player.

COMPUTER SHIKSHA

Let us now learn more about the 219 edqm glalﬂlﬂ’ QAR 2AYe
other options of the Paragraph. Qee Saaen feel |

Paragraph ‘

‘f( _Fvl; \

)

T

Stop video here and ask if they know why we use ‘Paragraph’ sub menu?
JE0I6Q 986 q 9L 9 I° dFIQ 6471160 KRISIRS 26! ‘Paragraph’ sub

menu § 126 SUELIR KRR ?
Just listen to the answers and play the video again for the correct answer.

QAQ § 4 99° 0] 29 IR 886 § A eI |
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232. To stop video time at 11 minute 20 seconds in VLC Media Player.

<.
COMPUTER SHIKSHA

Can you tell why we use indent £66 Q& aIfie 2ieel QAN6CY Ie°
and spacing ? 6996 A QUSLIR FIEE eQ ?

Indent & Spacing

Stop video here and ask if they can tell why we use ‘Indent and Spacing’?
YQ0I6Q GG § 8% A I8° JoIR 6471168 @LAIRER 2I6¢] ‘Indent and
Spacing’ 9126 QULLIQ KR2AIRA ?

Just listen to the answers and play the video again for the correct answer.
Qa9 § g4 99° 908 2@ AR @@6 § A eR |

233. To stop video time at 12 minute 26 seconds in VLC Media Player.
Stop video here and ask students to click on the ‘Format menu and then click on
the ‘Indent and Spacing’ option as shown in the video and then play the video
again.

JE0I6Q 066 q 9L 9 I8° I8 7leg @66 6 6QHINIRNYS! @ ‘Format

menu” QJ6R §Q XS 5[} qe NQ° LILIIE ‘Indent and Spacing’ option
QA6 {R AR aiR 9L IQ° QILIY6q K83 qQ qg‘éla omliel.

234. To stop video time at 13 minute 15 seconds in VLC Media Player.
Stop video here and ask students to use ‘Before Text’ option as shown in video
and then play the video again.

JE0I6Q 63 @ 9L @9 99° K18 FIeg &G 6 6Q% IRYS QR ‘Before
Text’ option R QUFCIR FRAR! IR GL IS° FILIV6R ©GG § YAFIR SRI.

235. To stop video time at 13 minute 50 seconds in VLC Media Player.
Stop video here and ask students to do normal as shown in the video and then
play the video again.
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JE@0I69 ©E6 @ 9L AR 99° I8 AIeg 8@G 6Q 695l AN @ normal
Q! IR L 9L9° GITITER VEE § YRR SmI2.

236. To stop video time at 14 minute 32 seconds in VLC Media Player.
Stop video here and ask students to use ‘After Text’ option as shown in video
and then play the video again.

JE0I69 ©E6 q 9% AR 99° I8 AIeg 8&G 61 695! AN @ “After

Text’ option @ USLIR GRS VRN L IS° SITIUER GGG § YRR SR,

237. To stop video time at 14 minute 53 seconds in VLC Media Player.
Stop video here and ask students to do normal as shown in the video and then
play the video again.

JE@0I69 ©E6 @ 9% AR 99° I8 AIeg 886 6Q 695l AN @ normal

@G IR §E 99° GITITER BB § YAFIR SRI.

238. To stop video time at 16 minute 26 seconds in VLC Media Player.
Stop video here and ask students to use ‘Above Paragraph and Below
Paragraph’ option as shown in video and then play the video again.

JE0I6Q 886 q 9L 9 98° RIE FlIeg QGG 6Q 696l AN QR ‘Above
Paragraph \4S° Below Paragraph’ option @ QUL LI @QS| AR Qe NQ°
QlTITER @66 § PRSI SR,

2309. To stop video time at 17 minute 06 seconds in VLC Media Player.
Stop video here and ask students to use the ‘Line spacing’ as shown in the video
and then play the video again.

JE20I69 @63 @ 9% 29 99° RIg AIeg ©G3 62 6Q46! AN @ ‘Line

spacing’ 9 QUSLIQ 2SI TR G2 I9° BITIT6ER BBE § YRR SR,
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240. To stop video time at 17 minute 31 seconds in VLC Media Player.
Stop video here and ask students to bring paragraph back in the normal as
shown in the video.

JE0I69 @63 Q 9L @9 99° RIg 7Ieg 883 69 6.6l AN O

dIQUAIP @ normal § 6PAUR 2lI&l.

Now Just check whether have used the ‘Indent and spacing’ option or not and
then play the video again.

Y69 56Q 607 @G 6496% ‘Indent and spacing’ option Q QUSRI YRS

@ Q1T 98° GITIU6R DBG6 § YATIA oM.

241. To stop video time at 17 minute 44 seconds in VLC Media Player.
v

COMPUTER SHIKSHA

Can you say why we use the £661 @ AIRE 2l6F ININTEAE
Alignment option ? 4R A QIELIQ RILR AR ?

Stop video here and ask if they know why we use ‘Alignment’?
YQ0I6Q 08B § 8% AR I8° J9IQ 6971I6R RISIRE 2I6E “Alignment” §

LG USTIR FAB ?
Just listen to the answers and play the video again for the correct answer.

QAQ § 4 99° 0] 29 IR 8&6 § A eI |

242. To stop video time at 19 minute 34 seconds in VLC Media Player.
Stop video here and ask students to use the ‘Alignment’ as shown in the video.

VL0169 966 qQ 9@ @A I9° I8 Fleg KEG 69 6Q¢l AR OF

‘Alighment’ Q USLIR K9G| AN G2 .
Now just check and play the video again.
Y69 60 657 R0 IG° BE6 § YRR oI,
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243. To stop video time at 20 minute in VLC Media Player.

<t

COMPUTER SHIKSHA

Now you will learn about the drop caalg £661 dIfUGI ATECEIG R
caps in the paragraph sub menu. 621€ QYIY SA6R FisIS |

Stop video here and ask if they can tell why we use ‘Drop Caps’?

YE@0I69 ©E6 @ 9% AR 99° JFIR 649168 REAAES 2lI6¢1 ‘Drop Caps’ q
FIEE QUSTIR FRAIR ?

Just listen to the answers and play the video again for the correct answer.
QRQ § g4 99° 90Q 29 IR 8&E6 § AR eI |

244, To stop video time at 21 minute 20 seconds in VLC Media Player.
Stop video here and ask students to click on the ‘Format menu’ and then click
on the ‘Paragraph’ option as shown in the video and then play the video again.

JE0I69 63 q 9L 29 99° I AIng ©@3 69 66! AN @ ‘Format
menu’ AUER GA GG IR L IG° ‘Paragraph’ option RUER §F AR
IR Q€ . 99° SITIT6R €86 § IR SR,

245. To stop video time at 23 minute 08 seconds in VLC Media Player.
Stop video here and ask students to use the ‘Drop Caps’ as shown in the video
and then play the video again.

JE@0I69 @63 q 9% 29 99° RIg AIeg 883 69 6.6l AN @ ‘Drop

Caps’ Q QUSLIQ 95! IR L 99° SITIT6R §EE § YasIa emil.

246. To stop video time at 24 minute 42 seconds in VLC Media Player.
Stop video here and check whether they have used ‘Drop caps’ or not and then
play the video again.
JE20I60 @63 q 9% A9 99° T6a 65 @7 69716 ‘Drop caps’ Q
OLIQ FARE @ 918 99° SITIU6R AEE § YAFIR SR,
247. To stop video time at 24 minute 55 seconds in VLC Media Player.
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COMPUTER SHIKSHA

Can you say why we use border 266 98 QI ZJIS‘?‘]‘Q@Q 98
option ? UELIN QILT Q@ ?

Boarder

Stop video here and ask if they can tell why we use ‘Border’ option?
YE@0I69 @606 @ 9% AR 99° JFIR 699168 @LUIRESR I6E! ‘Border’ option

g SR8 QUSTIR KRR ?

Just listen to the answers and play the video again for the correct answer.
QAR g g8l 99° 90% QA IR VLB § YRS SR |

248. To stop video time at 26 minute 08 seconds in VLC Media Player.
Stop video here and ask students to click on the ‘Format menu’ and then click
on the paragraph option as shown in the video and then play the video again.

JE0I6Q 086 q 9% 9 98° RIE Fleg @63 6] 696l AN QR ‘Format
menu’ QIR §7 229! AR € I9° QUG YR AT6R {7 A9 AR
QL IG° QITITER @66 § PRSI SR,

249. To stop video time at 28 minute 26 seconds in VLC Media Player.
Stop video here and ask students to apply the ‘Border’ on the paragraph as
shown in the video and then play the video again.

JE0I6Q 066 q 9L A9 99° ]Ig AIng @G3 62 696! NS AP 6

‘Border’ ROIRGIG 98 I9° GILIN6Q ©&6 § eI M2,
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To stop video time at 28 minute 34 seconds in VLC Media Player.

COMPUTER SHIKSHA

Closing Writer. ANTA G 9L IR |

e

Close Button

Stop video here and ask the students to close the writer file and then shut down
the computer.

@0I6Q GGG § 96 99 99° |1 FI9g ARTA O FIRA § 99 859! AR
9% 99° 2o g 9L /A<l ([ Q9.

Just check whether they have shut down the computer or not.

966 56 667 290G 620162 aFATA § 98 FOETRRE & AT .
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Complete teacher’s manual for Writer 2 Class 7
Class 7 Summaries

v" Open your laptop/notebook and switch on

S MUIISY /62199R 369 @ IQ° §6 2Q a9 .
v How to open Writer file and operate it.

AURTA A PIRM G 62TE 369G FAUANT IQ° YL QUSLIR 67T AU,

v" Why we use default formatting?

2l16¢1 default formatting @ QLG QUeTIQ *FRIQ ?
v How to use line and spacing?

line 9Q° spacing q 69¢1G QUELIA A8 ?
v How to insert numbering and bullets?

numbering and bullets § 6876 REYS KRG ?
v How to set margin on the page?

Page 6 margin 69¢1% 649% Q@98 ?
v How to change page background?

69% 6Q background 68816 SRR 2IG ?

v" How to insert header and footer?
header and footer § 694156 RELS KRG ?

v How to insert border on the writer page?

ARTA Q 690G 6Q border § 60816 RFIS K98 ?
v How to Close Writer file.

AURTA A PR § 6906 @ A8 .
v How to shut down computer.

APRATR g 69¢16 9L KRG .
Now let’s start class.
29 969 Q&6 2I9g 939! .
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250. To stop video time at 41 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell how we can remove g6 eEaIfe 2Al6e1 66'gE 1RGN
the text boundaries ? Q 6908 2IRSI ?

- .'IIA
W

Stop video here and ask if they can tell how to remove ‘Text Boundaries’?
JE@0I69 ©E06 @ 9% AR 99° JFIR 6471168 RLUIQAES & “Text Boundaries’

q 699G 29I,
Just listen to the answers and play the video again for the correct answer.

Qa9 § g4 99° 908 2@ AR @@6 § A eR |

251. To stop video time at 1 minute 01 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you say £6¢1 @EAIRS § 2l6q CoR
why we use default formatting ? CIFITE Q6 QIR USRIA QR ?

: : v({‘\ Default Formatting

Stop video here and ask if they can tell why we use ‘Default Formatting’?
JE20I69 @63 q 9L 29 Y9° JoIQ 6496 @RAIRES 16T ‘Default

Formatting’ Q126 QUELIQ f5RIIQ ?
Just listen to the answers and play the video again for the correct answer.
QAR § §8 1G° 90 AR AR BE6 § YRS SR |
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252. To stop video time at 1 minute 30 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell why we use the £661 0% AIRE 2166 6€PIFlIS 6919
paragraph submenu of the format 68 dIUGIEr AQEAQ 0 SUSTIQ @6l

menu ? dit @ ?

‘ . yob l\ Paragraph Submenu

Stop video here and ask why we use ‘Paragraph’ submenu option?
JE@0I6Q @63 @ 9% @A 99° IR 269! ‘Paragraph’ submenu option R

QUSTIQ FIRF [R2UQ ?
Just listen to the answers and play the video again for the correct answer.

QR9 § g4 99° 908 Q9 AR @@6 § AR eRI |

253. To stop video time at 2 minute 30 seconds in VLC Media Player.

COMPUTER SHIKSHA

Now open your writer file. Neggaa ngg Iﬂ’lﬂm g Geae

Unested | - Opescmcn Wrtter

nomuwa @,
“mw e A-v-m

Stop video here and ask students to open writer file as shown in video and then
play the video again.
JE0I69 @63 @ 9L A9 99° RIg AIfg ©&6 63 6Q4 RS QfF AURTR

Q FIRMA § 6698 09I dIR §2 99° QILIUES G188 § RTIQ SR,
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254, To stop video time at 3 minute 10 seconds in VLC Media Player.

. 3
What will we learn today?
2IR 2169 !4 §iel ?

COMPUTER SHIKSHA

Stop video here and ask, what will we learn today?

YE@0I69 ©E06 @ 9% /R 99° 991 2R 26F @48l FgS ?

Just listen to the answers and play the video again for the correct answer.
QR9 § g4 99° 908 Q@9 AR @@6 § A eRI |

255. To stop video time at 3 minute 18 seconds in VLC Media Player.
=

COMPUTER SHIKSHA

Next type out the line being QEFIe §AQ 696 AINYL NIV §
shown to you. gld /a1 |

The time is always right to do
what is right.

Stop video here and ask students to type the line and also ask them to do copy
and paste ten times and then play the video again.

20169 823 § 98 99 98° QIE AIeg gL line FIRY /RS AIR I8°
62F1IRG L €0 2R KT YS° 69% RS AR I9° FILIN6R 8RB § YRR
omie.

256. To stop video time at 4 minute 02 seconds in VLC Media Player.
Stop video here and ask students to select the line as shown in video and then
play the video again.
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JE0I69 ©E06 @ 9% AR 99° I8 AIeg 8&6 6Q 695 AN Of ARG §
A6nQ K0S AR IG° GILIIER BGE § YRR SR,

257. To stop video time at 4 minute 41 seconds in VLC Media Player.
Stop video here and ask students to do copy and paste by shortcut command as
shown in video and then play the video again.

JE0I69 ©E6 g 9% AR 99° I8 FIeg 9L 9@6 6 695l AN F
shortcut command SUSLIR 88 94 YG° 60% RS IR G .NMG° SITIY6R
PE6 § eI SRI2.

258. To stop video time at 5 minute 54 seconds in VLC Media Player.
Stop video here and ask students to do as shown in video.

JE0I69 63 q 9L 29 99° RIE FIeg 883 69 6.6l AN A AR
dIR §E.

Now just check whether they have copied or pasted ten times or not and then
play the video again.

96Q 569 699 9GY 6971162 €0 2R 9T 69} FAAINRE & QI IQ°
QlTITER @66 § PRSI SR,

2509. To stop video time at 6 minute 21 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell why we use bullets £67 @24IRE 21671 SEME 98°
and numbering ? FAREP QILE SUELIQ SR ?

i

' ’
. Bullets & Numbering
Ewy 3

Stop video here and ask if they can tell why we use ‘Bullets and Numbering’
option?
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JE@0I69 ©E6 @ 9% AR 99° JFIR 6491168 REUIRAESR 2I6F] ‘Bullets I_°

Numbering’ G126 QUSLIQ 95IIQ ?
Just listen to the answers and play the video again for the correct answer.

Q99 § g4 99° 0] Q9 AR 8F6 § IR oM |

260. To stop video time at 7 minute 25 seconds in VLC Media Player.

Stop video here and ask students to click on the ‘Format menu’ and then click
on the ‘Bullets and numbering’ option as shown in the video and then play the
video again.

JE0I69 63 q 9L 29 99° I AIng ©@3 69 66! AN @ ‘Format
menu’ QU6R 57 S| AN L IS° BILIV6R ‘Bullets and numbering’ AYE

QU6A 38 S AR G2 . I9° SILIU6R BBEB § YRR SR,

261. To stop video time at 7 minute 53 seconds in VLC Media Player.

Stop video here and ask students to apply the ‘Bullets’ on the first line as shown
in the video and then play the video again.

JE0I6Q ©E6 q 9L 9 98° RIE FlIeg QGG 6] 696l AN QR e
RREG 62 ‘Bullets’ RAING! IR 8 IG° GIFIN6R 8&E6 § ISR ORI,

262. To stop video time at 8 minute 59 seconds in VLC Media Player.

Stop video here and ask students to apply the ‘“Numbering’ on the second line as
shown in the video and then play the video again.

JE0I6Q 066 q§ 9L A I8° RIE FIeg ©EG 69 6946l IR O GB1%
RRE 6 ‘Numbering’ RIIRS! IR G2 IS° FILIT6R QL6 § IRl
SRI.

263. To stop video time at 10 minute 22 seconds in VLC Media Player.

Stop video here and ask students to apply the ‘graphics’ on the third and fourth
line as shown in the video and then play the video again.

G060 086 § 98 K9 I9° I8 Fleg 886 69 66¢! AN AR 9B1H
95° 652 RING 69 graphics ARG VIR GL . IG° GILINER B&G
Jesia SR,
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264. To stop video time at 11 minute 35 seconds in VLC Media Player.
Stop video here and ask students to remove ‘Bullets and Numbering’ as
explained in the video.

JE0I6Q W86 § 98 2 I9° ]I8 FIeGg 866 61 6Q% AIRIS! @ ‘Bullets
\G° Numbering’ § €911 AR Q€ .

Now just check whether they’ve removed the ‘Bullets and Numbering or not
and then play the video again.

966 567 66] @0G2 694168 ‘Bullets and Numbering €912 AI0RE & F1&
G° QILIU6R BBG § YRR M.

265. To stop video time at 12 minute 56 seconds in VLC Media Player.
Stop video here and ask students to click on the ‘Format menu’ and then select
the ‘Page’ submenu and then play the video again.

JE0I69 @63 q 9L @9 99° I e ‘Format menu’ QU6 §8 29Q!
IR 9L 99° FILIU6R ‘Page’ submenu 6MG AR AR §L I9° FILIT6R
PEG g JaSIa oI,

266. To stop video time at 14 minute 12 seconds in VLC Media Player.
Stop video here and ask students to change the Paper format as shown in the
video.

JE0I69 @63 Q 9L 29 99° I AIng Q83 69 626! AN QU Paper
format SORIRG! IR §L YG° GIFITER 866 § YRR SR,

Now just check whether they’ve changed Page format or not and then play the
video again.

96Q 569 699 99G 699168 page format § CRINAR @ Q@ 9e°
CIRIYER 0GB Q qm‘la omi2l.
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267. To stop video time at 14 minute 27 seconds in VLC Media Player.

by g
COMPUTER SHIKSHA

Can you tell why we use the £661 @ AIAS 2l6F BRICLEENR N
orientation option ? LUELIQ FILT IR ?

Stop video here and ask if they can tell why we use ‘Orientation’ option?
YQ0I6Q 08B § 8% A I8° JFIQ 6491169 @QAIRER 2I6S] ‘Orientation’
option § Q128 SUSLIQ FARIRA ?

Just listen to the answers and play the video again for the correct answer.
QRQ § g4 99° 90] 29 IR 8&6 § 9aIa e |

268. To stop video time at 15 minute 52 seconds in VLC Media Player.
Stop video here and ask students to click on the ‘Format menu’ and then click
on the ‘Page’ option as shown in the video and then play the video again.

JE0I6Q 986 q 9L 9 I8° RIE Fleg QGG 6Q 696l AN @R Format
menu’ QU6 §Q 990G TN 2 IS° GITITER page option AIER G
@G IR §E 9E° GITIT6ER 8BE § YL SR |

269. To stop video time at 16 minute 27 seconds in VLC Media Player.

Stop video here and ask students to change ‘Orientation’ of the page as shown
in the video and then play the video again.

YQ0I6Q 08B § 9% @ 98° RIG FIeg ©@G 6% 64l AN V& page
69 ‘Orientation’ § FGRING! VN L I9° FILIV6R BEG § YIS |

270. To stop video time at 16 minute 46 seconds in VLC Media Player.
Stop video here and ask students to do in ‘Portrait’ format as shown in the video
and then play the video again.

JE0I6Q @63 q 9% 29 99° Ig AIeg W63 62 6@l NS @ “Portrait’
format @29 IR 9L . 99° SITITER VLGB § YRR SR |
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271. To stop video time at 16 minute 56 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell what happens with £691 QEING 69Q LUILFIQE FIQ
page background ? @6 6LIRN2AIN ?

Background

Stop video here and ask if they can tell what happens with ‘Page Background’
option?

JE0I69 ©G3 @ 9L A9 99° JFIQ 6991168 RRUIRES "Page Background’
29 I @6l 6LIIN ?

Just listen to the answers and play the video again for the correct answer.
QA9 § g4 99° 0] 29 IR 8&E6 § 9aIa eI |

272. To stop video time at 17 minute 46 seconds in VLC Media Player.
Stop video here and ask students to click on the ‘Format’ menu and then click
on the ‘Page submenu’ and then play the video again.

JE0I69 @63 Q 9L @9 99° I IR ‘Format’ menu QU6 §8 29Q!
IR 9€ 99° FILIU6R ‘Page submenu’ QUER §@ KRR AR §€ 99° 40K
QAR AR B&6 § SIS |

273. To stop video time at 18 minute 26 seconds in VLC Media Player.
Stop video here and ask students to change the ‘Page Background’ as shown in
the video.

JE20I69 @63 q 9% 29 99° I AIeg 983 69 66! AN U Page
Background’ SGRIRSI AR §F .

Now just check whether they’ve changed page background or not and then play
the video again.
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969 569 699 9a? 699169 Page Background’SGRIR 69088 & Q1L .
G° GILI6R BB3 § YRS I |

274, To stop video time at 19 minute 19 seconds in VLC Media Player.
Stop video here and ask students to set the picture in the background of the page
as shown in the video.

JE@0I69 ©E6 @ 9% AR 99° I8 g @66 62 6.6l AR AF
background 6 8¢ 699 RS AR §2.99° GITITER VLGB § LTI SR |

Now just check whether they’ve set the picture in the background or not and
then play the video again.

Y69 56q 699 291G 697168 background 62 52 q 699 @RS @
Q1T . 99° FILIN6R 866 § YA SR |

275. To stop video time at 19 minute 34 seconds in VLC Media Player.
a7

COMPUTER SHIKSHA

Can you tell why we use the £691 @ AINS 2l6A 620N I8°
header and footer ? LA QA ULIA QLR @R ?

Header
&
Footer

Stop video here and ask if they can tell why we use ‘Header and Footer’?
JE@0I69 ©E06 @ 9% AR 99° JFIR 699168 REAIRES 6T ‘Header IQ°

Footer’ § Q12 QUSLIQ 99& ?
Just listen to the answers and play the video again for the correct answer.

Q99 § g4 99° 908 QA9 AR §E6 § JasIa el |
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276. To stop video time at 20 minute 48 seconds in VLC Media Player.
Stop video here and ask students to click on the ‘Format menu’ and then click
on the ‘Page’ option as shown in the video and then play the video again.

JE0I6Q 866 § 88 R IS° ]IS FI9F 9L ‘Format menu’ QUER §R A
IR 99° GITIU6R 696 AUYR A6 R KRG IR I9° SIFIV6R BGE §
Jesia omI2l |

2717. To stop video time at 21 minute 28 seconds in VLC Media Player.
Stop video here and ask students to insert header as shown in the video and then
play the video again.

JE@0I69 63 q 9L A9 99° I AIeg ©83 69 6.6l AN @ header §
REIS FRG! UIR §L IS° FILIV6R ©B6 § YA SR |

278. To stop video time at 22 minute 25 seconds in VLC Media Player.
Stop video here and ask students to set left margin of header as shown in the
video and then play the video again.

JE0I6Q 986 q 9L 9 98° 1L AIeg QGG 6Q 696! AN QR header
69 left margin 6QQITIR G . I9° FILIV6R BEE6 § YRR SR |

279. To stop video time at 22 minute 55 seconds in VLC Media Player.
Stop video here and ask students to do spacing of header as shown in the video
and then play the video again.

JE0I6Q 086 q 9L 9 I8° &I2 Fleg @63 6 6946 AN @R header
69 spacing 699 AR G2 YG° GIFITER 866 § YRR SN |

280. To stop video time at 23 minute 22 seconds in VLC Media Player.
Stop video here and ask students to set height of header as shown in the video
and then play the video again.

YQ0I6Q 083 § 9L A 9e° IE FIRg V&6 61 6949 AN @F header
A height 699 @081 IR §€ 98° GITITER 863 § YL ORI |

281. To stop video time at 23 minute 44 seconds in VLC Media Player.
Stop video here and ask students to type name or title as shown in video.
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JE@0I69 ©E06 @ 9% AR 99° I8 AIeg 8@6 63 696! ARSI QF Qla 9_°

title 9109 FARIIN L .
Now just check whether they’ve typed or not and then play the video again.
Y69 569 600 972 647160 9lnd 2291088 @ Q1T 9IG° GILIN6R ©63

g eI M2l

282. To stop video time at 24 minute 45 seconds in VLC Media Player.
Stop video here and ask students to insert footer as shown in the video and then
play the video again.

JE0I6Q @63 q 9L 29 99° ]Ig AIng Q83 69 696! AN @ footer @
insert @291 AR §L . 99° GITIV6R BGE § YR SR,

283. To stop video time at 25 minute 26 seconds in VLC Media Player.
Stop video here and ask students to set right margin of footer as shown in the
video and then play the video again.

JE0I69 @63 Q 9L 29 99° Ig AIng Q83 69 626! AN QU footer
6Q right margin 6Q9I19IR G . 99° FILIY6R B&6 § YRR SR |

284, To stop video time at 26 minute 05 seconds in VLC Media Player.
Stop video here and ask students to do spacing of footer as shown in the video
and then play the video again.

JE0I6Q 0BG q 9L 9 I8° 12 Fleg @G E3 69 694 AN @F footer
69 spacing 699 AR G2 IG° GIFITER 866 § YRR SN |

Now just check and play the video again.
69 T67 607 AR IG° FILIF6R 866 § YAl SR |

285. To stop video time at 26 minute 39 seconds in VLC Media Player.
Stop video here and ask students to set height of footer as shown in the video
and then play the video again.

JE0I69 63 Q 9L 29 99° ]Ig ARG @83 69 696! AN @ footer
69 height 6981 AR 92 IG° GILINER BBG § YRS SR |
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286. To stop video time at 27 minute 03 seconds in VLC Media Player.
Stop video here and ask students to insert a page number as shown in video.

JE@0I69 @63 q 9L 29 99° ]Ig AIeg @63 62 6@l AN A page
number 995 GaSI AN 9L .

Now just check whether they’ve inserted page number or not and then play the
video again.

969 569 699 9G 694169 page number REYF GORE & QIR 9Q°
QITITER VBB § YRSl eI |

287. To stop video time at 27 minute 19 seconds in VLC Media Player.

% . 3

COMPUTER SHIKSHA

Can you tell what happens with £661 0% AIRE 608 SEA I Q61
the page border ? 6LINAN ?

o

A’y
<

Stop video here and ask why we use ‘Page Border’?

20169 8136 § 98 99 I9° JFIQ 26 ‘Page Border’ Qlae QUSLIR
allQ ?

Just listen to the answers and play the video again for the correct answer.
QAQ § g4 99° 90Q 29 IR 886 § A eI |

288. To stop video time at 29 minute 52 seconds in VLC Media Player.
Stop video here and ask students to apply the ‘Page Borders’ as shown in the
video.

JE0I6Q 63 q 9% A9 99° ]IE AIng @63 61 696! NS QR Page
Borders’ @09 QIR §F .

Now just check whether they’ve applied ‘Page Border’ or not and then play the
video again.

Y69 56Q 607 @272 64916R ‘Page Border’ @9Q10Q8 & Qe 99° G&6 q
JesIa SRI2.

Supported By “Human Development Foundation” 107



COMPUTER SHIKSHA

......... bridging the digital divide

289. To stop video time at 31 minute 10 seconds in VLC Media Player.
Stop video here and ask students to use the ‘Spacing to contents’ as shown in
the video.

JE0I69 @63 q 9L 29 99° I AIeg Q@3 69 66! AN Q& “Spacing
to contents’ QUSLIR FAG! AN §L .

Now just check whether they’ve used ‘Spacing to contents’ or not and then play
the video again.

Y69 56Q 607 AT 64CI6R Spacing to contents’ Q RULLIR FARE @

Q@la

290. To stop video time at 31 minute 50 seconds in VLC Media Player.
Stop video here and ask students to do as shown in the video and then play the
video again.
JE@0I69 ©E06 @ 9% R 99° 88 FIeg 066 67 6.4l RS AR 2R
IR 9T .MS° SITIF6a GGG § YaTIa eI,

291. To stop video time at 34 minute 01 seconds in VLC Media Player.
Stop video here and ask students to do as shown in the video and then play the
video again.
JE0I6Q ©%6 q 9L @A IQ° I8 e QB3 62 694 IRl AR a<
IR g2 99° GILIER BEE § eI eI,
Now just check whether they have applied shadow or not and play the video
again.
969 569 699 9G? 697169 shadow § applied @988 & 912 98° 886 g
Jesia emil.

292. To stop video time at 34 minute 15 seconds in VLC Media Player.

& iy

COMPUTER SHIKSHA

Closing Writer. AN ¢ 9L !R |

pp——

Close Button

Supported By “Human Development Foundation” 108



COMPUTER SHIKSHA

......... bridging the digital divide

Stop video here and ask the students to close the writer file and then shut down
the computer.
YZ0I6Q 866 § 90 AR 98° I8 FIFg ARTA A PIRM § 9L K9S AR

92 98° 02160 SHRSa § 96 @99l IR §< .

Just check whether they have shut down the computer or not.
6% 569 667 290 697166 AFIACR § 9L F9R8 @ A1 .

Supported By “Human Development Foundation” 109



COMPUTER SHIKSHA

......... bridging the digital divide

Complete teacher’s manual for Writer 2 Class 8
Class 8 Summaries

v" Open your laptop/notebook and switch on.

S MUIISD /6R199R 3698 @ IQ° §0 2q /9 |
v How to open Writer file and operate it.

ARTA A PR G 6276 3697 FAUAN IQ° YLIR QUSRIR 671G
QAULNG?

v" How to use character sub menu.

“Character” 949 6¢19 § @3 QULLIQ AAUANI |
v How to use indent and spacing?
“indent and spacing” @ QUSLIRQ FIX QU ?

v How to insert numbering and bullets?
numbering and bullets § 68816 RELS K& ?
v How to change page background?

69% 62 background 628G fLRIN2IT ?
v How to insert header and footer?
header and footer § 695156 REAS KRG ?
v How to insert border on the writer page?
AURTA X 69R 6Q border § 687G RRLS [ ?
v How to Close Writer file?
AURTA A PIRM § 6906 L AT ?
v How to shut down computer?

APARATR @ 69¢16 L KAG ?
Now let’s start class.

29 969 Q&6 2199 929! |
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293. To stop video time at 43 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell why we use bullets gee Q§0I§§ 2l6¢1 M 9e°
and numbering ? QAR FIER QUETIA *Q ?

- '/I "l‘ Bullets & Numbering

Stop video here and ask if they can tell why we use ‘Bullets and Numbering’
option?
JE0I69 @63 q 9L A9 99° JoIQ IQ 697160 @EAIRES 2I6¢ ‘Bullets and
Numbering’ 2a q QLG LR QAR ?
Just listen to the answers and play the video again for the correct answer.
Qa9 § g4 99° 909 209 IR @86 § AR SR |

294, To stop video time at 1 minute 29 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell how we can set the £6¢1 @€ AIRS 267 69R 60 AT
margin for a page ? 69AE MelQ ARSI ?

‘ . ./}’fl‘ Set the margin of a
‘ page

Stop video here and ask if they can tell how to set ‘Page Margin’ on the writer
page?

YE0I69 &6 @ 9% AR 99° dFIR T 647I6R fRUIA6S AURTR 696 6
‘Page Margin’ § @9 ReAS SN ?

Just listen to the answers and play the video again for the correct answer.

QA q §4 99° A0 AR AR &4 q QG?Q‘IQ omid |
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295. To stop video time at 2 minute in VLC Media Player.

COMPUTER SHIKSHA

Can you tell which sub menu of 2661 O QIR eluIe 661G O 698G

the format menu will help you to Ae6eg AG SANETFT O

change the background color of LYING SR G 66F Qa8 g1
the text ? qAILIQY @I ?

‘ Y J'T{! - Change the
L Background color

Stop video here and ask if they know which submenu helps us to change text
‘Background Color’?

E0I6Q GGG § 98 89 I9° JoI UG 697166 RITRE 609 A6AIg 2lAg

6999 Q ‘Background Color’ @ 65& @0 AR ALIAY Q2 ?
Just listen to the answers and play the video again for the correct answer.
Qa9 § g4 99° 909 209 IR @B6 § AR SR |

296. To stop video time at 2 minute 20 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell what happens with 2661 8 dIfS 69R A UIFING
page background ? FI9l @6l 6LIRAN?

‘ ; ./} '\1{ X Page
‘ Background

Stop video here and ask if they can tell what happens with use of ‘Page
Background’ option?
YE@0I69 ©E6 @ 9% AR 99° JFIR T 64716 @RGSR Page

Background’ 2I9& @ QUL Y19 @6l 6L ?
Just listen to the answers and play the video again for the correct answer.

Q9 § g4 99° 90] Q99 AR 8E6 § eI ol |
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297. To stop video time at 2 minute 47 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell what happens with 2661 0% QIS eFR AR FIAU K4
the border option ? 6RINAN ?

, T&
%

Stop video here and ask if they can tell what happens with use of Page ‘Border’
option ?
JE@0I69 ©E6 g 9% AR 99° AFIR I& 697I6Q @LUIRES 6948 R ‘Border’

2Y4a QA QULLIRN YU N6l 6L IM2IN ?
Just listen to the answers and play the video again for the correct answer.

QA9 § g4 99° 90Q Q9 IR 6E6 § ReIa SR |

298. To stop video time at 3 minute 35 seconds in VLC Media Player.

COMPUTER SHIKSHA

Now open your writer file. piE o ngg? IG’IQﬁ) g Geae

Stop video here and ask students to open writer file and then play the video
again?
YZ0I6Q @66 § 90 A 98° RISFINT AR FIRM § 3698 aAS! AR

gL IG° GITITER VBB § YRSl omIY |
299. To stop video time at 4 minute 17 seconds in VLC Media Player.

Supported By “Human Development Foundation” 113



COMPUTER SHIKSHA

......... bridging the digital divide

COMPUTER SHIKSHA

Have you all opened the £6¢1 €169 AF6S AURNTR A FIAM
Writer file or no ? Q B69R fREEM R QT ?

Stop video here and ask if they all been able to open writer file?

JE0I69 ©G3 @ 9L A9 Y9° JoIQ UG 697168 ARG PIRM § B6AR
RS ?

Just listen to the answers and play the video again.

QAQ § g4 99° 90Q Q9 IR 6E6 § RS SR |

300. To stop video time at 4 minute 29 seconds in VLC Media Player.
.

COMPUTER SH\KSHA
Now type out the paragraph being ({afall=) ge 2leeq 6961 LIRS
shown in front of you. diuigier g 91Ra @ar |

The bear was coming towards them. They were much

frightened to see such a deadly Sight. Ramu at once
climbed up a nearby tree to save his life. He was
unaware of his friend's safety. Raju did not know how
to climb up a tree.
But he was wise and intelligent. He had heard that
bears do not touch the dead.

Stop video here and ask students to type the paragraph as shown in video.
JE20I69 @63 Q 9% 29 99° I AIeg 983 69 6L6IKIRNYS! AR IR

g FIRY A9 IR 9L |

Now just check whether they have typed out the paragraph or not and play the
video again.

96Q 569 699 20GY 6971162 QG § IR FAIIARE @ QIE 99°
QITITER VBB § YRS oMY |
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301. To stop video time at 4 minute 57 seconds in VLC Media Player.

COMPUTER SHIKSHA

First of all after selecting the full g6sl 661 9169 AIUGIT TG
paragraph using the character qeng el 69 6Q6YR ATECEIG
submenu change the paragraph ¢ SISLI @A dIRIFIP O IR §
size. 6B QR |

Change the size using
Character submenu

Stop video here and ask students to change the size of the paragraph by using
‘Character’ submenu and then play the video again.

JE0I69 @63 Q 9L @9 99° RIGLIQG ‘Character’ 96619 @ RULLIR a4
JIQIPICr Q ARG G 698 KRG VR GE IG° GIFINER 863 § YRR

omie |
302. To stop video time at 5 minute 6 seconds in VLC Media Player.

COMPUTER SHIKSHA

Change the style of writing and ainiglie 9 EMEIR YA G 60
how that you can over-line this £9:99° pe9 1% Slalra S
g : ARARIAE IR 6912 |

‘ v J-«R Change the style of
] text and show the
‘ Overline

Stop video here and ask students to change the ‘Font Name’ and also apply over
line on the paragraph and then play the video again.
@0I6Q GGG § 96 9 99° |1 FISg ‘Font Name’ § 66& G99l dIR g2
9g° dIQIFIP 69 2RQRAIRE 5! AR 9L I9° CPIRINER 8EG q q&‘@la
omie |

303. To stop video time at 5 minute 24 seconds in VLC Media Player.
Stop video here and ask students to select the paragraph as shown in the video
and then play the video again.
JE20I69 @63 q 9% 29 99° I AIeg 983 69 6L6IKIRNYS AR AP
g J6AQ 99! AR §E 99° SIZIU6R 8&E6 § 9ASIa eI |

304. To stop video time at 5 minute 38 seconds in VLC Media Player.
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Stop video here and ask students to click on the ‘Format’ menu and then click
on the ‘Characters submenu’ as shown in the video and then play the video
again.

JE@0I69 @63 q 9L @9 99° I AIeg 883 69 6L6IKIRNYS! AR
‘Format’6¢19 § @ @9%! AR 9L 99° PIU6Q ‘Characters submenu’ § {Q

3G IR gL I9° GITIT6ER 8BE § ILEIR SR |
305. To stop video time at 6 minute 25 seconds in VLC Media Player.
Stop video here and ask students to change the font name as shown in the video
and then play the video again.
JE0I69 @63 Q 9L 29 ¥9° I AIng Q83 69 6L6IUIRNYS! AT P 69¢

G 698 SR IR 9T I8° SITIU6a AE6 § YaTIa eI |
306. To stop video time at 6 minute 37 seconds in VLC Media Player.
Stop video here and ask students to select the paragraph as shown in the video
and then play the video again.
JE0I69 @63 q 9L @9 99° I AIeg 883 69 6L6IKIRNYS! AR AP

g 96AQ 99! AIR gL I9° SILIU6R 836 § 9A<IR SRl |

307. To stop video time at 7 minute 40 seconds in VLC Media Player.
Stop video here and ask students to change the ‘Font Size’ as shown in the
video.
JE0I69 @63 @ 9L @9 99° I AIng ©@3 69 6L6IKIRNYS! AT ‘Font
Size’ § 66& /A< AN §L |
Now just check whether they’ve changed the ‘Font Size” or not and then play
the video again.
968 56@ 66Q @9G2 69416Q ‘Font Size’ § 66& @AIINRE @ 12 9e°

QITITER @66 § YRIIA SR |

308. To stop video time at 8 minute 55 seconds in VLC Media Player.
Stop video here and ask students to apply the ‘Over lining’ on the paragraph as
shown in the video.

YQ0I6Q 083 § 9L @ 98° IL FIRg V&6 61 69HIAIRNYS| A AU

69 “Over lining” RASI TN §L |
Now just check whether they’ve applied the ‘Over lining’ or not and then play
the video again.
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969 569 699 SGY 699162 “Over lining” AAINRE @ Q12 98°
QITIU6R BEG § YRS oI

3009. To stop video time at 9 minute 26 seconds in VLC Media Player.
w7

SILINERN 9T QAR AINIGIEP 68
606N 496G § SUSLIN &
661 FUR ILIQ L NN 668G

Next on the same paragraph using
the character submenu show how

you will change the font color, eae

Change the font color
using character
submenu

Stop video here and ask students to do practice of ‘font color’, ‘small caps’ and
‘under-lining’.
JE@0I69 ©E6 @ 9% AR 99° I8 AIRg “font color’, ‘small caps’ 9Q°
‘under-lining’ Q AL @S IR L |

310. To stop video time at 9 minute 42 seconds in VLC Media Player.

Stop video here and ask students to select the paragraph as shown in the video
and then play the video again.

JE0I6Q 986 q 9L 9 I8° I8 7leg @66 61 6QHIYIRYR IR AINUIICP
g J6Me ARSI AR 9L I6° GITINER BEE6 § YRS oI |
311. To stop video time at 10 minute 38 seconds in VLC Media Player.

Stop video here and ask students to change the ‘font color’ as shown on the
video.

JE0I69 63 q 9L 29 99° RIQ FlIex ©EG 6Q 6QFlIAINS| AR “font

color’ § 66& KASI TN FL |
Now just check whether they have changed the font color or not and then play
the video again.

96Q 569 699 fG2 694169 “font color’ § 698 AQTRE & AIE 9e°
QlTITER @63 § YFSI emIY |
312. To stop video time at 11 minute 42 seconds in VLC Media Player.

Stop video here and ask students to make the paragraph in small capitals as
shown in video and then play the video again.
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JE@0I69 ©E6 @ 9% AR 99° I8 AIeg 686 6Q 6QHIAIRYR! IR AIUICP
g “small capitals” @99 IR QL |

313. To stop video time at 12 minute 44 seconds in VLC Media Player.
Stop video here and ask students to apply ‘underline’ on the paragraph as shown
in the video.

YE@0I69 ©E6 @ 9% a1 99° I8 AIeg 63 6Q 6QHAIRNIYR! AR NG

69 ‘underline’ 991G IR L |
Now just check whether they have applied underline or not and then play the
video again.

966 567 66] @9G2 624168 “underline’ FALIRRE & FIE IS° GILIT6ER

PE6 § eI SR |
314, To stop video time at 12 minute 59 seconds in VLC Media Player.

b~
COMPUTER SHIKSHA
Next, using the paragraph SILIFER AINUGIEP AS6AG §
submenu show how you can SYELIQ 8 §66 AIUGIE R _Z_llGlfl
leave space in the beginning and 691 9Q° dIGIP A 6619 601 KRN
then after the paragraph. 6949 6@ easlial |

-

‘ Leave the space in
beginning and
‘. 3 paragraph

Stop video here and ask students to practice ‘Indent and Spacing’, ‘Drop caps’
and ‘Border’ option and then play the video again.
JE20I69 @63 Q 9% 99 99° !Ig AIRg ‘Indent and Spacing’, ‘Drop caps’
9S° ‘Border’ YR 9 AL 2AS! IR §L |

315. To stop video time at 13 minute 31 seconds in VLC Media Player.
Stop video here and ask students to select the paragraph as shown in the video
and then play the video again.
JE0I69 @63 @ 9L A9 99° I AIeg 883 69 626N AR AP
g 96AQ A9 AR G 99° SILIU6a A& § 9A<Ia eI |

316. To stop video time at 15 minute 09 seconds in VLC Media Player.
Stop video here and ask students to do practice of ‘Indent and Spacing’ as
shown in the video and then play the video again.
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JE@0I69 ©E06 @ 9% AR 99° I8 AIeg 8@6 69 6Q5IKIRYS| A Indent

and Spacing’ 9 JRUIY ARSI TN L IS° SITIVER BBE § YA SR |
317. To stop video time at 16 minute 54 seconds in VLC Media Player.

Stop video here and ask students to do practice of ‘Drop Caps’ as shown in the

video and then play the video again.

JE0I69 ©E6 g 9% AR 99° I8 FIeg GEG 6Q 6QHAIRIYR! AR

‘Drop Caps’  2QUI9 f39! AR §8 Y6° GILIU6R &6 § gaala o2 |
318. To stop video time at 17 minute 08 seconds in VLC Media Player.

COMPUTER SHIKSHA

LIU6R G661 IRUGILP G 9 6

Next, divide th h int
s, divits the parmgraph lnto QUSIER B 9Q 98° GEME 9E°

two parts and sh.ow how bullets Qa.ae G0a QYeLIQ eIl
and numbering is used. ca 2l |

Use of bullets and
numbering

Stop video here and ask students to do practice of ‘Bullets and Numbering’ and
then play the video again.

JE20I69 @63 q 9% 29 99° I AIeg 983 69 6Q6IKIRNYS AR ‘Bullets
and Numbering’ Q U9 89S QIR G 9I9° GILIT6R 886 § 9Ia

omid |

3109. To stop video time at 19 minute 38 seconds in VLC Media Player.
Stop video here and ask students to apply the ‘Bullets and Numbering as shown
in the video.

JE0I69 @63 Q 9L 29 99° I AIng ©@3 69 6L6IKIRNYS! AR ‘Bullets
and Numbering’ @ m%llQ< ([} 9L I9° QIRINER ©&G q qgéla omid |
Now just check whether they have applied ‘Numbering and Bullets or not and
then play the video again.

Y69 569 600 R 647168 ““Numbering and Bullets” RollRQIR8 &

Q@ 98° GITIT6ER QBB § YATIa onI |
320. To stop video time at 19 minute 55 seconds in VLC Media Player.
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COMPUTER SHIKSHA

Put today’s date as the Header
and insert the page number as the
footer.

2IRN CI06 § 6LERN 69 ME2 9Q°
TN 6Q 697 RAQ § RRASF 9 |

Header & Footer

o

Stop video here and ask students to put date in ‘Header’ and insert the page
number in ‘Footer’ and then play the video again.

@0I6Q GGG § 98 8 I9° |1 F19g ‘Header’ 69 S10¢ RTINS IR §L
Q° ‘Footer’ 69! 698 FAQ AAYE 294! dIR 98 I6° GILIU6R 8&G6 §
Jesia omI2l |

321. To stop video time at 20 minute 19 seconds in VLC Media Player.
Stop video here and ask students to click on the ‘Format’ menu and then click
on the ‘Page’ option as shown in the video and then play the video again.
JE0I69 @63 Q 9L 29 99° ]Ig AIng ©E3 69 6Q6IUIRIYS AR
“Format’6€19 § 38 99! dIR gL 99° SIT6Q ‘page’ YR § GQ 999! AR
gL 99° GILIN6R VBB § YRR I |

322. To stop video time at 21 minute 36 seconds in VLC Media Player.

Stop video here and ask students to insert the ‘Header’ as shown in the video
and then play the video again.

JE0I69 @63 q 9% 29 99° ]Ig AIng @63 62 6Q6IKIRS AR ‘Header’

g 2994 936! IR gL 9I9° SILIU6 886 § YRR oIl |

323. To stop video time at 22 minute 06 seconds in VLC Media Player.
Stop video here and ask students to insert the date in the header box as shown in
the video.

JE0I69 63 Q 9L 29 99° I8 AIng @63 69 696IKIRYS AR ‘Header’

69 G109 RIINS! AR L |

Now just check whether they have inserted the date in the ‘Header box’ or not
and then play the video again.
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968 569 66Q @0G2 696168 Header box’ 69 G10% AIIRKE @ QI 98°

QITIU6R BEG § PRSI S |

324, To stop video time at 23 minute 43 seconds in VLC Media Player.
Stop video here and ask students to insert the ‘Footer’ as shown in the video and
then play the video again.

JE@0I69 ©E6 g 9% AR 99° I8 FIeg GG 6Q 6QHAIRNYS! AR “Footer’
g R09E 2AQI AR 9L Y8° GITIU6R BEG § YRS S |

325. To stop video time at 24 minute 10 seconds in VLC Media Player.
Stop video here and ask students to insert the page number in the ‘footer’ box as
shown in the video.

JE0I69 63 Q 9L 29 99° I AIeg ©@3 69 6L6IKIRNYS! AR ‘Footer’

QF 6 6d% TR MAIWS ([} Q9 |

Now just check whether they have inserted the page number in the footer box or
not and then play the video again.

Y69 569 657 @R 64716Q “footer box’ 6Q 696 QA MIINRE & Qe

45° QITITER @66 § YRR SR |
326. To stop video time at 24 minute 15 seconds in VLC Media Player.

=

COMPUTER SHIKSHA

And then change the background JQ° ¢lUea) 69@ A YIRGIRE 658
of the page. el

n

‘ ’an Background
of the page

Stop video here and ask students to change the background of the page and then
play the video again.
JE20I6Q @63 q 9% 29 99° RIg ARG 699 R QUIRYIRE q 658 KK
IR G2 99° SIT6Q GGG § RS SR |

3217. To stop video time at 25 minute 21 seconds in VLC Media Player.
Stop video here and ask students to change the background of the page as

shown in video and then play the video again.
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YE@0I69 ©E6 @ 9% a2 99° I8 FIeg 66 6Q 6QHIAIRNYR! IR 6@
NFPIRE § 698 AR AR §L IS° FIU6R BEG § YRS SR |

328. To stop video time at 25 minute 43 seconds in VLC Media Player.

COMPUTER SHIKSHA

Shut down your computer.

£a efiaca g 9L a9 |

Stop video here and ask the students to save the writer file and then shut down
the computer.
YZ0I69 0BG § 99 R 99° ]I FIeg AURNTR PR § 699 2% iR

92 99° GIU6R KRS § 9L KAQ! aiR Qe |
Just check whether they have shut down the computer or not.

36@ 699 2052 6971168 SFATA § 9L FORE & AIX |
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Complete teacher’s manual for Writer 2 Class 9
Class 9 Summaries

v Open your laptop/notebook and switch on.

S MUIISY /6R199R 369 @ IQ° §6 2q /9 |
v How to open Writer file and operate it?
ARG QA FlRM § 697G 6697 FQUAN I° IRIQ QUSLIR 6906
@AUIN?
v" Why we use Change case?
2661 AI2G 698 609 QULLIR o ?
v What is table?
60'q9Mm @él ?
v" What is row and column?
69l 9Q° 6qlemIc] @6l ?
v How to insert table?
6915 699M § AR RALS KRG ?
v" What is merge cell?
ad 69m [l ?
v" What is split cell?
4o 69R @4l ?
v How to use table option?
699Mm 2Ye § A9 QUSRI YUK ?
v How to change table design?
699M Q GRIND @ AU 650G KA ?
v How to Close Writer file?
AURTA A FIRM § 6906 L AT ?
v How to shut down computer?
APRATR @ 69¢16 L KAG ?
Now let’s start class.

29 969 Q&6 2198 89! |
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320. To stop video time at 26 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell how many types of 2661 98 AINS 60R BAICLESNS
page orientation are there? 6Q6C gRI AR ?

-

Stop video here and ask, if they can tell there are how many types of ‘Page
Orientation’?

YE0I6Q ©E3 g 9% AR 99° JFIR IE 697167 REUIRER Page

Orientation’ 696% IRl 2R ?
Just listen to the answers and play the video again for the correct answer.

Qa9 § g4 99° 909 209 IR @86 § AR SR |

330. To stop video time at 41 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you say £661 QT AIRS 2l6e 6219 QYIY K61
why we use Drop caps ? dIR QYSLIN /R ?

Stop video here and ask if they can tell why we use ‘Drop Caps’?
JE0I69 @63 Q 9L A9 Y9° JoIQ T 6971I6Q @EAIRESR I6E <Drop
Caps’ QIZG QUETIQ @R ?

Just listen to the answers and play the video again for the correct answer.
QA q §4 99° A0 AR AR &4 q qa*@a omi2 |
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331. To stop video time at 1 minute 01 seconds in VLC Media Player.

COMPUTER SHIKSHA

s 2661 9% AIGS 2i6e §P FaAIR
Can you tell why we use Blinking ? QUELIN Qg

/ i
"y

Stop video here and ask if they can tell why we use ‘Blinking’ option?
YE@0I69 ©E6 @ 9% AR 99° JFIR I& 6971I6Q @RUIRAES 2I6¢] “Blinking’

YR AR SUSTIR R ?
Just listen to the answers and play the video again for the correct answer.

QRA § g4 99° 90Q Q9 IR §E6 § eI SR |
332. To stop video time at 1 minute 24 seconds in VLC Media Player.

COMPUTER SHIKSHA

Now open your writer file. HEE EHa ng.g? Imam g 6eae

Uit § - Openmce writee
nom

“va @4
- o A-v-m

Stop video here and ask students to open the ‘Writer file and then play the video
again?

JE0I6Q 66 Q 9% A9 99° ]IE FIRg AURTA A PIRM G 3648 AR
IR G 99° SIT6Q BEE § YRS SR |
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333. To stop video time at 1 minute 31 seconds in VLC Media Player.
-4

COMPUTER SHIKSHA

Let us now know what all you are 219 eiAIe F18SI § 2AIFQ |19 691
going to learn in today’s class . £661 99 Q6 §ge |

Stop video here and ask, what will we learn today?

YE@0I69 ©E06 @ 9% /R 99° 951 2R 26F @4l FgS ?

Just listen to the answers and play the video again for the correct answer.
QRQ § g4 99° 90Q Q9 IR §E6 § eI SR |

334. To stop video time at 2 minute 20 seconds in VLC Media Player.
. 4

COMPUTER SHIKSHA

Now type out the paragraph being ga2ie6a 6961 IRl AINUGIP
shown in front of you. g oIed e |

So he lay on the ground, held his breath and appeared

to be dead. The bear came near him and sniffed the
whole body of Raju. Thinking him dead, he went away.
When the bear had gone quite far Raju got on his feet.
Ramu also came down the tree. He asked Raju to tell
him what the bear had whis-pered in his ear. Raju said
that the bear had advised him to beware of false
friends like him.

Stop video here and ask students to type the paragraph as shown in video.
JE20I69 @63 q 9% 29 99° I AIeg 983 69 6L6IKIRNYS AR AP

g 9109 S99 IR §F |
Now just check and play the video again.
69 T6R 697 2202 IG° GIU6Q VX6 § YRR ORI |
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335. To stop video time at 2 minute 55 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell £661 @8 GIfE 6RIAR 684 FINU
what happens with lower case ? @6l 6LIRN2AIN ?
.l B/ U
B e

e

-
—

Stop video here and ask if they know what happens with ‘Lower Case’ option?
JE@0I69 ©E6 @ 9% AR 99° JFIR ARG 649167 RIERE ‘Lower Case’2YR
KU @6l 6L 12N ?
Just listen to the answers and play the video again for the correct answer.
Qa9 § g4 99° 909 209 IR @86 § AR SR |

336. To stop video time at 3 minute 20 seconds in VLC Media Player.

Stop video here and ask students to select the paragraph as shown in the video
and then play the video again.

JE0I69 @63 Q 9L 29 99° I AIeg 883 69 66N AR AP
g J6Me ARSI AR 9L I6° GlU6Q @66 § YRSIR I |
337. To stop video time at 3 minute 54 seconds in VLC Media Player.

Stop video here and ask students to change the paragraph in ‘Lower Case’ as
shown in the video.

JE0I69 @63 Q 9L 29 99° I AIng 883 69 66N AR AP

Q ‘Lower Case’ § 658 @991 9IQ 92 |
Now just check if everyone has done so and play the video again.

969 56Q 699 29a2 e6g Gll FRINRE @ 99° GlU69 8E6 § eI
SR |
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338. To stop video time at 4 minute 4 seconds in VLC Media Player.
&. 44

COMPUTER SHIKSHA

Can you tell what is Sentence 661 @2 GIfE 6964, 699 Q6
case ? 6% ?
B/ U

N =

e
/ e
55| Ay
Do

Stop video here and ask if they know what is ‘Sentence Case’ option?
JE@0I69 ©E6 q 9% AR 99° A9IR UG 6971I6R QIEIRT ‘Sentence Case’
e @l ?
Just listen to the answers and play the video again for the correct answer.
QRA § g4 99° 90Q Q9 IR §E6 § eI SR |

330. To stop video time at 4 minute 28 seconds in VLC Media Player.
Stop video here and ask students to select the paragraph as shown in the video
and then play the video again.
JE0I69 @63 Q 9L 29 99° I AIng 883 69 66N AR AP
g 96AY A8 AIR G2 99° SIU6Q BEE § YR ORI |

340. To stop video time at 5 minute 09 seconds in VLC Media Player.

Stop video here and ask students to apply the ‘Sentence Case’ as shown in the
video.

JE0I69 @63 q 9L 29 99° I8 AIng @83 69 6Q6IUIRYS! AR ‘Sentence
Case’ 996 QIR QE |

Now just check if everyone has done so and play the video again.

Y69 569 607 @0a2 4069 QL 2R & I9° PlJ6x ©EG § qqe‘m
omig |
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341. To stop video time at 5 minute 19 seconds in VLC Media Player.

.

o T,
COMPUTER SHIKSHA

Can you tell £6¢1 OF €IRe 2YR 699 Q
what happens with UPPER CASE? IELIN FIQU K6 6LINAIN ?

}'“ = ‘

‘ 57 | S ondFormmmian F13 Copitate Every Wesd
e
-/ .
55| Ay
Do

Stop video here and ask if they can tell what happens with ‘Upper Case’?
YE0I69 ©E06 @ 9% AR 99° J9IR JQ 649I6Q @€ AIRES “Upper Case’
K1l @6l 6L IM2IN ?
Just listen to the answers and play the video again for the correct answer.
Qa9 § g4 99° 909 209 IR @B6 § AR SR |

342. To stop video time at 5 minute 54 seconds in VLC Media Player.

Stop video here and ask students to select the paragraph as shown in the video
and then play the video again.

JE20I69 @63 Q 9% 29 99° I AIeg 983 69 6L6IKIRNYS! AR IR
g J6Me ARSI dIR 9T I6° GlJ6Q @66 § YRR I |
343. To stop video time at 6 minute 24 seconds in VLC Media Player.

Stop video here and ask students to change the paragraph into ‘Upper Case’ as
shown in the video.

JE0I69 @63 Q 9L 29 99° I AIeg 883 69 66N AR AP

q “Upper Case’69& @99 5[} qQu |
Now just check if everyone has done so and play the video again.

69 T6R 694 9002 96169 GIL] fRINRE & I8° GIU6R VBE § JeIR
omIe |
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344, To stop video time at 6 minute 39 seconds in VLC Media Player.

% . ag

COMPUTER SHIKSHA

Can you tell what happens with -
th: it “Capital‘i’z"e s 2661 2 QIS “SUIASIAIRG 9B
@6 @ QUSLIR TIRI 96 621R2AN ?
| = e 5

Stop video here and ask if they can tell what happens with ‘Capitalize Every
Word’ option?

JE0I69 @63 q 9L @9 ¥9° JoIQ IQ 6971I6Q @EAIRES “Capitalize Every
Word’ 29a 919U @6l 6Ll ?

Just listen to the answers and play the video again for the correct answer.

Qa9 § g4 99° 909 209 IR @86 § AR SR |

345. To stop video time at 7 minute 11 seconds in VLC Media Player.
Stop video here and ask students to select the paragraph as shown in the video
and then play the video again.

YQ0I6Q ©8B § 9L A 99° RIL FIRg V&6 61 69HIAIRNYS| A AU

g J6AS Q! dIR g2 I9° SIF6Q GE6 § ReI oI |

346. To stop video time at 8 minute in VLC Media Player.
Stop video here and ask students to change the paragraph into ‘Capitalize Every
Word’ as shown in the video.

JE0I69 @63 @ 9L A9 99° I AIeg ©83 69 6L6IKIRNYS! AR AP

q “Capitalize Every Word® § 66 @9 QIR §€ |
Now just check if everyone has done so and play the video again.

69 T6R 699 9002 96169 GIL] fRIRRE & I8° GIU6R VBE § JedI
omIe |
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347. To stop video time at 8 minute 10 seconds in VLC Media Player.
¢ 4

COMPUTER SHIKSHA

Can you tell why we use the £661 @€ AINE 2I6F AR 699 A
Toggle case option ? QUELIN RILR @AIQ ?
e E=thevae
T M ow
¥

- e
%J

Stop video here and ask if they know why we use ‘Toggle Case’?
JE0I69 @63 q 9% A9 99° JoIQ T 697160 KRISIRE 2I6E! “Toggle Case’
LG QUSTIR R ?
Just listen to the answers and play the video again for the correct answer.
Qa9 § g4 99° 909 209 IR @B6 § AR SR |

348. To stop video time at 9 minute 29 seconds in VLC Media Player.

Stop video here and ask students to apply the ‘Toggle Case’as shown in the
video.

JE20I69 63 q 9% 29 99° I AIeg 983 69 6Q6IKIRNYS AR “Toggle
Case’ @091 IR Q2 |

Now just check if everyone has done so and play the video again.

69 T6R 699 900 96168 GIL] FRIRRE & I8° GIU6R VEG § JedI
oIl |

3409. To stop video time at 10 minute 05 seconds in VLC Media Player.
. 4

COMPUTER SHIKSHA

Do you know what is a table and geel GI@&GG‘QQ @61 99° 2les
why do we use it ? NgIg FIEE QUETIQ SRAIN ?

Stop video here and ask if they know what is ‘Table’? And why we use it?
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JE0I69 ©E6 @ 9% AR 99° JFIQ UG 6DCI6R QIEIRE ‘Table’ K6l ? IQ°

a6l 9Ll QLG QYeLIa @ ?
Just listen to the answers and play the video again for the correct answer.
QA q §4 99° A0 AR IR VBG q QG‘G{IQ omie |

350. To stop video time at 10 minute 06 seconds in VLC Media Player.
=7

COMPUTER SHIKSHA

You might be wondering £6f1 QUGYS 681 IS° 6RI6MIA
what are rows and columns ! @6l !

Row & Column

Wi - -
" o

Stop video here and ask them, if they know what is ‘Row and Column’?
YG0I69 ©E3 § 9% AR 99° Gl JFIA I8 697166 RIGIRT ‘Row I&°
Column’@él ?

Just listen to the answers and play the video again for the correct answer.
QA9 § g4 99° 90Q Q9 IR 6E6 § Rei SR |

351. To stop video time at 11 minute 18 seconds in VLC Media Player.
=y

COMPUTER SHIKSHA

Let us now learn how to insert 219 SEiFIS FI18S1 & 669A ¢ Fad
tables ? 2ead ealaNg ?

Insert Table

Stop video here and ask if they know how to insert a ‘Table’ and how many
methods are there to insert a ‘Table’?

YE@0I69 ©E3 @ 9% @R 99° IFIR UG 6971I6R QSRS 66115 ‘Table’ AR

Re9E SR 9G° ‘Table’ § AEIE FAS! IR 6962SIT AT 2R ?
Just listen to the answers and play the video again for the correct answer.

Qa9 § g4 99° 909 209 IR @B6 § AR SR |
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352. To stop video time at 12 minute 38 seconds in VLC Media Player.
Stop video here and ask students to click on the ‘Table’ menu as shown in the
video and then play the video again.

JE0I6Q @63 @ 9% 29 99° ]Ig AIeg @63 61 696N AR “Table’
6619 9 {2 2RI ([ 9L 99° PlU6 ©E6 § Q?.‘élfa omid |

353. To stop video time at 13 minute 53 seconds in VLC Media Player.
Stop video here and ask students to insert a table as shown in the video and then
play the video again.

JE0I6Q @63 q 9L 29 99° Ig AIng @G3 62 6Q6IKIRYL AR 631159

‘Table’ § RALE 9AG! AIR G2 IS° G169 &G § LI SR |

354, To stop video time at 15 minute 27 seconds in VLC Media Player.
Stop video here and ask students to type the titles in the table as shown in the
video and then play the video again.

JE0I69 63 q 9L 29 99° ]Ig AIng ©G3 69 6Q6IKIRYS AR 659

69 title 6AYS IR G2 IS° SI6Q BBG § YA SR |

355. To stop video time at 16 minute 08 seconds in VLC Media Player.
Stop video here and ask students to type out the names in the table as shown in
the video.
JE0I6Q ©E6 q 9L 9 I8° &I2 Fleg @63 69 6QHINIRNYR IR 659M

69 QI JE% 6AYS! IR gL IS° SIF6Q &G § LI SR |
Now just check whether they’ve typed the names or not and then play the video
again.
Y69 569 600 9R 647160 Qlfl YL MRS & QIR 98° GIT6Q
QB0 g YRS SR |

356. To stop video time at 16 minute 33 seconds in VLC Media Player.
Stop video here and ask students to type out the ‘roll number’ in the table as
shown in the video.
JE20I6Q @63 q 9% 29 99° Ig AIng Q63 61 6Q6IKIRIYR IR 659
69 “roll number’ 6RYSI TN GL |
Now just check whether they’ve typed the ‘roll number’ or not and then play the
video again.
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969 569 699 990G 699169 ‘roll number’ 6AYAIDRE @ QX I° G1U6Q
PE6 § YeSIa eRI2l |

357. To stop video time at 18 minute 08 seconds in VLC Media Player.
Stop video here and ask students to type out the data as shown in the video.

JE@0I69 ©E6 q 9L AR 99° I8 FAIeg §86 61 69N IR BIS!
q@q 6A%Sl IR QT |
Now just check whether they’ve typed out the data or not and then play the
video again.
96Q 569 699 290G 6971165 BIF1 I8 CAHIINRE @ QIE I9° G969
PE6 § eI SR |

358. To stop video time at 18 minute 33 seconds in VLC Media Player.

Can you tell how you can insert a
row?

COMPUTER SHIKSHA

£69 @& AIRS 691 ¢ 6908 Aeqd
QAN ?

Stop video here and ask if they can tell how to insert ‘row’?
JE@0I69 ©E6 g 9% a1 99° JFIQ I& 6Q7I6R RLUIAER row’ § FAR

RAAS QUL ?
Just listen to the answers and play the video again for the correct answer.
QAR q g8l 99° A0SR AAQ AR &4 qQ q&‘éla omid |

3509. To stop video time at 19 minute 40 seconds in VLC Media Player.
Stop video here and ask students to click on the ‘Table’ menu and then click on
the ‘Row’ option as shown in the video and then play the video again.

JE0I69 66 @ 9L 29 99° ]Ig AIng ©E3 69 696N AR
‘Table’6617 G G2 909! IR G IG° QIU6R ‘Row’ YR § &2 498! AR
3L IG° QIU6R BH6 § YRR SRI |

360. To stop video time at 20 minute 45 seconds in VLC Media Player.
Stop video here and ask students to insert a row as shown in the video.
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JE@0I69 ©E06 @ 9% AR 99° I8 AIeg 8@6 63 6Q5IKIRYS| IR ‘Row’ §

Re9d 99 IR §F |
Now just check whether they have inserted a row or not and then play the video
again.
Y69 56Q 607 @272 64916S ‘Row’ qQ QR Q58] @ Q17 99° FIg6
PE6 § eI eIl |

361. To stop video time at 21 minute 21 seconds in VLC Media Player.
Stop video here and ask students to type the data in the new row as shown in the
video and then play the video again.

JE0I6Q @66 @ 9% 29 99° ]Ig AIeg @63 62 696N AR Q2

‘Row’ 69 @191 956G 6RYSI AIN GL I° GIU6Q ABE6 § YRS SR 1|
362. To stop video time at 21 minute 27 seconds in VLC Media Player.

e

Can you tell how you will insert
columns?

COMPUTER SHIKSHA

2661 98 AIRS 6QI6AIE § 6905
Q89 ST ?

Stop video here and ask if they can tell how to insert ‘column’?

YE@0I69 ©E06 @ 9% AR 99° dFIR T 69768 @RGSR ‘column’ § FAR

RAAS QUL ?
Just listen to the answers and play the video again for the correct answer.
QA q §4 99° A0 AR AR &4 q QG‘Q‘IQ omid |

363. To stop video time at 23 minute 28 seconds in VLC Media Player.
Stop video here and ask students to insert a column as shown in the video.

JE0I69 @63 Q 9L 29 99° RIG FIeg 883 69 6L6IAIRNYS! AR ‘column’

g 2099 99l AR 9L |
Now just check if everyone has done so and play the video again.

969 56Q 699 @9a2 gr6g Gl] FRINRE @ 99° GlU69 8E6 § IR
SR |
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364. To stop video time at 23 minute 34 seconds in VLC Media Player.
Stop video here and ask if they know how ‘delete’ option is used?

JE@0I69 ©E06 @ 9% AR 99° JFIR T 647I6R QIEIRE ‘delete’ AYR § FAR

QUL QUL ?
Just listen to the answers and play the video again for the correct answer.
Qa9 § g4 99° 909 209 IR @B6 § AR SR |

365. To stop video time at 24 minute 42 seconds in VLC Media Player.
Stop video here and ask students to delete the row as shown in the video and
then play the video again.

JE@0I69 ©E6 @ 9% AR 99° I8 AIeg 8@6 63 6Q5IUIRYS| AR ‘Row’ §
‘delete’ @RS AIR QL BIU6Q GGG § YRR SR |

366. To stop video time at 25 minute 11 seconds in VLC Media Player.
Stop video here and ask students to delete a ‘column’ as shown in video.

JE0I69 @63 q 9L 29 99° I8 AIng @83 69 6L6IKIRYS! AR ‘column’
g ‘delete’ @G QIR G |
Now just check and play the video again.

69 T6R 699 920 98° 866 g I SRIZ |
367. To stop video time at 25 minute 17 seconds in VLC Media Player.

Stop video here and ask if they know why we use ‘select option’?

JE0I69 ©E06 @ 9% AR 99° JFIR UG 697I6R QGRS 2I6E! ‘select option’

g 128 QUELIR SN ?
Just listen to the answers and play the video again for the correct answer.
QA q §4 99° A0 AR AR &4 q QG@IQ omid |

368. To stop video time at 26 minute 14 seconds in VLC Media Player.
Stop video here and ask students to select the ‘table’ as shown in video.

JE0I69 @63 @ 9L A9 99° I AIeg 883 69 626N AR AP
g 96AQ A% AIR L |
Now just check and play the video again.
Y69 56Q 607 Q02 IQ° 98B q qgéla omie |

3609. To stop video time at 26 minute 40 seconds in VLC Media Player.
Stop video here and ask students to select a ‘row’ as shown in video.
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JE@0I69 ©E06 Q@ 9% A 99° I8 AIeg 8@6 63 6Q6IKIRYS| IR 695N
‘row’ § J6A 9SG AIR QE |
Now just check and play the video again.
Y69 56Q 607 Qa2 IQ° 9B q qsa*éla omid |

370. To stop video time at 27 minute 12 seconds in VLC Media Player.
Stop video here and ask students to select a ‘column’ as shown in video.

YE@0I69 ©E06 Q@ 9% A 99° 8I8 AIeg 8@6 63 6Q6IKIRYS| IR 6915
‘column’ § J6AS, A0S IR QL |

Now just check and play the video again.

69 T67 699 9002 98° 866 g I SRIZ |

371. To stop video time at 27 minute 40 seconds in VLC Media Player.
Stop video here and ask students to select a ‘cell’ as shown in video.

JE0I69 @63 q 9L 29 99° ]Ig AIng @63 62 6Q6IUIRYR AR 6315
‘cell’ § S6me FAG! IR G |
Now just check and play the video again.
J6Q T6a 60Q QR 99° LG q qm‘la omid |
372. To stop video time at 27 minute 49 seconds in VLC Media Player.

(v

Do you know what is a Merge cell?

COMPUTER SHIKSHA

£66 Q1818 § A 69R 96 266 ?

Stop video here and ask them if they know what is ‘merge cell’?
JE0I69 63 Q 9L A9 99° oI T 697160 RISIRS ‘merge cell” K4l ?
Just listen to the answers and play the video again for the correct answer.
QR § g4 99° 0] Q9 IR §E6 § eI SR |

373. To stop video time at 29 minute 03 seconds in VLC Media Player.
Stop video here and ask students to select the cell as shown in the video and
then play the video again.
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JE@0I69 &6 @ 9% AR 99° I8 AIeg 8@6 63 6QSIKIRYS| AR “Cell” @

J6AS A0S TN 9L 99° SIT69 8B6 § 9 SR |
374. To stop video time at 29 minute 21 seconds in VLC Media Player.
Stop video here and ask students to ‘merge’ the cell as shown in the video.

JE0I69 63 Q 9L 29 99° I AIeg 883 69 6LGIKIRNYS! AR “Cell’ @
‘merge’ 908 IR GL |

Now just check if everyone has done so and play the video again.

Y69 56Q 607 @9G2 4069 2Ll 2IRE & I9° PlJ6x ©EG § qs?eﬂa

omid |
375. To stop video time at 29 minute 33 seconds in VLC Media Player.

Do you know what is meant by
split?

COMPUTER SHIKSHA

2661 Q188 § ' 9 FI6E 961 26T ?

Stop video here and ask them if they know what is the meaning of ‘split’?

JE0I6Q 886 q 9L 9 I8° JFIQ G 69768 QISR “split’ Q IR @6l ?
Just listen to the answers and play the video again for the correct answer.
QA9 § g4 99° 90Q Q9 IR 6E6 § ReIa SR |

376. To stop video time at 32 minute 09 seconds in VLC Media Player.
Stop video here and ask students to do ‘Split’ as shown in the video.

JE0I6Q @63 @ 9% 29 99° RIg AIeg QG3 61 6Q6IAIRIYL AR “Split’
Q! IR L |

Now just check if everyone has done so and play the video again.

69 T6R 694 9002 96169 GIL] RRIRRE & I8° GIU6R VBE § JeI
omig |

3717. To stop video time at 32 minute 14 seconds in VLC Media Player.
Stop video here and ask if they know why we ‘Auto format’?
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JE@0I69 ©E6 g 9% 2R 99° dFIR I8 697169 QISR 2671 “Auto format’

QLG USTIR FRAIR ?
Just listen to the answers and play the video again for the correct answer.

Q9 § g4 99° 0] Qa9 AR 8E6 § Ja<Ia oI |

378. To stop video time at 33 minute 59 seconds in VLC Media Player.
Stop video here and ask students to change the design of the table as shown in
the video and then play the video again.

JE0I6Q @63 q 9L 29 ¥9° I AIng Q83 69 6L6IAIRYS AR ‘Table’ Q
2RING § 698 A9 AR 9T I8° SI6Q AB6 § AR SR |

379. To stop video time at 34 minute 16 seconds in VLC Media Player.

COMPUTER SHIKSHA

Closing Writer. ARG G 9L IR |

——

Close Button

Stop video here and ask the students to close the writer file and then shut down
the computer.

Q0169 966 q 9@ @A 99° 8I8 7o ARTR FIoM § 699 @S AR

92 99° GIU6R KTRATA § 9L KRS aiR Qe |
Just check whether they have shut down the computer or not.

36@ 699 290G 6971168 SFATA § 9L FORE & AIX |
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Complete teacher’s manual for Writer 2 Class 10
Class 10 Summaries

v" Open your laptop/notebook and switch on
S MUIISY /6R199R 369 @ IQ° §6 2q /9 |
v" How to open Writer file and operate it.
ARG QA PR § 697G B6dQ FAULN IF° YLIQ QUSRIR 694G
@ULIN?
v" What is table?
Table @6l ?
v" What is row and column?
Row 2 Column @él ?
v How to insert table?
Table § 892 REIS AU ?
v" What is merge cell?
Merge cell @6l ?
v" What is split cell?
Split cell @6l ?
v How to use table option?
Table 2R @ @I ULLIR AU ?
v How to change table design?
Table Q @RING § FAR 665G AU ?
v How to Close Writer file.
AURTA A FIRM § 6906 L AT ?
v How to shut down computer.
AFARATA G 62118 L K98 ?
Now let’s start class.

29 969 Q&6 2198 89! |
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380. To stop video time at 40 seconds in VLC Media Player.

COMPUTER SHIKSHA

Cilm::ﬁ'm;tc':;: ::::ere:: . 661 @LAINS CRIAN 69€ I9°
case ? e 2AYR 699 AU AIARY @61 2

Lowercase
&
UPPERCASE

Stop video here and ask if they know the differences between ‘Upper Case’ and
‘lower case’?

JE0I69 Q63 @ 9L A9 Y9° oI UG 6971I6Q “Upper Case’ \IK° lower

case’ F1216Q QIZQY RIEIRT ?
Just listen to the answers and play the video again for the correct answer.

QRA § g4 99° 90Q Q9 IR §E6 § eI SR |
381. To stop video time at 1 minute’_ 10 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell what happens with 2661 @8 AIfS “QUIATINIRG IR
Capitalize every word ? 36" Q QYSLIR FINI K6 6LIN2AIN ?

-
% Capitalize every word

Stop video here and ask if they know what happens with ‘Capitalize Every
Word’ option?

YE@0I69 ©E6 @ 9% AR 99° I5IR U8 6971I6R QIEIRS ‘Capitalize Every

Word’ 2Ya I @él 6Ll ?
Just listen to the answers and play the video again for the correct answer.

Q9 § g4 99° 90] Q99 AR 86 § eI ol |
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382. To stop video time at 1 minute 31 seconds in VLC Media Player.

COMPUTER SHIKSHA

Do you know what is a table and geea alagseqm @61 9e° 2Alen
why do we use it ? 9gIg FIEE QYELIQ AR ?

Stop video here and ask if they know what is ‘“Table’ and why we use it?
JE0I69 63 Q 9L A9 Y9° JoIQ UG 697160 RISIRE & ‘Table’ K4l IQ°

4[N RN QLG LR SRR ?
Just listen to the answers and play the video again for the correct answer.

QRA § g4 99° 90Q Q9 IR §E6 § eI SR |
383. To stop video time at 2 minute 14 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell what happens with £661 @2 AIRE A 69Q TN 6l
Merge cell ? 6QIQAN ?

Stop video here and ask them if they know what happens with ‘Merge Cell’
option?
JE0I69 @63 Q 9L A9 99° JoIQ T 6971I6Q RISIRE & “Merge Cell” FIQ

@6l 6L ?
Just listen to the answers and play the video again for the correct answer.

Q9 § g4 99° 90] Qa9 AR 8E6 § eI ol |
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384, To stop video time at 2 minute 34 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell what happens with £661 @8 dIfe ¢ 69R FIQU @4
splitcell ? 6QIQAN ?

Split Cells

Stop video here and ask them if they know what happens with ‘Split Cell’
option.
JE0I69 @63 q 9L @9 Y9° oI AT 697160 KRISIRE & “Split Cell’ FIN
@6l 6Ll ?
Just listen to the answers and play the video again for the correct answer.
QA q §4 99° A0 AR AR &4 q QG?Q‘I%} omid |

385. To stop video time at 3 minute 15 seconds in VLC Media Player.

COMPUTER SHIKSHA

Now open your writer file. Neggdal ngg IGPIQE! 8689

Stop video here and ask students to open writer file and then play the video
again.

JE20I6Q @66 Q 9% 29 99° RIg AIRg AURTA A FIRM § 3647 AR
IR G2 99° SIT6Q BE6 § RS SR |
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386. To stop video time at 4 minute 31 seconds in VLC Media Player.

=

Thae

COMPUTER SHIKSHA

Next, all of you make a table SIRINER §651 & T 68U IQ° 8 &
containing 5 rows and 5 columns 6QI6RIA G2AIR @R I° | LR
and add a student’s record to it. 8Ig FINF A 699E CAUR /A |

Name Roll No. |Maths English Hindi
Vikash 87 69

1

Samir 2 922 73
Rohan 3 68 67
Prakash 4 72 65

Stop video here and ask students to create 5*5 Table and add students’ details in
it and then play the video again.
JE@0I69 @63 q 9L 29 99° RIg AR 5*5 6Q 695N Table G KRR
([} 9L 99° ]Ig AIew SR G2l 692)6Q QS ([} g% JQ° ©ldeR
Q&6 § eI oI |

387. To stop video time at 5 minute 03 seconds in VLC Media Player.

Stop video here and ask students to click on the ‘Insert’ menu and then click on
the ‘Table’ option as shown in the video and then play the video again.
JE0I69 63 Q 9L 29 99° ]Ig AIng ©G3 69 6Q6IUIRYL! AR “Insert’
6919 § 39 99QI AIN G 9S° GIU6R ‘Table’ AYE § 4R FAS! IR §L I°
GlU6Q V6B § PRSI I |

388. To stop video time at 5 minute 46 seconds in VLC Media Player.
Stop video here and ask students to insert a table as shown in the video and then
play the video again.
JE0I69 @63 q 9L A9 99° ]Ig AIng ©G3 62 6Q6IUIRYR AR 63115
‘Table’ § RELS @0Q! AIR G IS° GIU6R A&G § PRSI SR |

3809. To stop video time at 6 minute 47 seconds in VLC Media Player.
Stop video here and ask students to type the titles in the first row as shown in
the video and then play the video again.

JE0I69 @63 @ 9L A9 99° I AIeg G83 69 66NN AT Jalel
‘Row’ 69 SRR § 6RYS! AR G2 IG° Gl96Q 8&6 § YRS I |

390. To stop video time at 8 minute 11 seconds in VLC Media Player.
Stop video here and ask students to type the data in the table as shown in the

video and then play the video again.
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JE0I69 ©E6 g 9% AR 99° I8 FIeg G868 6Q 6QHAIRIYR! AR

‘Table’6Q ©I9' @ 6MYS AR 9L I9° PlU6 ©BB q g@éla omid |
391. To stop video time at 9 minute 23 seconds in VLC Media Player.

Stop video here and ask students to type the data in the table as shown in the

video.

JE0I69 ©E6 g 9% AR 99° I8 FIeg GEG 6Q 6QHAIRIYR! AR

‘Table’6Q! G191 § 6AHS! IR L |

Now just check whether they have typed out the data or not then play the video
again.

966 564 667 @0GY 62416% GI91 § FINY FRATRE @ QI I9° FIU6R
PE6 g 9aSIa ol |

392. To stop video time at 9 minute 33 seconds in VLC Media Player.
w7

COMPUTER SHIKSHA

Now all of you go ahead and show eaale £6¢1 96169 Q121 9e° gaAel
that you can insert a new row on 69l O QUER 66T g2 691
top of the very first row. aead @R 6962 |

Stop video here and ask students to insert the row and then play the video again.
YZ0I6Q QB6 § 99 A IG° &I AR ‘Row’ § RE9S @08 dIR §€ 98°

GlU6Q BE6 § YRSIR SR |
393. To stop video time at 11 minute 12 seconds in VLC Media Player.
Stop video here and ask students to insert row as shown in the video.

YQ0I6Q 08B § 9% @ 98° 1L FIng ©&G 61 6QHIAIRNIYS| I ‘Row’ §

Re9d fA9 IR §E |
Now just check if everyone has done so and play the video again.

69 T6R 699 9002 96169 GIL] fRIRRE & I8° GIU6R VBE § JeIR
omie |
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394, To stop video time at 11 minute 23 seconds in VLC Media Player.

b "4

COMPUTER SHIKSHA

Next, all of you merge this first 2IE69, §6¢1 AF169 YL 69U G ae
row and type in your school’s Q0 IE° 69Y6R £ M A QI
name in it. 6ms! |

Merge cells

Stop video here and ask students to merge the first row and type the school
name in it and then play the video again.

J@0I6Q BE6 § 96 9 I9° |1 FIeg 92 ‘row’ § ‘merge’ RS QIR
g% J9° 64269 M Q ¢l 6mYQ aiR 9L 99° QlU6q @63 q qmﬂa
omie |

395. To stop video time at 12 minute 11 seconds in VLC Media Player.
Stop video here and ask students to select the first row as shown in the video
and then play the video again.
JE0I69 @63 Q 9L A9 99° RIg 7Ieg 883 69 6LFIAINYS| AR ‘row’ @
J6ng fAS! IR G 99° 1969 BEE § eI SR |

396. To stop video time at 12 minute 36 seconds in VLC Media Player.
Stop video here and ask students to merge the row as shown in the video and
then play the video again.
JE@0I69 @63 Q 9L A9 99° RIg 7Ieg 883 69 6LFIAINYS| AR ‘row’ @
‘merge’ @01G1 IR G I9° SIT6Q GGG § YRS SR |
Now just check and play the video again.
Y69 56Q 607 202 IQ° 98B q qgéla omid |

397. To stop video time at 12 minute 55 seconds in VLC Media Player.
Stop video here and ask students to type the school name as shown in the video.
JE0I69 63 Q 9L 29 99° RIg ARG ©E3 69 66N IR Y Q
QT 6RYS| AN GL |
Now just check if everyone has done so and play the video again.
Y69 569 607 @952 4069 QL 2IARE & I9° PlJ6R ©EG § QG‘%‘{IQ
omid |
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398. To stop video time at 13 minute 05 seconds in VLC Media Player.
"=

COMPUTER SHIKSHA

Now show how you will split the 968 $6¢1 950 6619 6RUERIA §
very last column vertically into QERIM 9 & QS § S R

two parts. casli2l |

Sgs KB

Stop video here and ask students to split the last column vertically and then play
the video again.

JE0I69 @63 Q 9% @9 99° ]Ig AIeg 6819 ‘column’ q vertically “split’
F0S! IR G2 9G° GlU6R BE6 § YRFIR SR |

399. To stop video time at 14 minute 49 seconds in VLC Media Player.
Stop video here and ask students to split cells as shown in the video.

JE@0I69 ©E6 @ 9% AR 99° I8 FIeg 686 6Q 6QHIAIRYS! IR 69N
q@q ‘split’ @99 AR QT |

Now just check if everyone has done so and play the video again.

69 T6R 699 9002 96168 GIL] FRIRRE & I8° GIU6R VEG § JeIR

omid |

400. To stop video time at 15 minute 12 seconds in VLC Media Player.
. 4

COMPUTER SHIKSHA

Now show how you will change N6 611 $10 66'GM alae
the design of your table. 60% @R 69612 |

‘ v ‘/I"l ~ Change the design of
‘ = table

Stop video here and ask students to change the design of the ‘Table’ and then
play the video again.

J@0I6Q GGG § 96 89 99° RIE FI9g ‘Table’ QA PRING § 658 9AQ| AR
QL IS° GIU6Q VBB § YRR SR |
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401. To stop video time at 16 minute 30 seconds in VLC Media Player.
Stop video here and ask students to change the design of the ‘Table’ as shown

in the video.
JE@0I69 @63 q 9L 29 99° I AIeg Q83 69 6L6IKIRYS AR ‘Table’ X

PRIRG G 66% 999! AR 9L
Now just check whether they have changed the design of the table or not and
then play the video again.
J6Q 56q 699 2002 & 6496% ‘Table’ Q @RIV § 658 2IARE &
Q12 99° QIT69 BBG6 § 9L SR |

402. To stop video time at 16 minute 50 seconds in VLC Media Player.

& o

COMPUTER SHIKSHA

Shut down your computer.

218 *fi0cR g 99 89l |

Stop video here and ask the students to save the writer file and then shut down
the computer.
YZ0I6Q @66 § 90 A 98° RIS FIfE ARTRA FIRM § 698 A< IR

92 99° GIU6R KTRATA § 9L KRS aiR Qe |
Just check whether they have shut down the computer or not.

568 669 90172 626168 aFRTA § 99 F08E & A1T |
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Complete teacher’s manual for Writer 2 Class 11
Class 11 Summaries

v Open your laptop/notebook and switch on.

S MUIISY /6R199R 369 @ 9Q° §6 2q /9 |
v How to open Writer file and operate it?
AURGTR QA FlRM § 697G 3697 FAUAN IS° IRIQ QUSLIR 6906
@AUAIN?
v" What is status bar?
6RAFY QURX @6l ?
v" What is header and footer?
6L NR° LA R6l ?
v" Why we use hyperlink?
QRIRT 2651 FITE ULLIR KRR ?
v How to insert page border?
690G FUQ AR REAS AU ?
v" What is a table?
659Mm @6l ?
v How to insert table?
6915 659M @ @4 QRIS FG ?
v" What is merge cell?
ad 69m [l ?
v" What is split cell?
a6 69m 94 ?
v How to Close Writer file.
AURTA A FIRM § 6906 L AT ?
v How to shut down computer.
APRATR @ 69¢16 L KAG ?
Now let’s start class.

29 969 Q&6 2198 89! |
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403. To stop video time at 45 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell what happens with 2661 08 dIfS 6869 1A FIR Q61
the Status bar ? 6QIQAN ?

Stop video here and ask if they can tell what happens with ‘Status bar’?
JE0I69 @63 q 9L 29 Y9° JoIQ T 697168 R@EUIRAES Status bar’ I

@l 6Ll ?
Just listen to the answers and play the video again for the correct answer.

QRA § g4 99° 90Q Q9 IR §E6 § eI SR |
404, To stop video time at 1 minute 19 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell what are non-printing 266 @RAIRE 6RI9-aeP
characters ?And how do you 6FEARN QBT Q6 ? 99° 6QIQ-
remove the non-printing QaeP 6R6R YEG ANTR 69R
characters from your Writer page? 2 6086 201N AIRE ?

Non-Printing
character

Stop video here and ask if they know what are ‘Non-Printing Characters’ and how to
hide non printing characters from the writer page?

JE@0I6Q @63 q 9% 29 99° JoIQ T 697168 @ELAIRAES “Non-Printing

Characters’ @61 49° ‘Non-Printing Characters’ QRS 696 Q @I RN A ?
Just listen to the answers and play the video again for the correct answer.

Q9 § g4 99° 90] Q@9 AR §E6 § eI ol |
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405. To stop video time at 2 minute 10 vseconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell what happens with 266 QLIRS 69R 69€ FINU Q61
page break ? 6QIQAN ?

page break

Stop video here and ask if they can tell what happens with ‘Page Break’?
JE0I69 ©G3 @ 9L A9 Y9° JoIQ T 6971I6Q @G AIRES ‘Page Break® FIR

@l 6Ll ?
Just listen to the answers and play the video again for the correct answer.

QRA § g4 99° 90Q Q9 IR §E6 § eI SR |
406. To stop video time at 2 minute 4Q vseconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell why we use £67 GTAIRS Al6A LNQARST R
Hyperlink ? UL RILR Fardia?

Hyperlink

Stop video here and ask if they can tell why we use ‘Hyperlink’?

JE0I69 @63 Q 9L A9 99° JoIQ IT 697I6Q @& AIRES 26T ‘Hyperlink’

g FIE @ ULTIQ FRAR ?
Just listen to the answers and play the video again for the correct answer.

Q9 § g4 99° 90] Q99 AR 8E6 § eI ol |
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407. To stop video time at 3 minute 20 vseconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell what happens with 269 e2aIfe GorR 6T IR
Default formatting? @61 6LIRNAIN ?

Default
Formatting

Stop video here and ask if they can tell what happens with ‘Default Formatting’?
YE@0I69 ©E6 g 9L AR 99° A9IQ I& 697I6Q @& AIRES ‘Default

Formatting” Q19U @6l 6L Im2IIN ?
Just listen to the answers and play the video again for the correct answer.

QRA § g4 99° 90Q Q9 IR §E6 § eI SR |
408. To stop video time at 3 minute 4?3 vseconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell what is a Table ? £66 QRAINE & 659M 61 99°
Also why it is used ? 2661 9LIG FILE ULLIR FRAIQ ?

: i

Stop video here and ask if they can tell what is ‘Table’ and why it is used?
JE0I69 @63 Q 9L A9 Y9° JoIQ ITQ 6971I6Q @& TIRES “Table’ K8l 9Q°

Nelq QIEE USLUQ KU ?
Just listen to the answers and play the video again for the correct answer.

QA9Q § g4 99° 0] Q9 IR §E6 § ReIa SR |
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400. To stop video time at 4 minute 01 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell why we use Merge 2691 @€ QIS & 26 e 69R
cells? QLR QYeLIQ KRR ?

Merge Cells

Stop video here and ask if they can tell why we use ‘Merge cells’?

YE@0I69 ©E06 @ 9% AR 99° JFIR T 6476 /F AIRES 2I6E “Merge

cells’ § FIER SULLIR FR2IR ?
Just listen to the answers and play the video again for the correct answer.

Qa9 § g4 99° 909 209 IR @86 § AR SR |
410. To stop video time at 4 minute 2§_seconds in VLC Media Player.

COMPUTER SHIKSHA

. 5 ged Qi‘ﬂl@@ 269 Y 69R Q61
Can you tell why we use Split cell ? gIg QYERIR 0Q ?

, !

Stop video here and ask if they can tell why we use ‘Split cells’?
JE0I69 BE6 g 9% 2R 99° dFIR I& 697I6Q @8 AIRES 6L “Split cells’

g FIEG UL AR ?
Just listen to the answers and play the video again for the correct answer.

Q9 § g4 99° 90] Q@9 AR §E6 § eI ol |
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411. To stop video time at 5 minute 01 seconds in VLC Media Player.
=7

COMPUTER SHIKSHA

96€ S0 QARTR FIRM § B6AF
ol

“w
-a

Stop video here and ask students to open the writer and then play the video again.
JE0I6Q @63 @ 9% A9 ¥9° ]IE FIRg AURTA A FIRM § 3648 AR

IR G2 IG° GlU6R BE6 § YLFIR SR |

412. To stop video time at 5 minute 06 seconds in VLC Media Player.
Stop video here and check whether they have all opened the writer file or not and then
play the video again.

JE@0I69 ©E6 @ 9% AR 99° 664 99 697168 AUNTA QA FIAM q 369Q
FORE @ Q1T 9S° FIU6R 866 § YRR oI |

413. To stop video time at 6 minute 35 seconds in VLC Media Player.
=7

COMPUTER SHIKSHA

Can you tell what all you have P
Iearntyin view, insert, f(y)rmat and gg?:;%g?;a@%%%gg;géﬁg;
in the Table menus ? )

'
4 ’I “ i st pefi M
’ ' T
\ B85 BERYE . B¢ G20 M2mENd g, AR
c / ™ vnelken v 0 v BJUEEIN ZEGEAYR

Stop video here and ask students if they know what have they learnt in writer 2
module?

YE@0I69 066 @ 9% @R 99° 8I8 AIeg doIR UT 647I6R QIR 64I6R

QAURG'RQ 9 module 6 K& TGRS ?
Just listen to the answers and play the video again for the correct answer.

Q9 § g4 99° 0] Q@9 AR 8E6 § eI ol |
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414, To stop video time at 7 minute 51 seconds in VLC Media Player.

COMPUTER SHIKSHA

Now copy - paste the given line Qaele QAN NIV G €0 AN
10 times ensuring that each line 90 608 @A §g UIQ 69€ ALAIAR

appears in a new line. Q2 ARG 68 AR AN |

Stop video here and ask students to do ‘copy and paste’ 10 times of the given line and
then play the video again.

JE0I6Q @63 q 9L A9 99° I8 AIeg QKRR MIRR § €0 2N copy

and paste’ @29 IR 2 IS° FIU6Q BEG § YRS ORI |
415. To stop video time at 9 minute 52 seconds in VLC Media Player.
Stop video here and ask students to do copy paste as shown in the video.

JE0I69 @63 q 9L 29 99° I AIeg 883 69 6L6IYIRNYS! AR “copy and

paste’ @S] AR §F |
Now check whether they’ve ‘copy pasted’ or not and then play the video again.

Y69 659 9052 649I6Q “copy and paste’ @IIRE @ QIR 98° S196Q

PE6 § eI SR |
416. To stop video time at 9 minute 58 seconds in VLC Media Player.

COMPUTER SHIKSHA

Let us now revise about the 219 LIS @f@ 98 a Awig
Fields option. el |

Field Option

]

e,

Stop video here and ask students to practice ‘Field option’ and then play the video
again.
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YZ0I6Q 866 § 99 A 98° RIS FIFG “Field option” § ARIY SRS IR L

G° QlU6Q B&6 § YRS eIl |
417. To stop video time at 10 minute 04 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell why we use the Fields £661 @€ AIRS 2l6A TR AYE A
option? QUELIQ FIRE efIR ?

Stop video here and ask if they can tell why we use ‘Field option’?

JE@0I69 ©E06 @ 9% AR 99° JFIR UG 6476 *EUIRAES 2U6F! ‘Field
option’ § FIEG FUSLIR AR ?
Just listen to the answers and play the video again for the correct answer.

QRA § g4 99° 90Q Q9 IR §E6 § eI SR |
418. To stop video time at 10 minute 24 seconds in VLC Media Player.

COMPUTER SHIKSHA

Now, show how you will insert Q_(}iﬂlﬁ' geel Fe1a AL AER
today’s date after the second line. AR G108 AR S8 6612 |

Insert date

Stop video here and ask students to insert date on the writer page and then play the
video again.
JZ0I6 QGG q @« @A N’ RIQ N AN 6dE 6 ISl q taele

Q! IR §E 9S° GITIT6ER BBE § YRR SR |
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4109. To stop video time at 11 minute 24 seconds in VLC Media Player.
Stop video here and ask students to insert date as shown in the video and then play the

video again.
JE@0I69 ©E6 g 9% a2 99° I8 FIeg GEG 6Q 6QHAIRNYR! IR AR

693 69 5109 § RADY ARSI AN L IS° SILIYER BEG § YR\

I
420. To stop video time at 11 minute 53 seconds in VLC Media Player.

COMPUTER SHIKSHA

Can you tell what happens with £661 QEINS 6200 I9° FTR
Header and Footer ? FIQU @61 6LINAIN ?

Stop video here and ask if they can tell what happens with ‘Header and Footer’?
JE@0I69 ©E6 @ 9% AR 99° JFIR UG 697I6R RLUIRES ‘Header and

Footer’ Q19U @6l 6<I2IIN ?
Just listen to the answers and play the video again for the correct answer.

Q9 § g4 99° 90] Qa9 AR 8E6 § eI ol |

421. To stop video time at 12 minute 15 seconds in VLC Media Player.

COMPUTER SHIKSHA
Next, show how you will insert a F1U68 G611 AN 601 681 628N
Header and a Footer on your page. 96° PO QRS FR 69612 |

Header

&
Footer
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Stop video here and ask students to insert the ‘Header and Footer’ on the writer page
and then play the video again.

G016 9e3 q @@ @A N’ RIQ IR AN 6dG 69 ‘Header and Footer’

g R99d 294! IR gL 99° SILIU6 886 § YASIR SR |

422. To stop video time at 12 minute 50 seconds in VLC Media Player.
Stop video here and ask students to insert ‘Header as shown in the video and then play
the video again.

JE@0I69 @63 @ 9% 29 99° RIg AIng Q83 69 6R6IKIRYS IR AURTA
69% 69 ‘Header and Footer’ § RELDS 209! IR 98 IG° GILIU6R @66 q
Jesia omI2l |

Now just check whether they’ve inserted ‘Header’ or not and then play the video
again.
Y69 T6a 667 R0 695168 ‘Header’ § REDS 2008 @ §IE@ 9IS°

QITITER VBB § YRSl SmIY |

423. To stop video time at 14 minute 14 seconds in VLC Media Player.
Stop video here and ask students to insert date and time in the ‘Header’ box as shown
in the video and then play the video again.

JE0I6Q 986 q 9L 9 98° RIE Fleg QGG 6Q 696NN I ‘Header’
Qg 69 GIRG I9° 9l § REYS KRG AR L IG° GIFINER BEE6 §

JeI I |

424, To stop video time at 14 minute 37 seconds in VLC Media Player.
Stop video here and ask students to insert ‘Footer’ as shown in the video and then ask
them to insert page number in the ‘Footer’ box as shown in the video.

JE0I69 63 Q 9L 29 99° ]Ig AIng Q83 69 6Q6IUIRYS AR “Footer’

69 69@ 99 § AEYS QRS AR L I9° FILIER 8FE § YadIa SR |

Now just check whether they have inserted ‘Footer’ or not and then play the video
again.

969 56 660 02 6961I6R ‘Footer’ § AL S0RE & Al 99°

QlTITER VBB § YASIR SmIY |
425. To stop video time at 15 minute 27 seconds in VLC Media Player.
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COMPUTER SHIKSHA

Let us now revise the Character 219 SEiAIe 6Q6FRN AR A
option and practice using it. USLIR ALY KR |

Stop video here and ask students to do practice of ‘Character’ option and then play the
video again.
YZ0I6Q Q836 g 99 A IG° &I8 ARG ‘Character YR § ARUIY KAS! AIR

QL I9° FILIN6R 866 § YA SR |
426. To stop video time at 15 minute 05 seconds in VLC Media Player.
Stop video here and ask if they can tell what we can do with ‘Characters’ submenu?

JE@0I69 ©E06 q 9% 9 99° JFIR I& 6Q7I6Q @LUIRQER “Characters’

AL6Q 62 26T 8l @A2AIR ?
Just listen to the answers and play the video again for the correct answer.

QA9 § g4 99° 90Q Q9 IR 6E6 § ReIa SR |

427. To stop video time at 15 minute 58 seconds in VLC Media Player.
=

COMPUTER SHIKSHA

Change the first line so that $6€1 gaAF RING G 668 SR 6QIR
it appears Bold. eal

Stop video here and ask students to make the line ‘Bold’ and ‘Italic’ then play the
video again.
YE@0I69 ©E6 @ 9% @R 99° I8 AIFg RIRG § ‘Bold” 98° ‘Italic’ KRS

IR 9 I9° QILIN6a &6 § LI ORI |

428. To stop video time at 17 minute 12 seconds in VLC Media Player.
Stop video here and check whether they’ve made the line bold and italic or not and

then play the video again.
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JE0I6Q 63 q 9L A Y9° 659 99Ge & 69768 MR § Bold’ IS°
Ttalic’ 0RE @ Q1T I9° QITIU6R 866 § LTI S |

429. To stop video time at 17 minute 17 seconds in VLC Media Player.

COMPUTER SHIKSHA

Let us now practice the use of 219 LGS g AP QO AV
Font effects. @Rl |
e o

s ‘ S == g |
. | Times New Roman

Stop video here and ask the students to do practice of ‘Effects’ option and then play
the video again.

J@0I6Q GGG § 96 9 I9° RIG FISG ‘Effects’ 2AYR § AR 89S AN

QL IG° QITITER VBB § YRSl omIY |
430. To stop video time at 17 minute 23 seconds in VLC Media Player.

soe

COMPUTER SHIKSHA

Now, show how you will overline QEIFIR, §6¢1 §010 NKR §
on the second line. BRORINE SR 696112 |

Stop video here and ask students to apply over line on the second line and then play
the video again.

JE@0I6Q ©E6 g 9% 22 99° 88 FIfg §612 MINR 62 ARANAR 2R
dIR 92 IG° GITIU6R Q66 § JASI oM |
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431. To stop video time at 18 minute 40 seconds in VLC Media Player.
Stop video here and check whether they have applied over lining or not then play the
video again.
JE0I69 63 Q 9L A9 Y9° 699 25 & 697168 NRE 6] ALMIAS

A0RE & QIE 99° GITIT6R 886 § 9L SR |

432. To stop video time at 18 minute 54 seconds in VLC Media Player.
w7

COMPUTER SHIKSHA

Next, on the third line practise the CILILER, 6F $O10 NAG 69
use of the background option of 66N AFEAF A SUIRGIQE
the character sub menu. 2R A LI AN ! |

Background

Stop video here and ask the students to practice ‘Background’ option and then play the
video again.
Y@0I6Q ©E6 § 9% A I8° Ig ARG ‘Background’ Y@ § LI KR!

IR G 99° FILIU6R Q66 § YRR I |

433. To stop video time at 19 minute 57 seconds in VLC Media Player.
Stop video here and check whether they’ve changed the ‘background color’ or not
then play the video again.

JE0I6Q ©EG q 9L 9 I8° 667 @R & 6976 ‘background color’ §
658 G088 @ 91T 99° QITITER VEE § YRR SMIY |

434, To stop video time at 20 minute 05 seconds in VLC Media Player.
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COMPUTER SHIKSHA

Next, on the third line practise the CILILER, 67 $O10 NAG 69
use of the background option of 6F6LRN AFECAF A SUIREIQE
the character sub menu. 24 A LI 2ING }Q |

Background

Stop video here and ask the students to practice ‘Page Border’ option and then play
the video again.
JE@0I69 ©E6 @ 9% AR 99° I8 ARG ‘Page Border’ 29 @ ALY QS
IR 98 96° GILIU6R &G § YRala o2l |

435. To stop video time at 21 minute 22 seconds in VLC Media Player.

Stop video here and check whether they’ve applied the ‘Page Border’ or not then play
the video again.

YE@0I69 ©E6 g 9L AR 99° 607 @G & 6496% ‘Page Border 2088 &

QI 99° QITITER BE6 § gReIa I |
436. To stop video time at 21 minute 34 seconds in VLC Media Player.

COMPUTER SHIKSHA

Next, all of you insert a table and SI1g68), §6¢1 AF6S 661ITI 65gM
then show how you will make a CUR TR 98° YY6RA TG4 A MY
sales list in it. GUL FQ 6Q612A |

Stop video here and ask the students to create the ‘Table’ and ask to make sales list in
it and then play the video again.

20169 886 § 9 99 99° QIS AIeG 695N Table’ 2R KR AR G2

9Q9° 692/69 852 9 o7 YISl AIR L YG° GIFITER 863 § YRR ORI |
437. To stop video time at 21 minute 52 seconds in VLC Media Player.
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COMPUTER SHIKSHA

Shut down your computer.

299 fiaca § 98 99 |

Stop video here and ask the students to close the writer file and then shut down the
computer.

S0I6Q GGG § 98 9 I9° |1 FI9g ARTA FIRM § 698 S| AR

Qe NQ° LIdeR AHATR q e« aoQl IR Qe |
Just check whether they have shut down the computer or not.

J6% 699 AR 6971168 TR § 9% A0RE & AIE |
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